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END-USER LICENSE AGREEMENT 
EQ8, including without limitation the software’s source code, object code, instructions, graphics, and other components (collectively the 
“Software”), is provided to you under license.

COPYRIGHT: The Software is copyrighted 1991-2017 by The Electric Quilt Company. 

NOTICE OF RIGHTS: All rights reserved.

No part of this software or its documentation may be reproduced or transmitted in any form or by any means, electronically, photocopied, 
recorded, translated into a machine language, or otherwise, without the written permission of the publisher. 

You may not sell or distribute collections or individual block designs from the EQ8 Block Library. You may not use EQ8 library blocks or other 
library designs in any commercial application, including software. For rights clearance, please contact The Electric Quilt Company by email 
customerservice@electricquilt.com or by phone 419-352-1134 Monday-Friday, 9:00am-5:00pm Eastern.

NOTICE OF TRADEMARKS: Windows® and Microsoft® are registered trademarks of Microsoft Corporation. Mac® is a registered trademark 
of Apple Inc. Electric Quilt® is a registered trademark of The Electric Quilt Company. Many titles used by manufacturers and sellers to 
distinguish their products are claimed as trademarks. Where The Electric Quilt Company was aware of these trademarks, the trademark 
symbol was printed beside the trademarked title or product name.

GRANT OF LICENSE: This Software is protected by United States Copyright law and by International Treaty. Any use of the Software in 
violation of these laws terminates the license and can be prosecuted. This Software is licensed, not sold.

The Electric Quilt Company grants to you a non-exclusive, non-transferable license to EQ8. By your installation and use of this Software you 
acknowledge that you have read this agreement, understand it, and agree to be bound by its terms and conditions. 

You agree not to engage in, nor to permit, the decompilation, disassembly, attempt to discover the source code, or other reverse 
engineering of the Software.

You may not lend, lease, rent, sublicense, or otherwise distribute any portion of this Software. It is software piracy to do so and the licensee 
and others involved in the piracy can be prosecuted.

WARRANTY: The Software is licensed “as is” and without any express or implied warranties whatsoever. Because of the diversity of hardware 
and conditions under which this Software may be used, no warranty of fitness for a particular purpose is offered. The user must assume the 
entire risk of using the Software. Any liability of seller or manufacturer will be limited to product replacement or refund of purchase price. 

The Electric Quilt Company does not guarantee or make any representations regarding the use or the results of use of the Software or any 
related content or information in terms of its correctness, accuracy, reliability, currentness, completeness or otherwise. The entire risk as to 
the results and performance of the Software or related content or information is assumed by you.
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More Copyright Information
COPYRIGHT: 
The software is copyrighted 1991-2017 by The Electric Quilt Company.

The reference manual is copyrighted 1991-2017 by The Electric Quilt Company.

COPYRIGHT OF DESIGNS:  
If you have a question about copyright, contact us. 

When making or publishing a pattern, you do not need to mention that the pattern was made in EQ8 (we love it if you do, of course). 

Blocks You Draw: Any blocks you design (without copying a design from existing copyrighted quilt blocks) are yours to copyright.

Blocks from the Library: Blocks from the EQ8 Libraries (Libraries 01-10) are copyright-free when used in your designs. You may not distribute 
or sell collections of block designs from EQ8, or use EQ8 library blocks or other designs in any commercial application including software.

Blocks from Linked Libraries: Our other products link to EQ8. Blocks outside the libraries that come with EQ8 may be copyrighted. Many of 
these blocks are clearly marked in the notecard. If you have linked other EQ products, please check where the block patterns came from 
before publishing your design.

Quilts You Design: Any quilts you design (without copying an existing copyrighted quilt design) are yours to copyright.

Fabrics, Embroidery and Thread: The fabrics, threads and embroidery designs that appear in the libraries appear by permission of their 
manufacturers. All these designs are copyrighted by their respective manufacturers.
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OPENING EQ8
When you first open EQ8, the GET STARTED section of the Home Screen is your landing page, giving you options of how you 
can begin designing, and a Tip of the Day. You can use the navigation on the left to find help quickly (click LEARN), product 
details, and contact information for EQ. You can always return to this screen by clicking the Home Screen button in the top-left 
corner.

If you’re not sure what to do to begin, EQ8 gives you suggestions under 3 headings.

DESIGN QUILTS
Design a quilt from scratch: Start a new quilt design on the Quilt Worktable. This does not start a new project, only a new, 
blank quilt.

Start with a Quick Quilt project: Open and work with a pre-designed project. These projects have several quilts, blocks, and 
fabrics pre-loaded based on a theme, such as Log Cabin quilts.

Open an existing project: Open and work with an EQ8 project that you previously created. This will offer a list of projects 
stored in the My EQ8 > Projects directory, but you can always navigate to find any EQ8 project on your computer (see page 
17).

DRAW BLOCKS
Design a block from scratch: Start a new block design on the Block Worktable, whether it be pieced, applique, or a 
combination. This does not start a new project, only a new, blank block.

Search for block patterns: Open the Block Library to find pre-drawn blocks to print patterns, design with, and/or edit to make 
your own.

WORK WITH FABRICS
Import and edit fabric images: Scan or take a photo of your own fabric, then import it into EQ to see it in your quilt design.

Search fabric swatches: Open the Fabric Library to find a large variety of pre-loaded fabric to use in your project. 

All computers and monitors vary, so what you see on screen may be slightly different than the illustrations in this book.

Home Screen
button

Home Screen
navigation

Tip of the Day
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EQ8 WORKTABLES
There are 3 worktables in EQ8, each offering different tools and features for your project. You can switch between worktables 
at any time by clicking on their respective buttons, which will always be located in the top-right corner of the screen. Let’s take 
a closer look at these 3 worktables.

Quilt Worktable

Block Worktable

Image Worktable

OPEN LIBRARY
The Open Library button is a new addition to EQ8! Quickly 
access the appropriate library for the set of tools you’re 
currently working with. For example, if you have the Fabrics & 
Colors palette open and click the Open Library button, you’ll go 
to the Fabric Library.

Quilt Worktable
•	 Design quilts of all layout styles, including: traditional, 

modern, custom, strip, one-patch, baby blocks, and 
more 

•	 Customize borders (choose from 22 styles!)

•	 Add blocks, fabrics, and threads

•	 Visualize quilting

•	 Create quilt labels

Block Worktable
•	 Draw pieced blocks

•	 Draw applique blocks

•	 Draw combination blocks

•	 Create blocks without drawing

•	 Trace a photo to create a block

Image Worktable
•	 Import your favorite photos, then crop, resize, and 

colorize for your photo quilt or project

•	 Import photo or scans of your fabric stash, then 
straighten, crop, and scale for use in your quilt 
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WORKSPACE DIAGRAM
The diagram below shows the EQ8 Quilt Worktable (blue), fully labeled to help illustrate the workspace. The Block Worktable 
(yellow) is also shown smaller, with additional content. 

Main Menu

Main Toolbar

Palette

Palette Toolbox

Palette Tools

Palette Sub-tools

Fabric Preview

Most Recently 
Used List

Palette Tabs

Palette Viewer

Home button

Worktable TabsProject Name

Ribbon Options

Display Options Viewer Scrollbar Viewer Options Layer Tabs Hide/Show Layers

Palette Scrollbar
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Worktable Buttons

Status Bar

Palette Options

Precision Bar - Block Worktable only

Worktable Scrollbar

Layer Tabs
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CHOOSING INCHES OR 
CENTIMETERS
You can use inch or centimeter measurements 
in EQ8 (inches are the default).

1.	 Click File on the main menu bar, then 
click Preferences. 

2.	 Under Workspace, click Measurement.

3.	 Click on the measurement you’d like to 
use.

4.	 Click OK.

NOTE
Once you change the measurement units the 
program will continue to use those units until you 
change them again.

RESTORING DEFAULT 
SETTINGS
If you make changes to the default settings, 
you can always restore the program back to 
the way it was when you first installed it. 

1.	 Click File on the main menu bar, then 
click Preferences.

2.	 Under Workspace, click Restore. 

3.	 (Optional) Click the box next to Also 
restore default blocks, fabrics, colors 
and thread if you’ve made changes to 
the default palette (see page 11) and 
would like to go back to the defaults.

4.	 Click the Restore Default Settings 
button.

5.	 EQ8 will need to close to update 
the settings. Click OK at the warning 
message.

6.	 Open the program again and the 
default settings will be restored.

Step 2

Step 3 Step 4

Step 2

Step 3

Step 4

Step 5
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CREATING YOUR OWN DEFAULT PROJECT 
Follow the instructions below to change your default project. The next time you open EQ8, or start a new project, you will be 
starting with the Sketchbook items YOU selected, instead of what was pre-loaded in EQ8. 

WARNING: Make sure you are in a new, clean project file, as you don’t want to lose any of your in-progress designs.

Delete the Default Content  
1.	 Start a new project. 

2.	 Click View Project Sketchbook.

3.	 Click the Blocks section. You’ll see the 
pre-loaded default blocks. 

4.	 Click the 3-dot Options button in the 
upper-right of the Sketchbook window. 

5.	 Choose Clear all unused blocks. 

6.	 Click Yes to the prompt. The Blocks 
section should be empty. 

7.	 Repeat steps 4-6 for the Motifs and 
Stencils tabs in the Blocks section, and 
also for Fabrics and Threads, if desired.  

8.	 Close the Sketchbook. 

9.	 (Optional) Open the libraries and add 
any new items you’d like. Close the 
library.

10.	 When you have your project just as 
you would like, click File on the main 
menu bar and choose Save Palette as 
Default. Click OK to the prompt. The 
next time you start a new project, you 
will see your default palettes, whether 
completely empty, or with your own 
content. 

NOTE
You can also save your default project with newly 
sorted content. For example, in the Colors section 
of the Sketchbook, you might want to put black 
and white swatches at the beginning of the Color 
palette. Sort the colors so black and white are first 
in the list (see page 31). When you choose File > 
Save Palette as Default, the black and white will 
always be at the beginning of all new projects.   

Step 2

Step 4

Step 5

Step 10
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GETTING HELP
EQ8 is packed with online resources for learning your EQ8 software. To access most of these resources, click Help on the main 
menu to display the options below. 

View Home Screen 
Display the Home Screen for quick access to features, help resources and product details.

Online Support Articles 
Use the search feature on the EQ support site to find the answers you’re looking for. 

Video Tutorials 
These videos are a great way to get started. Watch and learn! 

Printable Lessons 
There are fully-illustrated printable lessons to help you get started. 

Quick Start Guide 
Offers an EQ8 Starter Lesson, along with tips and a tool reference. 

User Manual 
This User Manual is a reference guide to all the features of the program. View the PDF and print out the pages that are most 
useful. Contact EQ for information on purchasing a hard copy of the manual.    

Contact EQ 
Can’t find the answers you need? Contact our technical support team by email or phone. Emails are answered within 1-2 
business days, and phone calls can be taken during business hours. (Monday-Friday, 9:00am-5:00pm ET.)

•	 Find answers on our Support Site at any time: Support.ElectricQuilt.com

•	 Contact by email: techsupport@electricquilt.com

•	 Contact by phone: 1-419-352-1134

DOWNLOADING AND INSTALLING
If you have any problems or questions about downloading, installing/uninstalling, or activating EQ8, please visit  
Support.ElectricQuilt.com. Because operating systems and browsers change and update so frequently, you will be able to find 
the most up-to-date information regarding your operating system on our Support site. 

If you can’t find the help you need on the Support site, please contact us! We’re happy to answer any questions you may have. 
See the contact info above.

ACTIVATING EQ8
After you’ve installed EQ8, you will need to activate the software. Activation sends a signal to EQ’s server to verify that the 
software is licensed to you and that it has not been shared or stolen.

On how many computers can I have EQ8 installed at a time? 
You can have EQ8 installed on as many computers as you wish, however only 2 computers can be active at a time. If you want 
to use EQ8 on a third computer, you must deactivate one of the computers before activating the third computer. 

Please note: When you deactivate EQ8 so it can be used on a third computer, you do NOT need to uninstall EQ8 unless you no 
longer plan to use it on that computer.
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CHAPTER 1
Projects and the Project Sketchbook

The first thing we’re going to talk about in this manual are the projects where your entire designs will be saved because 

we don’t want you to lose anything you create. Within these projects, the 6 sections that make up the Project Sketchbook 

will hold and allow you to access the individual parts that make up the design, including complete quilts. Continue reading 

to understand where your creativity will be stored.

1
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1
UNDERSTANDING PROJECTS
Like most software programs, any work you do in the program will not be saved until you create a file on your computer. 
EQ8 creates .PJ8 files that, by default, are saved in your computer’s Documents folder. While most computer files contain 
one thing, such as a letter to your Aunt Debbie, an EQ8 project can contain many items, including blocks, fabrics, threads, 
embroideries, photos, and completed quilts. These individual items will all be saved in the Project Sketchbook, see the next 
section. On the following pages we’ll explain how to open, save, rename, and perform other actions with the projects, but the 
most important idea to understand is you must have a project if you want to save what you create.

UNDERSTANDING THE PROJECT SKETCHBOOK
The Project Sketchbook is like a big organizer for your project. In EQ8’s Project Sketchbook there are 6 sections: Quilts, Blocks 
(there are 3 tabs within this section: Blocks, Motifs, & Stencils), Fabrics, Colors, Photos, Thread, and Embroidery. By default, 
the Blocks, Fabrics, Colors, and Thread sections all have respective items already stored there. Once you’ve designed quilts, 
you can add them to your Project Sketchbook, and many of the other sections, whether they start with items or not, can 
be filled with your own creations or by looking through and adding items from the Libraries (see chapter 8). Any time you 
click the Add to Project Sketchbook button, the current version of your design gets added to the Project Sketchbook and is 
organized in the appropriate section. So, you can be working on a quilt, add it to the Project Sketchbook, step away, and when 
you come back to the program, begin working on it where you left off. We’ll show you how to add, edit, sort, name, and delete 
items from the Project Sketchbook, so you understand how this can store all of your creativity.

Resizing the Project 
Sketchbook
The Project Sketchbook in EQ8 can be resized. 
Hover your cursor over any edge until it looks 
like a double-sided arrow, then click, hold, and 
drag to change the size.	

Options Menu
At the top-right of every sections’ display 
area are 3 dots. If you click on these dots, the 
options will be different for every section. Yet, 
they will all offer the ability to:

	 •	 Sort – sort the respective items in the  
		  section, see page 31.

	 •	 Frame Color – change the color of the  
		  frame around the selected item.

	 •	 Display – change the size of the items  
		  displayed from tiny all the way to large.

Each section offers different options. Click on 
the options menu to see what is available. 
For example, there are many options for the 
Blocks and Colors sections.

Resize the Sketchbook by hovering over one of the edges until 
your cursor changes, then click, hold and drag to change the size.

Click the three dots in the top-right corner of the Sketchbook 
to access the options menu. The options available will change, 

depending on the section of the Sketchbook that’s selected.
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1
CREATING A NEW PROJECT
When you open EQ8, before creating a project, you’ll notice at the top of your screen it says “Untitled – EQ8.” We recommend 
“naming” your project before you begin working. Following are the steps to create a new project, so Untitled will be replaced 
with a name of your choosing. It is very important to create a project so that you don’t lose any of your designs. If you’re not 
sure what your design results might be, and therefore what might be a good name (i.e., Mom’s Lone Star Quilt), you can start 
by naming the quilt using the date (i.e., July 12), and rename it later, see page 18.

If you choose not to name your project before you start working in the software, you will be prompted to save (aka “name” 
your project) each time you click the Add to Project Sketchbook button. See page 16.

Step 1
New Project

Step 1
File > New Project

OR

Step 2 Step 3

After clicking OK in step 3, a file is created in your My EQ8 > 
Projects folder using the name you typed in step 2.

1.	 With EQ8 open, you can click the New 
Project button, or click File > New 
Project. The Project Helper box will 
appear.

2.	 Type a name of your choosing (you can 
change it later, see page 18) on the 
Create a new project tab .

3.	 Click OK. You will now see the project 
name you typed at the top of your 
screen (followed by PJ8).

NOTES
The default locations for projects created in this 
manner are: 
PC: Documents > My EQ8 > Projects  
Mac: Go > Home > My EQ8 > Projects

If you create a new project called “Log Cabin,” you 
will find a Log Cabin.PJ8 file in the Projects folder.

To save your new project, see page 16.

To open your new project after closing it, see  
page 17.

To delete your project, see page 20.
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1
SAVING A PROJECT
If you begin working in EQ8 without creating or opening a new project (it will say “Untitled” at the top of your screen), nothing 
you design will be saved if you close the program (though EQ8 will ask you to save). You can create a new project, see page 15, 
or follow steps 2-4 below to save a project. 

1.	 If you have named your project (i.e. it 
does not say Untitled at the top of your 
screen), each time you click the Add 
to Project Sketchbook button, your 
project file is saved. You can skip to step 
5.

2.	 If you have not created a project (i.e. it 
says Untitled at the top of your screen), 
when you click the Add to Project 
Sketchbook button you will see a 
message warning you that the file has 
not been saved yet. Click OK and the 
Save As box will appear.

3.	 Type a name in the File name box.

4.	 Click Save. The box will disappear and 
the name you gave to the project will 
be listed at the top of your screen.

5.	 Continue to click Add to Project 
Sketchbook as you make new or modify 
existing designs. Any time you click this 
button your project is being saved with 
all the Project Sketchbook contents. 
You can have many quilts, blocks, and 
images in a project.

NOTES
To open a project after closing it, see page 17.

To delete your project, see page 20.

If you have already added something to the Project 
Sketchbook and click Add to Project Sketchbook 
again, EQ8 will alert you that the item is already 
there, and you can simply click OK. So, there is 
no harm in clicking the button if you are not sure 
whether you have added the items—better to 
be safe than sorry—because anything not in the 
Project Sketchbook will be lost.

If you did not create a new project or create one 
while working in EQ8 and attempt to close the 
program, you will receive a prompt asking, “Save 
changes to Untitled?” If you want to save what 
you’ve designed, click Yes, and follow steps 3 & 4 
above.

Step 1

If you see a name at the 
top of the screen, each 
time you click Add to 

Project Sketchbook, the 
project file is saved.

If it says Untitled at the 
top of the screen, each 
time you click Add to 

Project Sketchbook, you 
will be asked to save (or 

name) the project.

Step 2

Step 3 Step 4

Step 5

Step 2
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1
OPENING AN EXISTING PROJECT
You can open projects created in EQ8 or earlier versions of EQ within EQ8. You need to know where the project is saved on 
your computer.

1.	 Start EQ8. On the Home Screen, click 
on Open an existing project. If you 
already have EQ8 open, click the Open 
Project button. The Project Helper box 
will appear with the Open an existing 
project tab engaged.

2.	 If you see the name of the project in 
either the Most recently used projects 
or Existing EQ8 lists, click on it to select 
it, click OK, and skip to step 6. If you 
have a lot of existing projects, you may 
have to use the vertical scrollbar to 
see the project you want to open. The 
first quilt saved in this project will be 
displayed in the preview box, but if you 
didn’t save any quilts in this project (if 
you only worked on blocks) the preview 
box will say, “No quilts to display”.

3.	 If you do not see the project name in 
the lists, you will need to browse to 
find it. Click the folder in the bottom-
left corner named Click here to open a 
project not listed above.

4.	 Navigate to the location on your 
computer where the file is saved. 

5.	 Click the name of the project to select 
it, and click Open.

6.	 This project’s Project Sketchbook will 
open. Within the Project Sketchbook 
section you want (Quilts, Blocks, etc.), 
select the item you wish to work on and 
click the Edit button.

NOTES
Here are the default locations for previous EQ 
versions:  
EQ6: Documents > My EQ6 > PJ6 
EQ7: Documents > My EQ7 > PJ7

You can also open an existing project with File > 
Open Project or CTRL+O (Command+O).

Use this same method to open projects created in 
other EQ software, such as BlockBase.

Step 1

Open an existing project on the Home Screen

Open Project 
button on 

main toolbar

Step 2

Step 3 View the quilts 
in this project

Step 4

Step 5

Step 6
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1
SAVING A PROJECT IN A NEW LOCATION
Save As under the File menu is great for saving projects to other places on your computer, or onto removable storage devices 
like flash drives or writeable CDs. Remember your project consists of everything in the Project Sketchbook, so be sure to add 
any designs you want to see again, see page 16. Designs not in the Project Sketchbook will be lost.

RENAMING A PROJECT
1.	 If you are already in EQ8, click the Open 

Project button. If you start EQ8 and 
are on the Home Screen, click Open an 
existing project. Either way, the Project 
Helper box will appear.

2.	 Whether or not you see the project 
listed, click on Click here to open a 
project not listed above.

3.	 Navigate to the location where the 
project file is saved. EQ8 projects are 
saved by default in:  
PC: Documents > My EQ8 > Projects  
Mac: Go > Home > My EQ8 > Projects

4.	 Right-click on the project name and 
choose Rename from the pop-out 
menu. The current name will be 
highlighted.

1.	 If you want to save your project to a 
removable storage device, be sure the 
device is inserted or connected to your 
computer.

2.	 Make sure the EQ8 project you want to 
save is open.

3.	 Click File > Save As.

4.	 Navigate to the location where you’d 
like to save the project.

5.	 Type a name for the project in the File 
name: box. 

6.	 Click Save. Your project will be saved in 
the new location.

NOTE
To open a project from removable storage devices, 
you can either double-click the project name or 
use the directions on page 17 to open a project not 
listed on the Open an existing project tab of the 
Project Helper.

Step 3

Step 4

Step 6Step 5

Step 1

Open an existing project on the Home Screen

Open Project 
button on the 
main toolbar

Step 4

Step 2
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1

5.	 Type a new name. (If the entire name, 
plus the extension .PJ8, was highlighted, 
make sure to only change the name to 
the left of the period, so the extension 
stays the same.)

6.	 Click Cancel to close the Open box and 
Cancel again to close the Project Helper 
and return to the EQ8 worktable you 
were previously on.

NOTE
Don’t worry if you see the old project name in 
the Most recently used projects list of the Project 
Helper. The name will be bumped off the list once 
other projects are open.

SEARCHING FOR A 
PROJECT
If you ever need to find a project that is not in 
the Existing Projects list, follow these steps.

1.	 Open your computer’s Search option 
and type in .PJ8, to find the files on 
your computer that end in that file 
extension.

2.	 If you find a project not in the My EQ8 > 
Projects folder, you can double-click on 
the project in the list to open it.

3.	 You may want to choose File > Save As 
and save it in (PC) Documents > My 
EQ8 > Projects or (Mac) Go > Home > 
My EQ8 > Projects so it will be in the 
Existing Projects list.

NOTES
When searching, you’ll find projects that you did 
not create. These “unknown” projects are needed 
for the default projects and Auto Borders in EQ8 
and should not be moved or deleted. In general, 
do not move PJ8 projects or files out of folders in 
My EQ8 > res. Doing this may cause the program to 
stop working and you will need to reinstall.

If you’re looking for projects other than those 
created in EQ8, try the following extensions: 
.PJ7 – EQ7 project 
.PJ6 – EQ6 project 

Step 5
When renaming, make sure you leave the file extension (.PJ8) intact.

Step 1

Step 3
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1
DELETING A NAMED PROJECT
Sometimes you may want to delete a project, and if so, follow the steps below. If you only want to delete an individual block 
or quilt within a project, see page 33.

Step 1

Open an existing project on the Home Screen

Open Project 
button on the 
main toolbar

Step 2

Step 4

1.	 Start EQ8 and on the Home Screen click 
Open an existing project, or if you’re 
already in EQ8, click the Open Project 
button.

2.	 In the bottom-left corner of the Project 
Helper box, click Click here to open a 
project not listed above (even if you 
see the project you want to delete in 
one of the lists).

3.	 Navigate to the location where the file 
is saved on your computer. EQ8 projects 
are saved by default in:  
PC: Documents > My EQ8 > Projects 
Mac: Go > Home > My EQ8 > Projects

4.	 Right-click the project name and choose 
Delete (PC) or Move to Trash (Mac).

5.	 If asked if you want to delete, click Yes.

6.	 Click Cancel to close the Open box and 
Cancel again to return to the worktable.

NOTES
You can also delete a project outside of EQ8 
using File Explorer or Finder. On a PC, navigate 
to Documents > My EQ8 > Projects. On a Mac, 
navigate to Go > Home > My EQ8 > Projects. Select 
the file and send it to the Recycle Bin or Trash Can.

If you delete the wrong project you can recover 
it. On a PC, double-click the Recycle Bin and find 
the deleted file. Right-click on the file and choose 
Restore. On a Mac, click the Trash Can. Right-click 
on the file and choose Put Back. The project will 
be sent back to its original folder. Deleted projects 
are gone forever once you empty the Recycle Bin 
or Trash.

Don’t worry if you see a deleted project name in 
the Most recently used projects list of the Project 
Helper. The name will be bumped off the list once 
other projects are opened.
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STARTING WITH A 
QUICK QUILT PROJECT
EQ8 has over 70 pre-made quilts for you to 
use as is, or edit to make into your own.

1.	 Start EQ8 and on the Home Screen click 
Start with a Quick Quilt project, or if 
you’re already in EQ8, click the Open 
Project button and click the Start with a 
Quick Quilt project tab.

2.	 Click on the names to see the quilts, 
and use the arrows below the preview 
of the quilt to see all the quilts in that 
project.

3.	 Click on the project you want to use to 
select it. Click OK.

4.	 The Sketchbook for this project will 
appear (all of the blocks and fabrics 
used to make these quilts will be in the 
respective sections). Click the Quilts 
section.

5.	 To put a quilt on the worktable, either 
double-click it, or select the quilt and 
click the Project Sketchbook’s Edit 
button. 

NOTES
When you open a Quick Quilt, it will be Untitled. 
Don’t forget to save this project, see page 16.

If you turn off the EQ8 Home Screen, you can 
access the Quick Quilts by clicking File > Open a 
Quick Quilt Project.

Home
button

Step 1

Step 2 Step 3Preview the 
other quilts in 

the project

Step 4

Step 5
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OPENING OR SENDING A PROJECT VIA EMAIL
EQ8 projects sent via email are sent as attachments.

Step 2
Your options may look different, depending on your email provider.

.PJ8 file attached to the email

Opening a Project from 
your Email

1.	 If the attachment is an EQ8 project file 
(ending in .PJ8), click or double-click 
on the attachment to see your options. 
(You may need to click the words 
Download Attachment or click on a 
paper clip icon.)

2.	 Depending on your email provider, you 
can: 
 
Save (Recommended) – save the file in 
the default location for project files: 
PC: Documents > My EQ8 > Projects  
Mac: Go > Home > My EQ8 > Projects  
Then follow the directions on pages 
17 to open the project from Existing 
Projects list. 
 
Open – this will only put the file in your 
Temporary Files, but allow you to view 
it. You should immediately save the file 
following the directions on page 18.

NOTE
Remember, opening attachments from people you 
don’t know could potentially harm your computer.

Sending a Project via Email
You may have many quilts, blocks, fabrics, and 
images in your project. It’s best to clean up 
your project and decrease the file size before 
sending. See Copying Projects page 23, and 
Compressing a Project’s File size page 24.

1.	 Open your email account and start a 
new message.

2.	 Add an attachment. You may see a 
paper clip, the menu choice INSERT > 
File, or the word Attach. Check with 
your email provider on how to add 
attachments if you need help.

Step 2
Look for the word Attach, Insert, or a paper clip to add the project file to your message.
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COMPRESSING A PROJECT’S FILE SIZE
Use this compress feature to clean up your Sketchbook and make the file size smaller. You may want to do this so the project 
file won’t take up so much space on your computer, or so you can attach it in an email, see page 22. Using this feature will 
automatically delete items from your Sketchbook that are “unused” (only for this project, NOT from EQ8). There is the 
potential for losing items you didn’t mean to delete if you do not fully understand this feature. If you plan to compress the file 
size, it is highly recommended you create a backup copy of the project first using either File > Save As (page 18) or File > Create 
Copy Project (below).

What does it mean to 
be “unused”?
There are two options to choose from in the 
Compress Project File Size window:

•	 Delete unused blocks, fabrics, 
embroidery, pictures and thread means 
the Sketchbook quilts determine 
whether something is used or not. If 
it isn’t in one of the quilts, it will be 
deleted from the project.

•	 Delete unused fabrics only means 
Sketchbook quilts and blocks determine 
whether a fabric is used or not. If the 
fabric is not in a quilt or a block, it will 
be deleted from the project.

Make a Backup Copy of 
the Project

1.	 Click File > Create Copy Project.

2.	 (Optional) Choose a new location for 
the backup copy. Navigate to the folder 
in which you want to save the backup.

Step 1

Step 2

Step 4

3.	 Navigate to find the folder where your 
project is saved. Default location: 
PC: Documents > My EQ8 > Projects 
Mac: Go > Home > My EQ8 > Projects

4.	 Click the project name to select it 
and attach it to the email. Type in the 
receiver’s email address and add a 
subject line and message. Then send 
the email.

NOTE
The person that you are sending the project file to 
must have EQ8 installed on his or her computer in 
order to open the project file (.PJ8).

Compress Project File Size Options
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3.	 Type a name for the backup copy. We 
suggest adding the words “original” or 
“backup copy” to the current file name 
so you know what it is.

4.	 Click Save. The copy will be in the 
location you chose and you will still be 
working on the current project.

Compressing the 
Project’s File Size

5.	 Click File > Compress Project File Size.

6.	 Choose one of the compression options 
(see page 23 for details): 
•	 Delete unused blocks, fabrics,  
	 embroidery, pictures and thread will  
	 delete anything not used in one of  
	 the quilts in this project. 
•	 Delete unused fabrics only will  
	 delete all fabrics from the Sketchbook  
	 not used in a quilt or block in this  
	 project.

7.	 Click OK to delete the unused items 
and save the result. This process will 
overwrite your current project file 
and cannot be undone. (If you made a 
backup copy, you have nothing to worry 
about.) Click Cancel to do nothing and 
return to the worktable.

NOTES
If you choose to delete unused blocks, fabrics, 
embroidery, pictures and thread, first remove 
unwanted quilts from the project. See page 33 for 
how to delete items from the Sketchbook.

If you click the Clear button in the Fabrics section 
of the Sketchbook and check Delete only unused 
Fabrics, it has the same results as choosing the 
Delete unused fabrics only in step 6.

Block colorings are stacked by default in stacks  
of 2. This compressing feature does not remove an 
unused coloring from a stack if one of the other 
colorings is used. After running Compress Project 
File Size once, you can click View Sketchbook, go 
to the Blocks section, and manually delete unused 
colorings from the remaining blocks. Run Compress 
Project File Size again and your project may 
become even smaller.

Step 5

Step 6

Step 7

Step 3 Step 4
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COPYING PROJECTS AND USER FILES FROM ONE COMPUTER TO 
ANOTHER
To move important EQ8 files from one computer to another you need the following: 1) a computer with EQ8 installed and EQ8 
project files on it, 2) a “middle man” for storing the files, and 3) another computer with EQ8 installed on it.

The “middle man” can be removable storage (like a USB flash drive, writeable CD/DVD) or a server. Emailing yourself the 
projects would be another option, although it may take longer if you have multiple projects to transfer (see page 22).

You do not need to have EQ8 open to do this.

Find the Important Files 
on the Old Computer

1.	 Go to the default folder for EQ8 by 
clicking Documents > My EQ8 on a PC 
or Go > Home > My EQ8 on a Mac.

2.	 Select the Projects and the User 
Favorites folders.

3.	 Right-click and choose Copy or press 
CTRL+C (Command+C) on your 
keyboard.

Save the Projects to a 
Storage Device

4.	 Insert the removable storage device 
(USB flash drive, writeable CD/DVD, 
etc.) or connect to the server you plan 
to use.

5.	 Open the storage device on your 
computer.

6.	 (Optional) Make a new folder by right-
clicking an empty space and choosing 
New Folder and name it My EQ8. 
Double-click the folder to open it.

7.	 Right-click and choose Paste or press 
CTRL+V (Command+V) on your 
keyboard. This will put copies of the 
Projects and User Favorites folders in 
here.

Step 2

Step 3

Step 6

Step 7



26

EQ8 Reference Manual

1

8.	 If there are any other projects lurking 
elsewhere on the old computer, 
repeat steps 1-7 for those files. Use 
the directions on page 19 to search 
for projects that were not saved in the 
Projects folder. Then copy and paste 
those files into the Projects folder on 
the removable storage device.

Move the Projects to the 
New Computer

9.	 Insert the removable storage device 
into the new computer or connect to 
the server you used.

10.	 Open the storage device.

11.	 Select the Projects and User Favorites 
folders.

12.	 Right-click and choose Copy or press 
CTRL+C (Command+C) on your 
keyboard.

13.	 Go to the new computer’s My EQ8 
folder by clicking Documents > My EQ8 
on a PC or Go > Home > My EQ8 on a 
Mac.

14.	 Right-click and choose Paste or press 
CTRL+V (Command+V) on your 
keyboard.

Step 11

Step 12

Step 13

Step 14
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ADDING ITEMS TO THE PROJECT SKETCHBOOK
Every EQ8 project has its own Project Sketchbook. The Project Sketchbook is where you save your designs, kind of like a 
briefcase or file folder for that project. Anything added to the Project Sketchbook will be there the next time you open the 
project. Anything not added to the Project Sketchbook will be lost.

The Add to Project Sketchbook button is available from each of the 3 worktables (Quilt, Block, and Image). Don’t feel like you 
have to wait until your design is completely finished and perfect to click Add to Project Sketchbook. In fact, we encourage you 
to save many “in progress” designs or variations in the same project, along with the final design.

Step 1
Add to Project 

Sketchbook

Step 2
View Project 
Sketchbook

Quilts 
section

Use the scrollbar to see all 
the quilts in the project

Displays the number of 
quilts saved in the project

Blocks 
section

1.	 With the new or changed item on your 
worktable, click the Add to Project 
Sketchbook button. (If this is your 
first time clicking this button and you 
haven’t already Saved As, you will be 
prompted to name the project and it 
will be saved by default in: My EQ8 > 
Projects.)

2.	 If you like, click the View Project 
Sketchbook button to verify the new 
contents.

Quilts Section: Your new quilt will be the last 
quilt in the Sketchbook. Drag the scrollbar to 
the right to see all your quilts.

Blocks Section: Click the Blocks, Motifs, 
or Stencils tab within the Blocks section, 
depending on the item you added. Your new 
block, motif, or stencil will be the last one on 
its tab. If you recolored an existing design, it 
will be stacked on top of the original (up to 
two colorings by default). Click the design, 
then use the coloring arrows to go to the end 
of the stack of colorings. Or, right-click the 
design and choose Select Coloring to see the 
different ways that design has been colored 
and select one.

Photos Section: Your new image will be 
the last image in the Sketchbook. Drag the 
scrollbar to the right to see all your images.

For all of these sections, you can also change 
the number of items that display at one time. 
On the left below the horizontal scrollbar 
you will see a series of display buttons with 
squares on them. Click a button with a larger 
square to see fewer items, or one with a 
smaller square to see more items.

Photos 
section

Blocks, Motifs, and Stencils tabs

Coloring 
arrows

Display buttons
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EDITING QUILTS FROM THE PROJECT SKETCHBOOK
You can make changes to existing quilt designs or edit quilts to print patterns.

Step 1

Step 5

Step 2

Step 3Display buttons Step 4

1.	 Click View Project Sketchbook.

2.	 Click the Quilts section.

3.	 If you do not see the quilt you wish to 
edit, drag the scrollbar to find it.  
 
You can also change the number of 
items that display at one time. On the 
left below the horizontal scrollbar you 
will see a series of display buttons with 
squares on them. Click a button with 
a larger square to see fewer items, or 
one with a smaller square to see more 
items.

4.	 To edit the quilt back to the Quilt 
Worktable, either double-click it, 
or select the quilt and click the Edit 
button. 

5.	 Make any changes to the quilt and click 
Add to Project Sketchbook to save 
those changes. The new quilt will be at 
the end of the existing quilts.

NOTES
The old quilt you edited will still be in the Project 
Sketchbook. See page 33 if you do not want to  
keep it.

When you add a Photo Patchwork quilt to the 
Sketchbook, the quilt becomes a One Patch quilt 
and the image is no longer needed. When you edit 
this quilt, it will edit to the Quilt Worktable without 
the image and will be a normal One Patch quilt. 
Read more about Photo Patchwork on page 49.

If you plan to print the quilt, don’t forget to give it a 
name on the Notecard so it doesn’t display Untitled 
on your printouts. See page 34.

After editing from the Sketchbook, the quilt will be on the Quilt Worktable.

Add to Project
Sketchbook
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EDITING BLOCKS, 
MOTIFS, AND STENCILS 
FROM THE PROJECT 
SKETCHBOOK
You can make changes to existing block 
designs or edit blocks to print patterns.

1.	 Click View Project Sketchbook.

2.	 Click the Blocks section.

3.	 There are three tabs in the Blocks 
section. Click the Blocks, Motifs, or 
Stencils tab, depending on the item you 
wish to edit.

4.	 If you do not see the item you wish to 
edit, drag the scrollbar to find it. (If you 
still don’t see it, try a different tab in 
step 3. If no blocks have been added to 
a tab, it will say “No blocks to display”.) 

5.	 (Optional) Choose the coloring you 
wish to edit. Click the block to select 
it and use the coloring arrows to scroll 
through the colorings. Or, click the 3 
dot button and choose Select Coloring 
to see the different colorings in a menu.

6.	 To edit the block back to the Block 
Worktable, either double-click it, or 
select it and click the Edit button.

7.	 The block will appear on the DRAW 
tab of the Block Worktable, with the 
tools originally used to create it in the 
palette. Make any changes to the block 
and click Add to Project Sketchbook to 
save those changes. The new block will 
be at the end of the existing blocks or 
the new coloring will be the last of the 
stacked colorings for that block. 

NOTES
The old block you edited will still be in the 
Sketchbook. See page 33 if you want to delete it.

If you plan to print the new block, don’t forget to 
give it a name on the Notecard so it doesn’t show 
up as Untitled in your printouts. See page 34.

Step 1

Step 2

Step 3

Step 5
Coloring 
arrows

Step 4 Step 6

After editing from the Sketchbook, the block will be on the DRAW tab of 
the Block Worktable with the appropriate tools in the palette on the left.

This block was drawn using the EasyDraw 
tools, so you’ll see the EASYDRAW BLOCK 
palette on the Block Worktable when you 

edit the block from the Sketchbook.

Step 5
Click the 3 dot button and choose 

Select Coloring, then select a coloring 
from the menu (right).
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EDITING PHOTOS FROM THE PROJECT SKETCHBOOK
You can make changes to existing images or edit them to print. If you don’t have any photos in your Project Sketchbook, since 
there are no default photos in this section, you can add them from the Photo Library, see page 200 or Chapter 7.

Step 1

1.	 Click View Project Sketchbook.

2.	 Click the Photos section.

3.	 If you do not see the image you wish to 
edit, drag the scrollbar to find it. 

4.	 Photos can go on any worktable: 
Edit the photo to the Image Worktable:  
Click the image once to select it, then 
click the Edit button and choose to 
Image Worktable. You will then be able 
to use the tools described in Chapter 7. 
 
Edit the photo to the Block Worktable:  
Click the image once to select it, then 
click the Edit button and choose to 
Block Worktable. The image will go to 
the Block Worktable. Click the NEW 
BLOCK tab so you can choose the 
appropriate block style and start tracing 
(see page 158), or edit an existing block 
from the Sketchbook (see page 29) to 
continue working on an in-progress 
block.  
 
Edit the image to the Quilt Worktable:  
You need to have NEW QUILT > Photo 
Patchwork selected first. Close the 
Project Sketchbook, start a new Photo 
Patchwork quilt, then repeat steps 
1-4. With the correct quilt type on the 
worktable, you can click the image once 
to select it in the Project Sketchbook, 
click the Edit button and choose to 
Quilt Worktable. Click on the DESIGN 
tab. You will then be able to use the 
Photo Patchwork Options to create a 
One Patch Quilt filled with solid patches 
of color (page 49).

5.	 Make any changes on the worktable 
you selected in step 4 and click Add 
to Project Sketchbook to save those 
changes. The new quilt, block or image 
will be at the end of the existing ones in 
the Project Sketchbook.

Step 2

Step 3

Step 4
Click the Edit button and choose which worktable you’d like to use.

If editing to the Quilt Worktable, click the NEW QUILT tab and choose 
Photo Patchwork on the ribbon before editing the photo to the worktable.

Step 5

NOTE
If you import an image of a fabric on the Image Worktable and click the Add to 
Project Sketchbook button, the fabric image will appear in the Photos section 
of the Sketchbook. To quickly copy the fabric image to the Fabrics section of the 
Sketchbook, click the Copy to Fabrics button. The fabric image will then also be 
in the Fabrics section, and you’ll be able to color quilts and blocks with the fabric 
using the Fabric Tools. 

To add the fabric image directly to the Fabrics section while on the Image 
Worktable, click Add as Fabric (see page 181).
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NOTES
Images can be saved in the Project Sketchbook, 
so you can trace them on the Block Worktable in 
stages. The existing block described in step 4 could 
be the tracing “in-progress.” Just edit the image, 
then edit the block, and start tracing where you left 
off the last time.

When you edit quilts or blocks from the Project 
Sketchbook, you can double-click them and have 
them go automatically to the correct worktable. 
Because images can go on any worktable, it works 
differently. If you are on the Image Worktable 
and double-click an image in the Sketchbook to 
edit it, it will go to the Image Worktable. If you 
are on the Block Worktable and double-click an 
image in the Sketchbook to edit it, it will go to the 
Block Worktable. Remember you need to have a 
Photo Patchwork quilt on the Quilt Worktable to 
double-click an image and have it go to the Quilt 
Worktable.

SORTING ITEMS IN THE 
PROJECT SKETCHBOOK
You can sort items in any section of the Project 
Sketchbook. This technique also works in the 
My Favorite Library and Current Sketchbook 
sections of the library. 

1.	 Click View Project Sketchbook.

2.	 Click the section you’d like to sort. 
For example, to sort photos, go to the 
Photos section.

3.	 Click the Sort button. A Sort box will 
appear. To see all the items to be 
sorted, drag the scrollbar beneath the 
items. 

4.	 You can also change the number of 
items that display at one time. Click 
a button with a larger square to see 
fewer items, or one with a smaller 
square to see more items.

5.	 Click the items in the order you want 
them sorted. The first item clicked will 
appear first in your Sketchbook. When 
you click on an item, it will “disappear” 
so you can’t select it again.

Step 1

If it is too much to trace in one session, make sure that you are saving 
both your tracing image and the in-progress drawing to the Sketchbook 

so you can work on the tracing again later.

Click the Add to Project Sketchbook 
button while Tracing Image is selected 
on the ribbon to save the photo you 

are using to trace in the Photos section 
of the Sketchbook.

Click the Add to Project Sketchbook 
button while Drawing Tools is selected 
on the ribbon to save the drawing to 
the Blocks section of the Sketchbook.

Add to Project 
Sketchbook

Step 2

Step 3

Step 4
Display buttons

Scrollbar

Step 5
Click directly on the 
items in the order 

you’d like them sorted.
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6.	 Continue clicking items in the order you 
want them to appear. Click the Start 
Over button if you make a mistake. If 
you’ve clicked on all the items, the sort 
screen will disappear and you’ll be back 
in the Project Sketchbook.

7.	 Click the Close button if you are 
finished or if you want EQ8 to place 
the remaining unsorted items in their 
current order at the end of what has 
been sorted by you in the Project 
Sketchbook.

NOTES
You can also sort blocks in the Blocks palette, 
fabrics and colors in the Fabrics and Colors palette, 
and photos in the Photos palette on the worktable. 
Click the 3 dot button in the palette, choose Sort, 
and use the above steps to sort them. Also, see 
page 107.

If you only need to move a few things, you can drag 
and drop blocks, fabrics, or photos within their 
palettes. Select the item and drag it into a new 
position and release. It will show as a transparency 
as you drag. For best results, position the top-left 
corner of the transparency over the top-left corner 
of the item you want it to go in front of when you 
release.

Drag and drop sorting in the Blocks palette

Step 6 Step 7

3 dot button
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DELETING FROM THE 
PROJECT SKETCHBOOK

1.	 Click View Project Sketchbook.

2.	 Click the section containing the item 
you wish to delete. For example, to 
delete a quilt, click the Quilts section.

3.	 If you do not see the item you wish to 
delete, drag the scrollbar to find it. 

4.	 Click on the item to select it. It will have 
a box around it showing it is selected.

5.	 Blocks section only: You can delete a 
single coloring or the entire block: 
 
To delete a coloring, click the 3 dot 
button in the upper-right corner of 
the Project Sketchbook, click Select 
Coloring, then select the coloring you 
want to delete. (Or use the coloring 
arrows to scroll through the colorings.) 
 
To delete the entire block and all its 
colorings, click the first coloring arrow 
to view the line drawing (Coloring 0).

6.	 Click the Delete button.

7.	 Click Yes if you want to delete it.

NOTES
When cleaning up a project, the best order in which 
to delete unwanted items is: quilts, blocks, unused 
block colorings, then fabrics. By deleting quilts first, 
any blocks or fabrics in those deleted quilts are 
unlinked and changed from “used” to “unused.” 
By deleting blocks or unused block colorings next, 
you unlink the fabrics they were colored with. 
This allows you to make the project as clean as 
possible and the file size as small as possible. See 
Compressing a Project’s File Size, page 23.

If you try to delete a block or block coloring that is 
used in a quilt you will get a warning message that 
it is used in a quilt and cannot be deleted until the 
quilt is deleted. 

If you try to delete a fabric that is used in a quilt 
or block you are keeping, you will get a warning 
message. If you delete it anyway, the fabric will be 
replaced with a solid color in the block or quilt.

To delete an entire project, see page 20.

Step 2

Step 6Step 3

Step 5
Coloring 
arrows

Step 7

You can delete multiple items at once from the Current Sketchbook section  
of each library. Open the Block Library, click the Current Sketchbook section,  

select multiple blocks to delete, and click the Delete button.

Step 5
Click the 3 dot button and choose 

Select Coloring, then select a coloring 
from the menu (right).

Coloring 0
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NAMING PROJECT SKETCHBOOK ITEMS ON NOTECARDS
In each section of the Project Sketchbook there is a NOTECARD at the bottom left, so that you can label and identify any and 
every item you design or use. The default items that come with EQ8 already have notecards (blocks, fabrics, etc.), but you can 
still add to or edit these cards. When printing, the Name field of the Notecard appears at the top of your printout. 

1.	 Click View Project Sketchbook.

2.	 Click the section containing the item 
you wish to name. For example, to 
name a quilt, click the Quilts section.

3.	 If you do not see the item you wish to 
name, drag the scrollbar to find it. 

4.	 Click the item to select it and click the 
Edit Notecard button. The blinking 
cursor lets you know where you will 
begin typing.

5.	 Type a name in the Name field.

6.	 Press your keyboard TAB key to move 
from one field to the next.

7.	 Type as much as you’d like in the Notes 
field.

8.	 Click the X to close the notecard. The 
changes will appear on the NOTECARD.

9.	 Click Close to put the Sketchbook away.

NOTES
The Name field appears at the top of the page 
when printing, so you can change it to customize 
the printout. Example: Quilt Shop BOM: November

To print the notecard information, select, copy, and 
paste the notecard contents one at a time into a 
word processing document like Microsoft Word. 

In the Project Sketchbook and Libraries, you can 
move the notecards out of the way or “pin” them 
to stay open as you browse the section. To move a 
notecard, click and hold the Move icon as you drag 
the notecard across the screen. To pin a notecard 
to stay open, click the Pin icon. (When you change 
sections, you have to click the Pin icon again.)

Click the Flip icon to flip block notecards (only) to 
the back side to see marking information. See page 
202 for information on block categories.

To learn about searching by using the notecard, see 
pages 201.

Step 1

Step 5

Step 7

Step 8

Step 2

Step 4

Step 3Notecard info 
appears here

Notecard Buttons

Flip
(Only available 

for blocks, motifs, 
and stencils)

Move ClosePin



Understanding Sizes...........................................................................................36

Choosing a Quilt Layout......................................................................................38

Making a Horizontal Quilt...................................................................................39

Making an On-Point Quilt...................................................................................40

Making a Variable Point Quilt.............................................................................41

Making a Baby Blocks Quilt................................................................................42

Making a Variable Blocks Quilt...........................................................................43

Making a Horizontal or Vertical Strip Quilt.........................................................44

Choosing a Strip Style.........................................................................................46

Strip Formulas....................................................................................................47

Cloning a Strip....................................................................................................48

Making a One Patch or Photo Patchwork Quilt..................................................49

Making Custom Patches in a One Patch Quilt....................................................53

Making a Custom Set Quilt.................................................................................55

Creating a Quilt from a Block..............................................................................56

Using a Layout Library Quilt...............................................................................57

CHAPTER 2
Quilt Layouts

EQ8 has ten basic layout styles. All of these styles are adjustable, so you have endless design possibilities. To create  

your quilt design, you fill the blank spaces with blocks, fabrics, colors, and photos. EQ8 even has a Custom Set quilt  

layout, which gives you a large blank space to give you more flexibility in your quilt design. This chapter gives  

information about the size of your quilt, as well as the various quilt layout styles to help you determine which one  

will be best to create your design.

2
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UNDERSTANDING 
SIZES
It is extremely important that you understand 
how the settings you make on the Quilt 
Worktable > LAYOUT tab affect your quilt. To 
avoid confusion and printing patterns that 
won’t fit together or designing a quilt that is 
exponentially too large, please review this 
information. To see what we’ll be explaining, 
click the Quilt Worktable button. On the 
NEW QUILT tab, the Horizontal layout will be 
selected (if it’s not, click on it), and then click 
the LAYOUT tab.

Enter Finished Sizes
Never add seam allowance to the numbers 
you type in the palettes on the LAYOUT 
or BORDERS (see Chapter 3) tabs. You are 
designing the finished quilt; finished quilts 
don’t show seam allowance when you look at 
them. If you are mocking up a quilt found in 
a magazine or book, be sure you are entering 
the finished size of the block, not the cut size 
or the size it will measure before joining it to 
the other blocks. Likewise, if you are designing 
a quilt layout for blocks you already have 
sewn, measure the blocks, subtract the seam 
allowance from each side, and enter that 
finished size.

Seam allowance is automatically added by 
EQ8 at the printing stage. You have control 
over how wide the seam allowance is. If your 
block is 8 inches on the LAYOUT tab and your 
seam allowance is set to ¼ inch when you 
print, your block will be 8 ½ inches unfinished 
and will finish at the 8 inches you want.

Quilt Worktable
buttonLAYOUT tab

Enter finished sizes on the LAYOUT and BORDERS tabs

Seam allowance setting in the print dialog
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Finished Size of Quilt
As you enter numbers on the LAYOUT and 
BORDERS tabs, you can watch the quilt’s size 
change. The finished size of the quilt always 
shows in the bottom-right corner of your 
screen. Pay attention to this number if you 
are trying to make a quilt a specific size to fit 
a bed.

Always Choose Use Size 
from Quilt When Printing
If you like the finished size of the quilt in the 
bottom-right corner of your screen and like 
the way the quilt looks, print the patterns 
and always choose Use size from quilt. If you 
choose that option, EQ8 will read the sizes  
you have entered on the LAYOUT and 
BORDERS tabs for you and automatically 
print the pattern so it ends up that size. Don’t 
second guess the program and enter your  
own sizes; you could end up with blocks 
that don’t fit together if your math isn’t 
correct. The Use size from quilt option is very 
important when the block is not square; it is 
the only way to print the skewed pattern in 
Variable Point and Baby Blocks layouts, for 
example. See Chapter 9.

Verify Sizes with the Tape 
Measure Tool
The size will be correct, but if you ever 
question a size or what number you are 
entering, use the Tape Measure tool on 
the vertical toolbar on the left side of your 
screen. It lets you drag a line across the quilt 
to measure approximately how long it is. 
Remember, it is an approximation and is more 
accurate the closer you click and stop near the 
points of the actual object you are measuring. 
You may want to use it for Variable Point and 
Variable Blocks quilts so you understand how 
the numbers work.

NOTE
Every quilt has three layers. To learn more about 
these layers, see page 72.

Choose Use size from quilt in the print dialog to ensure 
your patterns print at the correct size for your quilt.

The finished size of the quilt is always shown at 
the bottom-right corner of the Quilt Worktable.

Using the Tape Measure tool, we can see that this 
Variable Point block is 8.00” across the width.
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CHOOSING A QUILT LAYOUT
Click the Quilt Worktable button, then the NEW QUILT tab. Choose a layout style on the ribbon. Here is a list of available quilt 
layout choices: 
 
A	 Horizontal layouts arrange blocks in  
	 horizontal and vertical rows. Blocks can  
	 be rectangular or square, and the layout  
	 can include optional sashing, corner blocks,  
	 and a sash border. 
 
B	 On-Point layouts contain on-point blocks  
	 tipped 45 degrees and can include optional  
	 sashing. 
 
C	 Variable Point layouts contain on-point  
	 squares of diamonds that measure through  
	 the block and can include optional sashing. 
 
D	 Baby Blocks layouts are overall grids of 3-D  
	 cubes made with equal-sided diamonds. 
 
E	 Variable Blocks layouts are like Baby  
	 Blocks, but the blocks can have unequal  
	 sides and tops. 
 
F	 Horizontal Strip quilts are long horizontal  
	 pieced or unpieced strips. 
 
G	 Vertical Strip quilts are long vertical pieced  
	 or unpieced strips. 
 
H	 One Patch quilts consist of one patch  
	 repeated throughout the quilt. 
 
I	 Photo Patchwork quilts are like One Patch  
	 quilt layouts, except these patches are  
	 filled with solid colors based on the colors  
	 of an image you select. 
 
J	 Custom Set layouts provide a large central  
	 area for placing blocks of different sizes.  
	 You can vary the height and width of this  
	 central area. Blocks of any size can be  
	 placed and aligned anywhere inside the  
	 center, even overlapping each other.

NOTES
Your quilt’s center size (without borders) will always 
appear at the top of the LAYOUT palette.

Use a Quick Quilt project, see page 21.

A B

C D

E F

G H

I J
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MAKING A 
HORIZONTAL QUILT

1.	 Click the Quilt Worktable button.

2.	 Click the NEW QUILT tab > Horizontal. 
A blank Horizontal quilt layout will 
appear.

3.	 Click the LAYOUT tab.

4.	 Under NUMBER OF BLOCKS, click the 
arrows beside Horizontal and Vertical 
to choose the number of blocks you 
want. (You can also type in these boxes 
by double-clicking on the number.)

5.	 Under FINISHED SIZE OF BLOCKS, 
choose the block size you want. Check 
Keep width and height equal to keep 
your blocks square. Change the sizes in 
any of the following ways: 
 
•	 Type a new size in the box 
 
•	 Drag the slider bar on the line 
 
•	 Click to the right or left of the slider  
	 bar to have the number jump in  
	 increments

6.	 Under FINISHED SIZE OF SASHING, 
choose the sashing size you want. 
Check Keep width and height equal to 
keep your cornerstones square. For no 
sashing, make the sash size 0.000. The 
sizes can be changed the same three 
ways described in step 5. Check Include 
sash border if you want sashing not 
only between the blocks, but around 
the outside of them, too.

7.	 Click the BORDERS tab to adjust, add, 
delete, or insert borders. See page 63.

8.	 Click the DESIGN tab to start filling your 
quilt. See Chapter 4 (page 71).

NOTE
To make adjustments in the LAYOUT palette faster, 
you can use the keyboard TAB key to cycle between 
entries and type immediately.

Step 1

Step 3

NEW QUILT tab

Step 2

Step 5

Step 7 Step 8

How blocks are measured: The width and height you input are the edges of the squares  
(or rectangles) you see. The sashing width is added to the left and right sides of your block. 

The sashing height is added to the top and bottom of your block.

Step 6

Width (8”)

He
ig

ht
 (8

”)

Sashing Height (1”)

Sashing Width (1”)

Step 4
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MAKING AN ON-POINT 
QUILT

1.	 Click the Quilt Worktable button.

2.	 Click the NEW QUILT tab > On-Point. A 
blank On-Point quilt layout will appear.

3.	 Click the LAYOUT tab.

4.	 Under SELECT A STYLE, click the circle 
next to the style you want (either 
triangles in the corners or a seam).

5.	 Under NUMBER OF BLOCKS, click the 
arrows beside Horizontal and Vertical 
to choose the number of blocks you 
want. (You can also type in these boxes 
by double-clicking on the number.)

6.	 Under FINISHED SIZE OF BLOCKS, 
choose the block size you want. You can 
change the edge length in any of the 
following ways: 
 
•	 Type a new size in the box 
 
•	 Drag the slider bar on the line 
 
•	 Click to the right or left of the slider  
	 bar to have the number jump in  
	 increments

7.	 Under FINISHED SIZE OF SASHING, 
choose the sashing size you want. For 
no sashing, make the sash size 0.000. 
The size can be changed the same three 
ways described in step 6. 

8.	 Click the BORDERS tab to adjust, add, 
delete, or insert borders. See page 63.

9.	 Click the DESIGN tab to start filling your 
quilt. See Chapter 4 (page 71).

NOTE
To make adjustments in the LAYOUT palette faster, 
you can use the keyboard TAB key to cycle between 
entries and type immediately.

How blocks are measured: The size of blocks you input here is the diagonal edge  
of the on-point squares. The sashing width is added on all sides of your block.

In this layout, your blocks will always be square. If you would rather have skewed 
diamonds, use the Variable Point layout instead. Be aware it measures differently.

Step 1NEW QUILT tab

Step 2

Step 3

Step 4

Step 6

Step 8 Step 9

Step 7

Step 5

Width (1
0”)

Sashing Width (1.5”)
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MAKING A VARIABLE 
POINT QUILT

1.	 Click the Quilt Worktable button.

2.	 Click the NEW QUILT tab > Variable 
Point. A blank Variable Point quilt 
layout will appear.

3.	 Click the LAYOUT tab.

4.	 Under SELECT A STYLE, click inside 
the circle of the style you want (either 
triangles in the corners or a seam).

5.	 Under NUMBER OF BLOCKS, click the 
arrows beside Horizontal and Vertical to 
choose the number of blocks you want. 
(You can also type in these boxes by 
double-clicking on the number.)

6.	 Under FINISHED SIZE OF BLOCKS, 
choose the block size you want. You can 
change the Width and Height through 
the block in any of the following ways: 
 
•	 Type a new size in the box 
 
•	 Drag the slider bar on the line 
 
•	 Click to the right or left of the slider  
	 bar to have the number jump in  
	 increments

7.	 Under FINISHED SIZE OF SASHING, 
choose the sashing size you want. For 
no sashing, make the sash size 0.000. 
The size can be changed the same three 
ways described in step 6. 

8.	 Click the BORDERS tab to adjust, add, 
delete, or insert borders. See page 63.

9.	 Click the DESIGN tab to start filling your 
quilt. See Chapter 4 (page 71).

NOTE
To make adjustments in the LAYOUT palette faster, 
you can use the keyboard TAB key to cycle between 
entries and type immediately.

Step 1

Step 3

NEW QUILT tab

Step 2

Step 4

Step 8 Step 9

How blocks are measured: The sizes you input here are NOT the edges of the Variable 
Point blocks you see. The Width is the horizontal measurement from point to point through 

the block. The Height is the vertical measurement from point to point through the block. 
The sashing Width is added horizontally out on all sides of your block.

Step 6

Step 5

Step 7

Width (9”)

Sashing 
Width (2”)

Height (14”)
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MAKING A BABY 
BLOCKS QUILT

1.	 Click the Quilt Worktable button.

2.	 Click the NEW QUILT tab > Baby Blocks. 
A blank Baby Blocks quilt layout will 
appear.

3.	 Click the LAYOUT tab.

4.	 Under NUMBER OF BLOCKS, click the 
arrows beside Horizontal and Vertical 
to choose the number of blocks you 
want. (You can also type in these boxes 
by double-clicking on the number.)

5.	 Under FINISHED SIZE OF BLOCKS, 
choose the block size you want. You can 
change the size in any of the following 
ways: 
 
•	 Type a new size in the box 
 
•	 Drag the slider bar on the line 
 
•	 Click to the right or left of the slider  
	 bar to have the number jump in  
	 increments

6.	 Click the BORDERS tab to adjust, add, 
delete, or insert borders. See page 63.

7.	 Click the DESIGN tab to start filling your 
quilt. See Chapter 4 (page 71).

NOTE
To make adjustments in the LAYOUT palette faster, 
you can use the keyboard Tab key to cycle between 
entries and type immediately.

Step 1NEW QUILT tab Step 2

Step 3

Step 5

Step 6 Step 7

How blocks are measured: The size of blocks you input is the edge length of all 
the sides of the Baby Blocks you see. There is no sashing for this layout style.

Step 4

Finished 
Size (10”)

Finished Size (10”)
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MAKING A VARIABLE 
BLOCKS QUILT

1.	 Click the Quilt Worktable button.

2.	 Click the NEW QUILT tab > Variable 
Blocks. A blank Variable Blocks quilt 
layout will appear.

3.	 Click the LAYOUT tab.

4.	 Under NUMBER OF BLOCKS, click the 
arrows beside Horizontal and Vertical 
to choose the number of blocks you 
want. (You can also type in these boxes 
by double-clicking on the number.)

5.	 Under FINISHED DIMENSIONS OF 
TOP, choose the size you want. You 
can change the Horizontal and Vertical 
sizes in any of the following ways: 
 
•	 Type a new size in the box 
 
•	 Drag the slider bar on the line 
 
•	 Click to the right or left of the slider  
	 bar to have the number jump in  
	 increments

6.	 Under FINISHED DIMENSIONS OF SIDE, 
choose the Vertical length of side you 
want. This size can be changed the 
same three ways described in step 5.

7.	 Click the BORDERS tab to adjust, add, 
delete, or insert borders. See page 63.

8.	 Click the DESIGN tab to start filling your 
quilt. See Chapter 4 (page 71).

NOTE
To make adjustments in the LAYOUT palette faster, 
you can use the keyboard Tab key to cycle between 
entries and type immediately.

Step 3

Step 6

Step 7 Step 8

Step 1NEW QUILT tab Step 2

How blocks are measured: The Horizontal and Vertical dimensions you input for the 
top are NOT the edges of the “top” variable block you see. Horizontal is the horizontal 

measurement from point to point through the “top” block. Vertical is the vertical 
measurement from point to point through the “top” block. Under FINISHED DIMENSIONS 

OF SIDE, Vertical is the edge length of that vertical line.

Step 5

Step 4

Horizontal (16”)

Vertical Top 
(10”) Vertical 

Side (3”)
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MAKING A HORIZONTAL OR VERTICAL STRIP QUILT 
A strip quilt is made up of either horizontal rows or vertical columns, each of which can have its own style and Width. The 
Length will be the same for all the strips. These rows will feel similar to adjusting border styles (see Chapter 3), more so than 
setting up a traditional layout.

1.	 Click the Quilt Worktable button.

2.	 Click the NEW QUILT tab > Horizontal 
Strip, to have your strips go from left 
to right (horizontally). Click Vertical 
Strip to have the strips go up and down 
(vertically). A blank Strip quilt layout 
will appear.

3.	 Click the LAYOUT tab.

4.	 Under SELECT STRIP, choose the strip 
you want to work on. You can either 
click directly on the strip in the quilt 
or use the left and right arrows to go 
back and forth between the strips. The 
selected strip always appears gray in 
the quilt layout.

5.	 (Optional) Put a check in Clone the 
selected strip to copy the settings of 
the selected strip whenever you click 
Add or Insert. See page 48.

NOTE
If Clone the selected strip is checked and you click 
Add or Insert, the selected strip will be copied. If it 
is unchecked, a plain 2-inch strip will be added or 
inserted. See page 48.

6.	 Once a strip is selected you can do any 
of the following: 
 
•	 Click Add to add a new strip to the  
	 end of the existing strips 
 
•	 Click Delete to remove the selected  
	 strip 
 
•	 Click Insert to put a new blank strip  
	 in front of the selected strip

7.	 Under STRIP STYLE AND SIZE, click the 
down arrow on the Select a strip style 
box. Click on a style name in the list to 
make your choice.

Step 1NEW QUILT tab Step 2

Step 3

Step 4

Step 5
Step 6

Step 7

Selected strip
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8.	 Under STRIP STYLE AND SIZE, choose 
the strip size you want. The Width can 
be different for every strip, but the 
Length will be the same for all. You can 
change the size in any of the following 
ways: 
 
•	 Type a new size in the box 
 
•	 Drag the slider bar on the line 
 
•	 Click to the right or left of the slider  
	 bar to have the number jump in  
	 increments

9.	 If you choose a style which allows 
for blocks, then one or both of the 
NUMBER OF BLOCKS boxes will become 
editable. Click the arrows beside Along 
length and Across width to set the 
number of blocks. (You can also type in 
these boxes by double-clicking on the 
number.) Across width will be disabled 
for all styles except Checker Board.

10.	 Repeat steps 4-9 for each strip in the 
quilt.

11.	 Click the BORDERS tab to adjust, add, 
delete, or insert borders. See page 63.

12.	 Click the DESIGN tab to start filling your 
quilt. See Chapter 4 (page 71).

NOTES
To make adjustments in the LAYOUT palette faster, 
you can use the keyboard TAB key to cycle between 
entries and type immediately.

The numbers for Along length and Across width 
determine how many blocks to add and have 
nothing to do with size.

You may want to see page 47 for strip formulas for 
making strips with perfect squares or 90 degree 
angles.

How blocks are measured (Horizontal Strip quilt): The horizontal length stays the same for 
all strips. The vertical width can be different for each strip.

Step 11 Step 12

Step 8

Step 9

Length

Width

How blocks are measured 
(Vertical Strip quilt): The vertical 

length stays the same for all 
strips. The horizontal width can 

be different for each strip.

Length

Width
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CHOOSING A STRIP STYLE

Checker Board

Plain

Pieced Blocks

Half Drop Blocks

Spaced Squares

Points A

Points B

Diamonds

Half Drop Diamonds

Double Diamonds

Half Drop Double Diamonds
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Example A using Pieced Blocks:

10 (Strip Width) x 5 (Number of blocks) = 50 
(Strip Length)

Example B using Double Diamonds:
11 (Strip Width) x 4 (Number of blocks ÷ 2) = 44 

(Strip Length)

Example C using Points A:
4 (Strip Width) x 10 (Number of blocks x 2) = 40 

(Strip Length)

Example D using Checker Board:
60 (Strip Length) ÷ 10 (Strip Width) = 6

6 x 3 (Blocks Across width) = 18 (Blocks Along 
length)

STRIP FORMULAS
Use the formulas below when you want perfect 
squares or 90 degree angles in your strips. These 
formulas are the same for both Horizontal or Vertical 
Strip quilts.

A	 For Pieced Blocks, Half Drop Blocks, Diamonds,  
	 and Half Drop Diamonds 
	 To create perfect squares or 90 degree angles: 
	 Strip Width x Number of blocks = Strip Length

B	 For Double Diamonds and Half Drop  
	 Double Diamonds 
	 To create perfect squares or 90 degree angles: 
	 Strip Width x (Number of blocks ÷ 2) =  
	 Strip Length

C	 For Points A and Points B 
	 To create triangles with a 90 degree angle: 
	 Strip Width x (Number of blocks x 2) =  
	 Strip Length

D	 For Checker Board 
	 To create perfect squares or 90 degree angles: 
	 First divide the Strip Length by the Strip Width.  
	 Multiply that number by the number of blocks  
	 Across width. This will equal the number of blocks  
	 Along length.

NOTE
The maximum number of blocks horizontally and vertically 
can range from 24-100. If you can only set Numbers of 
blocks to 24 and need it to be higher, change it in Quilt 
Worktable Options. Click the Worktable Options button on 
the left toolbar. Under Layout Options > All Styles, change 
the number in the second box beside Maximum number of 
blocks horizontally and vertically and click OK. 
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CLONING A STRIP
To clone a strip you must have either a 
Horizontal or Vertical Strip quilt layout on 
the screen. Cloning will copy the Layout tab 
settings of the selected strip and make new 
strips the same. This feature is great for 
creating consistent spacers or rows, as well as 
for creating Bargello quilts.

1.	 Click the LAYOUT tab.

2.	 Click in the quilt on the strip you want 
to clone.

3.	 Under SELECT STRIP, put a check in 
Clone the selected strip.

4.	 Click Add to put a copy of the selected 
strip at the end of the quilt. 
 
Click Insert to put a copy in front of the 
selected strip. 
 
A blank (empty) strip with the same 
settings as the cloned strip will be 
added or inserted. You will need to 
set blocks into and recolor this empty 
strip on the DESIGN tab, because EQ 
considers the clone strip a “new” strip.

NOTES
When you want a quilt of only one strip style, use 
the Delete button to delete all strips except one. 
Set the style and sizes for the single strip and clone 
it until the desired quilt size is achieved.

To quickly set up a strip quilt with two alternating 
strips, delete all but two strips in the quilt. Set the 
styles and sizes for each strip and put a check in 
Clone the selected strip. Select the first strip and 
click Add. Now alternate clicking between the left 
arrow (below SELECT STRIP) and the Add button 
(below the arrows) to quickly add the alternating 
strips.

Step 1

Step 3

Step 2

Step 4 - Add
Puts a copy of the selected strip  

at the end of the quilt

Step 4 - Insert
Puts a copy in front of the selected strip

Click the left arrow 
and the Add button 

repeatedly to quickly 
add alternating strips.
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MAKING A ONE PATCH OR PHOTO PATCHWORK QUILT
A Photo Patchwork quilt is a One Patch quilt filled with solid colors based on the colors of an image you select. Because the 
initial steps are the same and a Photo Patchwork quilt is saved as a One Patch quilt, you can follow the same directions for 
steps 1-7, then we’ll explain more about a Photo Patchwork quilt. 

Step 1NEW QUILT tab Step 2

Step 3

Step 6

Step 5

Step 4

Edge Length

Height

Width
How blocks are measured:

Edge length is the length of a side of a hexagon or cobblestone.
Height is the vertical measurement through the patch from the lowest point to the highest.
Width is the horizontal measurement through the patch from the furthest left point to the 

furthest right.

1.	 Click the Quilt Worktable button.

2.	 Click the NEW QUILT tab > One Patch 
or Photo Patchwork. A blank One Patch 
or Photo Patchwork quilt layout will 
appear.

3.	 Click the LAYOUT tab.

4.	 Click the down arrow under the Patch 
style box. Click a style name in the list 
to choose your patch type. 

5.	 Under NUMBER OF UNITS, click the 
arrows for Horizontal and Vertical to 
set the number of patches. See the EQ8 
Online Support site if you question how 
patches are counted.

6.	 Under FINISHED SIZE OF UNITS, choose 
the size you want. For some styles 
you choose Width and Height, and for 
others, Edge length. Change the size in 
any of the following ways: 
 
•	 Type a new size in the box 
 
•	 Drag the slider bar on the line 
 
•	 Click to the right or left of the slider  
	 bar to have the number jump in  
	 increments

7.	 Click the BORDERS tab to adjust, add, 
delete, or insert borders. See page 63.

8.	 Click the DESIGN tab to start filling your 
quilt. See Chapter 4 (page 71).

NOTES
To make adjustments in the LAYOUT palette faster, 
you can use the keyboard Tab key to cycle between 
entries and type immediately.

See page 96 for information on the Paintbrush 
designing/coloring options.	
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Designing a Photo 
Patchwork Quilt
For the initial layout of a Photo Patchwork 
quilt, follow steps 1-7 on page 49. You will see 
that the Design tab for this layout is rather 
different than the other layout styles.

8.	 On the Photo Patchwork quilt 
worktable, click the DESIGN tab.

9.	 You will need to Import a Photo and 
there are two ways to do this: 
 
If the photo you want to use is in the 
Project Sketchbook, click View Project 
Sketchbook and the Photos section. 
Select the photo and click Edit > to 
Quilt worktable. 
 
If the photo is not in the Project 
Sketchbook, click the Import Photo 
button. You will need to browse and 
locate where the photo is saved on 
your computer. Select it and click Open.

NOTE
Remember, you can use the Image Worktable to 
adjust color or add effects to your photo. (See 
Chapter 7.) Then make sure the photo is added 
to the Project Sketchbook so you can use the first 
option in step 9 to place it on the Quilt Worktable.

Once you have the photo on the worktable, if you 
decide you want to change the style or size of the 
shape, click on the LAYOUT tab and make whatever 
changes you wish. 

10.	 Click the Position & Resize tool. In the 
PHOTO PATCHWORK OPTIONS palette, 
under POSITION & RESIZE OPTIONS, 
click one of the three buttons to resize 
the photo automatically: 
 
•	 Inside Fit takes the longest edge of  
	 your photo and fits it proportionally  
	 inside the quilt center, thus fitting the  
	 entire photo inside. (If you don’t  
	 adjust your layout to match, you may  
	 have rows of uncolored patches  
	 along the edge of your layout.) 
 

Step 9
View Project 
Sketchbook

Step 9 – Import via the Sketchbook

Step 9
Import Photo in 

the palette

Step 9 – Import via the Photo Patchwork palette

Step 9

Step 8

Step 10

Fit options

Inside Fit:
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•	 Outside Fit takes the shortest  
	 edge of your image and lines it up  
	 proportionally with the quilt center.  
	 Some of the longer parts of the  
	 photo may fall outside the quilt  
	 center. Your borders will not be  
	 colored or affected. 
 
•	 Distort Fit ignores your photo  
	 proportions and fits each edge of the  
	 photo to each edge of the quilt  
	 center.

11.	 Click the Position & Resize tool to resize 
the photo manually. Click on the photo 
and you will have 8 points around the 
photo where you can click and drag to 
make the photo the size you wish.  
 
If Maintain Aspect Ratio is checked, 
when you pull on a corner or side 
handle of the photo, the image will 
resize but stay proportional and not 
skew. If Maintain Aspect Ratio is 
unchecked, you can pull on a handle in 
any direction to resize the image, but 
the photo will distort.

12.	 (Optional) Click the Mask tool. There 
are two ways to mask the edges of 
the image so you can see which parts 
of the image will be used. Masking is 
automatic, so you can choose to skip 
this step if you don’t care which parts 
of the image drop off.  
 
•	 Click Auto Mask to hide the edges of  
	 the photo that go past the quilt  
	 center. 
 
•	 To mask manually, click on the photo,  
	 then drag the handles in toward the  
	 center to hide the parts you don’t  
	 want to use. 
 
•	 To undo a mask, click Reset Mask.

Outside Fit:

Distort Fit:

Step 12

Without Auto Mask With Auto Mask
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13.	 Under Photo Patchwork Preview, click 
Show Quilt to convert the patches to 
solid colors. 

14.	 (Optional) You can switch back to the 
photo and continue resizing or masking 
it by clicking the Show Photo button.

15.	 Click the Layer 1 tab below the Quilt 
Worktable to view the photo as a 
quilt. You can make manual color 
adjustments if you wish, just like you 
would on any other quilt.

16.	 Click Add to Project Sketchbook to save 
the quilt. You can only save the quilt on 
Layer 1, not on the Photo tab.	

NOTES
See Chapter 7 to learn more about scanning, 
importing, saving, and other photo-editing options.

If you want to set an individual photo in a quilt, 
but don’t want to use the Photo Patchwork Quilt 
layout, see page 79.

(Optional) Color the Quilt
The colors created when the quilt is converted 
to solids are mathematical averages of the 
pixels that overlap that patch. If you want to 
replace them with colors or fabrics from the 
Sketchbook, you can do so quickly with the 
Randomize tool.

17.	 Click Fabric Tools on the ribbon, then 
choose Randomize in the toolbox. 

18.	 Choose a mapping option: 
 
•	 Map to colors changes the quilt’s  
	 colors to the closest colors in the  
	 Sketchbook. 
 
•	 Map to fabrics changes the quilt’s  
	 colors to the closest fabrics in the  
	 Sketchbook.

19.	 Click on your quilt center. Your success 
will depend on the number of fabrics 
or colors in your Sketchbook. For more 
details on using the Randomize tool, 
see page 115.

Step 13

Step 15

Step 16

Step 17

Step 18

The solid colors have been converted  
to fabrics from the Sketchbook
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MAKING CUSTOM PATCHES IN A ONE PATCH QUILT
Custom patches start like other patch styles, but you can change their shape. Custom patches have light gray “glides,” which 
run horizontally or vertically from the patch corners (see step 7 illustration on the next page). Pull on the glides to change the 
shape. (These glides do not appear on the quilt, just on the ONE PATCH LAYOUT palette.)

1.	 Click the Quilt Worktable button.

2.	 Click the NEW QUILT tab > One Patch. 
A blank One Patch quilt layout will 
appear.

3.	 Click the LAYOUT tab.

4.	 Click the down arrow under the Patch 
style box to choose either Custom or 
Custom (Glide). They are the first and 
last choices in the list.

5.	 Under NUMBER OF UNITS, click the 
arrows for Horizontal and Vertical to 
set the number of patches. (You can 
also type in these boxes.) See the EQ8 
Online Support site if you question how 
patches are counted. It may not be 
obvious.

6.	 Under FINISHED SIZE OF UNITS, choose 
the size you want for Width and Height. 
Change the size in any of the following 
ways: 
 
•	 Type a new size in the box 
 
•	 Drag the slider bar on the line 
 
•	 Click to the right or left of the slider  
	 bar to have the number jump in  
	 increments

Step 1NEW QUILT tab Step 2

Step 3

Step 4

Step 5

Step 6
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The gray dashed 
lines are “glides”

Step 7
Drag a glide to a 

new position

Step 8 Step 9

How blocks are measured: Height is the vertical measurement through the patch  
from the lowest point to the highest. Width is the horizontal measurement through  

the patch from the furthest left point to the furthest right.

7.	 Position your cursor over one of the 
gray glides in the display beneath Patch 
style. Click, hold, and drag the glides to 
a different position. When you release 
the mouse, the patch will fill the quilt.

8.	 Click the BORDERS tab to adjust, add, 
delete, or insert borders. See page 63.

9.	 Click the DESIGN tab to start filling your 
quilt. See Chapter 4 (page 71).

NOTES
Making a custom patch also works the same for a 
Photo Patchwork quilt layout.

If you don’t like the custom patch you’ve created 
and want to start shaping it again or use a different 
patch style, all you have to do is click the down 
arrow under the Patch style box to choose the style 
you want.

Width

Height
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MAKING A CUSTOM SET QUILT
A Custom Set quilt can be filled with large and small blocks together in one quilt. This layout style starts out as a large blank 
space that you can fill with any blocks, any size, anywhere on your quilt.

All other layout styles have shortcuts for filling the layout quickly. No shortcuts are possible with Custom Set because anything 
goes! Create the layout by setting each individual block exactly as you want.

1.	 Click the Quilt Worktable button.

2.	 Click the NEW QUILT tab > Custom Set. 
A blank Custom Set quilt layout will 
appear.

3.	 Click the LAYOUT tab.

4.	 (Optional) Place a check in the Keep 
width and height equal box if you want 
the width and height equal. (With this 
checked, you only have to adjust either 
the Width or Height.)

5.	 Under SIZE OF CENTER RECTANGLE, 
choose the size you want for Width and 
Height. You can change the size in any 
of the following ways: 
 
•	 Type a new size in the box 
 
•	 Drag the slider bar on the line 
 
•	 Click to the right or left of the slider  
	 bar to have the number jump in 	  
	 increments.

6.	 (Optional) Place a check in the 
Maintain the existing block sizes when 
resizing the layout box if you’ve already 
set blocks in the layout and you’d like 
them to remain the same size, even 
if you change the dimensions of the 
center rectangle.

7.	 Click the BORDERS tab to adjust, add, 
delete, or insert borders. See page 63.

8.	 Click the DESIGN tab to start filling your 
quilt. See Chapter 4 (page 71).

Step 1NEW QUILT tab Step 2

Step 3

Step 7 Step 8

Step 5

NOTES
See page 57 to learn how to use Layout Library quilts (many of which are Custom 
Set). These quilts are pre-designed and ready for you to set blocks into them.

See steps 9 – 15 on page 58 for information on how to resize your layout. 

Step 4

Step 6
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CREATING A QUILT FROM A BLOCK
EQ8 can turn a block into a quilt layout, but the block must have only horizontal and vertical lines. This feature creates Custom 
Set quilts automatically for you, so make sure you understand the rest of the topics in this chapter when you go to fill or edit 
your Custom Set quilt.

1.	 Start on the Quilt Worktable with 
blocks in your Sketchbook and the 
Sketchbook closed.

2.	 Click Quilt > Create Quilt from Block.

3.	 Under Select a block on the left, 
Sketchbook blocks with only horizontal 
and vertical lines will be shown in a 
column. At the right, you will see a 
quilt layout, made from the selected 
block. You may need to drag the vertical 
scrollbar to see all the blocks. Click any 
block to see it shown as a quilt layout.

4.	 Drag the Width and Height slider 
bars or type in the boxes to set the 
Custom Set quilt size. (Choose a size 
proportional to the block’s grid.)

5.	 Click the Add to Sketchbook button to 
add the quilt layout to the Sketchbook. 
Add as many quilts as you’d like. Click 
Close when finished.

6.	 To use the quilt layout, click the View 
Project Sketchbook button, then click 
the Quilts section. Select the quilt and 
click Edit. Your layout is ready to fill 
with blocks and color.

NOTES
Add your layouts to the My Favorite Layouts, see 
page 211.

You can draw your own blocks to turn into Custom 
Set quilts. Start a new Pieced EasyDraw block (see 
page 120). It can be a square or rectangular block. 
Make sure the snaps match the dimensions of your 
block. Use the Line tool (page 123) to draw only 
horizontal or vertical lines (the snaps will help you 
keep them straight). Add the block to the Project 
Sketchbook and switch to the Quilt Worktable. 
When you choose a size in step 4 above, choose 
one that is proportional or equal to the dimensions 
of your block.

Step 2

Step 4

Step 3

Step 5

Step 6

Step 6
View Project Sketchbook
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USING A LAYOUT 
LIBRARY QUILT
The Layout Library is filled with over 540 quilts 
for you to add to your Project Sketchbook and 
use. Many in the Layouts by Style category are 
Custom Set quilts.

Add the Layout to Your 
Project Sketchbook

1.	 Click Libraries > Layout Library.

2.	 Click to open the Layouts by Size or 
Layouts by Style category. If there is 
a + beside them, click on that for the 
respective examples to appear. 

3.	 Click the size or style you want to see.

4.	 Click the quilt (or quilts) you want to 
use. To select multiple items, you can: 
 
•	 CTRL+click (Command+click)  
	 individual items 
 
•	 SHIFT+click a range of items 
 
•	 CTRL+A (Command+A) to select all  
	 the items in the style.

5.	 Click the Add to Sketchbook button. 
The selected quilt(s) will disappear 
temporarily to show they’ve been 
added to the Sketchbook.

6.	 Click Close to return to the worktable.

Edit the Layout
7.	 Click View Project Sketchbook > Quilts 

section.

8.	 Select the Layout Library quilt you want 
to use and click the Edit button. You 
will be on Layer 1 of the DESIGN tab 
and the finished quilt size, as well as 
the quilt layout style, will show in the 
bottom-right corner of your screen.

Step 1

Step 2

Step 3

Step 5

Step 6

Step 7
View Project Sketchbook

Step 7

Step 8

Find the quilt layout style and the finished size 
of the Layout Library quilt at the bottom-right of the screen.
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(Optional) Resize the 
Layout
If you did not choose a Custom Set quilt, you 
can just resize the quilt on the LAYOUT tab and 
skip these steps. If the layout style is Custom 
Set, use the following steps.

9.	 On the DESIGN tab, click Block Tools on 
the ribbon. 

10.	 Click the Adjust tool in the palette.

11.	 Click on blocks in the quilt one by one 
and view the sizes in the palette under 
Adjust Block.

12.	 Click the LAYOUT tab to view the Size of 
quilt’s center layout.

13.	 If the sizes you view are not to your 
liking (and cannot be solved by adding 
or deleting borders), you will want to 
resize the quilt. Decide how you want 
the quilt to resize: 
 
•	 Put a check next to Maintain the  
	 existing block sizes when resizing  
	 layout if you want the block sizes to  
	 stay the same (and have white space  
	 added to the right and bottom sides  
	 of the quilt). 
 
•	 Uncheck Maintain the existing block  
	 sizes when resizing layout if you want  
	 everything in the quilt to resize (and  
	 still touch the edges).

14.	 Change the size of the center rectangle 
on the CUSTOM SET LAYOUT palette.

15.	 When you click the DESIGN tab, your 
quilt will be resized according to your 
choice in step 13.

Step 9

Step 11
Select a block in the layout

View the finished block 
size in the palette

Step 10

Step 12

Maintain existing block sizes unchecked:
The blocks resize proportionally to fit the  

new quilt size.

Maintain existing block sizes checked: White 
space is added to the right and bottom sides 
of the quilt. The block sizes do not change.

Step 13

Step 14
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CHAPTER 3
Borders

The border tools in EQ8 allow you great flexibility. You can build your own custom borders from scratch, choosing from  

22 styles. Or you can use the Set Auto Borders tool to set pre-designed borders with a click. This chapter tells you  

how to use all the border styles and tools.

3
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BORDER STYLES

Mitered Corner Blocks Long Vertical

Long Horizontal Blocks Half Drop Blocks

Spaced Squares Diamonds Half Drop Diamonds

Double Diamonds Half Drop Double Diamonds Big & Little Diamonds
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See page 70 for details on two 
additional border styles: Blocks 
Aligned Inside and Half Drop Aligned.

Half Drop Big & Little Diamonds Points Out Points In

Big & Little Points Out Big & Little Points In Tile Squares

Tile On Point Tile On Point Corners
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CHOOSING A BORDER 
STYLE
Begin on the Quilt Worktable. If you want to 
select a different quilt layout, see page 38.

1.	 Click the BORDERS tab. The BORDERS 
ribbon will appear. All quilt layouts have 
one, 1-inch Long Horizontal border 
by default. You can either resize this 
border (see page 64) or choose a new 
border style.

2.	 Click on any of the border styles on the 
ribbon to select the style and have it 
appear as the quilt’s new border. You 
will know the selected border style is 
the quilt border because it will be gray.

NOTE
The default border style for new borders is 
Long Horizontal, unless you change it. Click the 
Worktable Options button on the left vertical 
toolbar. Under Tool Options, click Starting New 
Quilts and click the drop-down menu below Default 
border style to choose a different style. Click OK. 
No matter what style you select to be the default 
border, the size will always be 1-inch on all 4 sides.

Blocks in Border Styles
If you have selected a border style with blocks 
in it, you can change the number of blocks 
in that border. At the bottom of the BORDER 
OPTIONS palette the BLOCKS IN BORDER 
number boxes are only active for styles with 
block spaces. 

3.	 If the number boxes are active, click 
the left and right arrows to select the 
number of blocks you want. (In some 
border styles, only one number box can 
be changed.)

NOTES
Each border can be a different size, but all four 
borders must be the same style. For a trick that 
gives the effect of making each border a different 
style see page 68.

You can set blocks into all border spaces except 
Mitered borders. Blocks will stretch or skew to fit 
the border space.

Step 1

Borders 
Ribbon

Default 1-inch Long 
Horizontal Border

You may have to click and 
drag the vertical scrollbar to 

see this option in the palette.

Step 3

Click the double arrows 
on the ribbon to see all 

of the border styles.

Step 2
Click on a border style on 

the ribbon to select it.
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ADDING, DELETING, OR 
INSERTING A BORDER
Begin on the Quilt Worktable. If you want to 
select a different quilt layout, see page 38.

1.	 Click the BORDERS tab. The BORDERS 
ribbon will appear with the BORDER 
OPTIONS palette below.

2.	 To add a border, click the Add button in 
the BORDER OPTIONS palette. A blank, 
Long Horizontal border with 1-inch 
sides will be added around the outside 
of your quilt. 
 
To delete a border, position your cursor 
directly over the quilt and click on the 
border you wish to delete. The border 
turns gray, showing it is selected. Click 
the Delete button in the BORDER 
OPTIONS palette. The selected border 
will disappear. 
 
To insert a border, position your cursor 
directly over the quilt and click on 
the border you wish to insert another 
border inside of. Click the Insert button 
in the BORDER OPTIONS palette. A Long 
Horizontal border with 1-inch sides 
will be added inside of the border you 
selected.

NOTES
To add or insert a border with the same size and 
settings as another border on your quilt, see how 
to clone a border on page 65.

If you added or inserted a border, you can now 
change the border style and size, see pages 62 and 
64 .  

BEFORE
Diamond border selected

Click Add to add a border outside the quilt
AFTER

BEFORE
Diamond border selected

Click Delete to remove the currently selected border
AFTER

BEFORE
Long Horizontal border selected

Click Insert to insert a border inside  
the currently-selected border

AFTER
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SIZING BORDERS
It’s easy to change the size of the borders, all 
together or one at a time. 

1.	 Begin on the Quilt Worktable. If you 
want to select a different quilt layout, 
see page 38.

2.	 Click the BORDERS tab. The BORDERS 
OPTIONS palette will appear.

3.	 Click in the quilt on the border you 
wish to resize. The border turns gray, 
showing it is selected.

Sizing All Sides Together
4.	 By default, all four sides of a border 

are the same size (note the check in 
the box next to All under Lock size 
adjustments). If you want to maintain 
this symmetry while changing the size 
of the border you can: 
 
•	 Hold and drag any of the slider bars  
	 below Left, Top, Right, or Bottom 
 
•	 Click on either side of any of the  
	 slider bars to watch the size increase  
	 or decrease by 0.25 inches 
 
•	 Double-click on the number in any  
	 of the size boxes, type in a new size,  
	 and click on that respective box’s  
	 slider bar. 

Sizing the Left & Right 
or Top & Bottom Sides 
Together
If you want to size the Left and Right border 
sides together, click the box next to All to 
uncheck it and then click the box next to L+R 
to add a checkmark (you can’t add a check to 
L+R if there is a check next to All). Resize the 
Left and Right border sides simultaneously by 
using the options above (only adjusting the 
Left and Right slider bars or numbers).

Step 2

Step 3

Step 1

All four sides will 
size simultaneously 
when All is checked.

Step 4

Uncheck All and put a check next to L+R to size the 
Left and Right sides of the quilt at the same time.
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Similarly, if you want to size the Top and 
Bottom border sides together, click the T+B 
box to add a check. (This is only possible when 
there is no check next to All). Resize the Top 
and Bottom border sides simultaneously by 
using the options on page 64 (only adjusting 
the Top and Bottom slider bars or numbers).

Sizing Border Sides 
Individually
To size the sides individually, make sure there 
are no checks next to any of the Lock size 
adjustments boxes (if there are any checks, 
click on them to remove them). Use one of 
the options on page 64 to adjust any side.  

CLONING A BORDER
Begin on the Quilt Worktable with at least 
one border you want to clone. If you have not 
done this already, see page 62.

1.	 Click the BORDERS tab. The BORDER 
OPTIONS palette will appear.

2.	 Click (in the quilt) on the border you 
wish to clone. The border turns gray, 
showing it is selected.

3.	 In the BORDER OPTIONS palette, make 
sure there is a check in the box next to 
Clone the selected border. If not, click 
on the box so a checkmark appears. 

4.	 To put a copy of the selected border 
around the outside of the quilt, click 
the Add button. Or, to insert a clone 
of the border in front of the selected 
border, click the Insert button. A 
blank border with the same settings 
(style, size, and number of blocks, if 
applicable) as the cloned border is 
added to or inserted in your quilt.

NOTES
If you clone a border, it will not copy the colors 
or blocks used, so you will need to design the 
border again in order to add fabrics and blocks. EQ 
considers the cloned border a “new” border.

If you want to keep your current border style, but 
change the quilt layout style, see page 67.

Uncheck All and put a check next to T+B to size the 
Top and Bottom sides of the quilt at the same time.

BEFORE
Big & Little Diamonds border selected

Click Add to add a clone of the selected  
border on the outside of the quilt.

AFTER

Step 3

BEFORE
Big & Little Diamonds border selected

Click Insert to insert a clone of the 
border inside of the selected border.

AFTER

Step 3
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USING THE SET AUTO 
BORDERS TOOL
Begin on the Quilt Worktable with a quilt that 
has at least one border on it to change. If you 
want to change the quilt layout or border 
styles, see pages 38 and 62.

1.	 Click on the DESIGN tab and then Auto 
Borders from the ribbon options. 

2.	 Under SELECT A BORDER STYLE, click 
the down arrow to display choices. 
Click to select the style of your choice.

3.	 Click and drag the horizontal scrollbar 
(beneath the auto borders style you 
selected) to see them all. Click to select 
a border.

4.	 Click the border on your quilt. The 
selected border will fill with the auto 
border you chose.

5.	 (Optional) If you want to change the 
size or number of blocks, if applicable, 
of the auto border, click on the 
BORDERS tab and adjust accordingly. 
See page 62.

6.	 (Optional) Click the DESIGN tab and 
click on Fabric Tools (see page 96) if you 
want to recolor the auto border.

NOTES
Auto Border blocks work just like other blocks. If 
you don’t like them in the quilt, click a different 
block (or Auto Border style) on top of them and the 
new one will appear.

On the BORDERS tab, do not change the border 
style or your automatic border will disappear from 
the quilt. You can only change BORDER SIZE or 
BLOCKS IN BORDER.

If you like the border styles available on the 
BORDERS tab filled with fabric (rather than using 
the border spaces for blocks), try using the Single 
Block Patterns from the Auto Borders styles 
instead. These set as one long block and print in 
one pattern instead of many separate ones.

Use Tile Squares as your border style before clicking 
in an auto border to make them the perfect size.

Step 1

Step 2

Use the scrollbar to see all the 
borders in the selected style

Step 3

Step 4
Click on the border on the quilt 
to apply the auto border style
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KEEPING BORDERS 
WHEN CHANGING 
LAYOUTS
If you have a quilt with a series of borders you 
like, you can reuse these borders on another 
quilt. When you switch to a new layout, you 
won’t lose your current border settings, but 
the blocks, fabrics, or colors will erase from 
the border.

Begin on the Quilt Worktable and have the 
quilt with the borders you like on the screen.

1.	 Click Quilt on the menu at the top and 
click Keep Current Borders to put a 
check next to it. (The menu will close, 
so you will not see the check until the 
next time you use the Quilt menu.)

2.	 Now click the NEW QUILT tab and 
select a new layout style. You will see 
the new quilt layout style with the 
same border style as your previous 
layout.

3.	 (Optional) If you want to change the 
size or number of blocks, if applicable, 
of the border(s), click on the BORDERS 
tab and adjust accordingly. See page 62.

4.	 Click on the DESIGN tab and click on 
Block Tools (see page 73) or Fabric Tools 
(see page 96) to set blocks or color the 
border(s).

NOTES
The Keep Current Borders option will stay turned 
on (have a check next to it) until you click it again to 
turn it off.

Keep Current Borders only works during the same 
session of EQ8. If you close the program or switch 
projects, EQ8 will forget which border you used 
last.

Step 1

Original quilt and borders

Step 2

Choose a 
new layout 
style on the 

ribbon

New quilt with same border styles as the original
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MAKING EACH SIDE A DIFFERENT BORDER STYLE
To make one border that appears to have different styles on each side, you actually make four separate borders and eliminate 
3 sides on each. This is easier than it may sound.

Begin on the Quilt Worktable with the quilt layout that you want to add borders to on the screen, see page 38. We will add 
borders to the layout, so only having the default 1-inch Long Horizontal border is perfect.

1.	 Click the BORDERS tab. The BORDER 
OPTIONS palette will appear.

2.	 Under BORDER SIZE click on any boxes 
under Lock size adjustments that 
have checks in them to remove the 
checkmarks. Now each border side can 
be sized independently.

3.	 If your quilt started with a 1.000” Long 
Horizontal border, use this border. 
Otherwise, click Add.

Bottom Border
4.	 Click, hold and drag the Left, Top, and 

Right slider bars (everything but the 
Bottom) one at a time all the way to 
the left, so that the size is 0.000. This 
eliminates all but the Bottom side.

Left Border
5.	 Click the Add button. This adds a 1-inch 

Long Horizontal border all around your 
quilt. 

6.	 Click, hold and drag the Top, Right and 
Bottom slider bars (everything but 
the Left) one at a time all the way to 
the left, so that the size is 0.000. This 
eliminates all but the Left side from 
your second border.

Top Border
7.	 Click the Add button. 

8.	 Click, hold and drag the Left, Right and 
Bottom slider bars (everything but 
the Top) one at a time all the way to 
the left, so that the size is 0.000. This 
eliminates all but the Top side from 
your third border. 

Step 2
Uncheck all boxes under Lock size adjustments

Step 1

Step 4

Step 6

Step 8

Step 5

Step 7
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Right Border
9.	 Click the Add button. 

10.	 Click, hold and drag the Left, Top and 
Bottom slider bars (everything but 
the Right) one at a time all the way to 
the left, so that the size is 0.000. This 
eliminates all but the Right side from 
your fourth border. Your Top, Bottom 
and Left borders will still appear since 
they are part of your first, second and 
third borders.

Modify Sizes, Styles and 
Number of Blocks

11.	 Click directly on a border in the quilt 
to select it. (Note: In the BORDER 
OPTIONS palette under SELECT BORDER 
it will let you know which border it is, 
i.e. 3 of 4. You can click on the arrows 
to toggle between the 4 borders.)

12.	 Under Select a border style, click the 
down arrow to display border style 
choices and click on a name to select 
it. If your selected style has blocks, 
click the BLOCKS IN BORDER arrows to 
choose the number of blocks.

13.	 Three sides will be set to 0.000. If you 
need to change the size of the selected 
border, modify the side that is NOT set 
to 0.000.

14.	 Repeat steps 11-13 for the remaining 
sides.

NOTES
Use a similar method to make a quilt with a “pillow 
covering” top border which is different than the 
sides and bottom borders. Or, simply eliminate the 
top border.

Depending on the order you add the borders, you 
can get Log Cabin-like or Court House Steps-like 
borders.

The exceptions to the border styles that can be 
chosen in step 12 are all the borders starting with 
Tile (Tile Squares, Tile On Point, Tile On Point 
Corners). These must always have 4 sides.

Step 9

Step 10

Step 11
Click directly on the quilt to 

select the border, or select the 
border in the palette.

Example quilt with each border side a different style and size.
Border Settings:

Left: Blocks, 4.000”
Top: Points In, 2.500”

Right: Half Drop Diamonds, 4.000”
Bottom: Big & Little Points In, 2.500”

Order for borders added in  
Log Cabin style

1

2

3

4

Order for borders added in  
Court House Steps style

1

4

2

3
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UNDERSTANDING “ALIGNED” BORDERS
EQ8 has two border styles found at the far right of the BORDERS ribbon options (you may have to use the double arrows to 
see these styles). These styles need a bit more explaining than the others.

When you want two adjacent borders to have rectangular blocks lined up exactly with one another, try setting the inner 
border as you like and using an Aligned style on the outer border. Set the number of blocks in the border (Horizontal and 
Vertical) to be the same for both borders.

Blocks Aligned Inside
The two example quilts on the right have 
a Blocks style border with 4 blocks (gray). 
Example A has an outer Blocks border with 4 
blocks. Notice the blocks in the outer border 
do not line up with the blocks of the inner 
border. Example B also has 4 blocks, but the 
outer border style is set to Blocks Aligned 
Inside. Notice in the Blocks Aligned Inside 
style you actually get two “extra” blocks that 
line up with the corner blocks of the inner 
border.

This works with other border styles as well. 
Example C shows a quilt with a Points In 
border. The blocks in the adjacent Blocks 
Aligned Inside border line up with the 
triangles of the inner border. (This only works 
if the same number of Horizontal and Vertical 
BLOCKS IN BORDER are selected for both 
borders.)

Try these border styles with Blocks Aligned 
Inside: Corner Blocks, Blocks, Half Drop 
Diamonds, Half Drop Double Diamonds, Big 
& Little Diamonds, Half Drop Big & Little 
Diamonds, Points In, Big & Little Points Out, 
Bit & Little Points In, and Tile Squares.

Half Drop Blocks Aligned
The Half Drop Blocks Aligned style works the 
same way. It is simply a “half-drop” style of 
the Blocks Aligned Inside border style. See 
Example D.

Try these border styles with Half Drop Blocks 
Aligned: Corner Blocks, Half Drop Blocks, 
Diamonds, Double Diamonds, Big & Little 
Diamonds, Half Drop Big & Little Diamonds, 
Points Out, Big & Little Points Out, and Tile On 
Point Corners.

Click the double arrows 
on the ribbon to see all 

of the border styles.

The Aligned border styles are the 
last two options on the ribbon

Example A
Border blocks do NOT line up when 
both are set to Blocks

Example B
Border blocks DO line up when the 2nd 

border is set to Blocks Aligned Inside

Example C 
Points In border (gray) and a Blocks Aligned Inside border

Example D
Half Drop Big & Little Diamonds border (gray) and a Half Drop Blocks Aligned border
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CHAPTER 4
Design Quilts with Blocks, Photos, and Embroidery

In this chapter you’ll learn how to further design your quilt by setting blocks (from the library or that you’ve drawn), 

photos, and embroidery on it. After setting these items, we’ll show you how to rotate and copy them, and other neat 

symmetry tricks. The 3 layers of the quilt that you can work on will be explained. While Layer 2 is typically used for 

floating applique elements, including text, and Layer 3 is for quilting stitches, this chapter will suggest other uses. With all 

of these options, you multiply your quilt design possibilities, so let your imagination go wild!

4
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UNDERSTANDING THE 
QUILT LAYERS
Every quilt has 3 layers. Whether you decide 
to use all 3 is up to you. Typically, Layer 1 is 
used for blocks and plain background fabric, 
Layer 2 is used for applique motifs (such as 
leaves, flowers, or text that you “float” on top 
of your pieced quilt), and Layer 3 is for thread 
(quilting stencils and embroidery). Photos can 
go on any layer.

There are two basic ways to add items to 
quilts: setting and drag and drop. Setting 
is used on Layer 1 of all the quilt layouts, 
which we’ll call “Standard Layouts.” Standard 
layouts are the first 7 layout options on the 
NEW QUILT tab of the Quilt Worktable (see 
page 38). For Custom Set, and Layers 2 and 
3 of all layout styles, you’ll use the drag and 
drop method. See pages 74 and 75. To better 
understand how items will “drop,” see page 
74. EQ8 will prompt you if you attempt to 
set a block when it should be dragged and 
dropped, and vice versa.

Using the Eye Icon
In EQ8 you will see the tabs for all 3 layers of 
the quilt, whether you use them or not, below 
the quilt design. For any layer, if you want to 
focus on another layer, for example, you can 
click on the “eye” on the tab for the layer you 
want to temporarily “disappear.” The eye icon 
will be crossed out and that layer’s items will 
not be visible, though you’ll still be able to 
see a transparency of Layer 1. Click on the eye 
again for the items to reappear.

Using the Hide/show quilt 
patch lines button
If you don’t want to see patch outlines, of any 
patch on any layer, including border blocks, 
click the Hide/show quilt patch lines button 
on the main toolbar. Even if you’ve changed 
the thread color for the outline of a block or 
motif, once you click this button those lines 
will temporarily disappear. Click it again and 
the lines will reappear. 

Quilt with all layers showing

Visibility icons on each layer at the 
bottom of the Quilt Worktable

Hide/show 
quilt patch lines

Quilt hiding patch lines

Quilt showing patch lines

Quilt with Layer 1 hidden to better 
see the applique and stencils

Applique text on Layer 2

Quilting stencil on Layer 3
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SETTING BLOCKS ON 
LAYER 1

1.	 With the block you want to set in 
your Project Sketchbook, click the 
Quilt Worktable button, then click the 
DESIGN tab. On the ribbon, choose 
Block Tools, then Set Block in the 
palette. 

2.	 Click on the block in the palette to 
select it (an outline will appear around 
the block). You may have to use the 
horizontal scrollbar to find it. 

3.	 (Optional) Select a different coloring of 
your chosen block by either using the 
coloring arrows at the bottom-right 
below the palette or right-clicking on 
the block and choosing Select Coloring.

Standard Quilt Layouts
Whether you use a default block, one from 
the library, or have drawn your own, it’s easy 
to set blocks in your quilt. (This is the method 
to use for the first 7 layout options on the 
NEW QUILT tab.)

4.	 Click a space on your quilt layout. Or, 
drag the block from the palette to the 
space in the quilt and release it. The 
selected block will pop into the quilt. 

NOTES
You can set a block into a sash, cornerstone, border 
block, or border strip in the same manner. The 
selected block will stretch to fit the space. 

Blocks cannot be set into mitered borders.

To remove a block immediately after setting it, click 
the Undo button, press CTRL+Z (Command+Z), or 
click the Erase Block tool and click on the block.

Step 1
DESIGN tab

Step 1
Block Tools

Step 2

Step 3

Step 1
Set Block tool

Step 4

If you drag and drop a block, aim the 
top-left corner of the block just inside the 

top-left corner of the block space.

When you release the mouse, 
the block will pop into the space.
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5.	 (Optional) Hold down the CTRL key 
(Command key) to set the block into 
all spaces on the quilt layout. Or, hold 
down the ALT key (Option key) to set 
blocks into alternate spaces on the 
layout. (Some layouts will require more 
than one click to fill.)

6.	 Click Add to Project Sketchbook.

NOTES
To replace a block, just set a new block on top 
of the old. You don’t need to erase or delete the 
block.

If you attempt to set motifs or stencils on Layer 1, 
you will see a pop-up message that this is not a 
default option.

Custom Set Quilt Layout
Setting blocks on Layer 1 of a Custom Set quilt 
is different because the layout does not have 
predefined spaces for your blocks to pop into.

4.	 Drag the block from the palette 
to where you want it on the quilt, 
and release. It will set either at the 
worktable dimensions on which it 
was designed or at a default size (see 
Notes). See page 80 to learn about 
where the block will “snap” on the 
quilt.

5.	 After dragging and dropping the block 
on the layout, you can use the Adjust 
tool to make adjustments to the size, 
position, or rotation. See page 82.

6.	 Click Add to Project Sketchbook.

NOTE
Click the Worktable Options button on the main 
toolbar. Under Tool Options, click Setting Blocks. 
Under Drag and Drop Options you can choose to 
have blocks set at the size they were designed, or 
at a default size you choose. 

Step 4
Drag the block from the palette to the quilt center

When you drag and drop the block, it will appear transparent until you release the mouse.

Step 5
CTRL+click (Command+click)  

fills every block space

Step 5
ALT+click (Option+click)  

fills alternating block spaces
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SETTING MOTIFS ON 
LAYER 2 AND STENCILS 
ON LAYER 3
You’ll need motifs and stencils in your Project 
Sketchbook, see page 200. Though you can 
set pieced blocks on Layer 2, they will not fill 
a space like on Layer 1, but instead will react 
like a motif. If you set a stencil on Layer 2, it 
will also become a patch/motif. You can set 
blocks and motifs on Layer 3, but they will be 
converted into stencils. These steps are used 
on Layers 2 and 3 of any quilt layout.

1.	 With the motif or stencil you want to 
set in your Project Sketchbook, click the 
Quilt Worktable button, then click the 
DESIGN tab. On the ribbon, click Block 
Tools, then Set Block in the palette.

2.	 On the Motifs or Stencils tabs, click on 
the motif or stencil in the palette to 
select it (an outline will appear around 
the motif or stencil). You may have to 
use the horizontal scrollbar to find it. 

3.	 Click the Layer 2 tab below the quilt 
worktable to set a motif or Layer 3 tab 
to set a stencil.

4.	 Drag the motif or stencil from the 
palette to where you want it on the 
quilt, and release. It will set either at 
the worktable dimensions on which it 
was designed or at a default size (see 
Note on page 74). See page 80 to learn 
about where the motif or stencil will 
“snap” on the quilt.

5.	 After dragging and dropping the motif 
or stencil on the layout, you can use the 
Adjust tool to make adjustments to the 
size, position, or rotation. See page 82.

6.	 Click Add to Project Sketchbook.

NOTE
To learn how to add text to Layer 2, see page 92.

Step 1
DESIGN tab

Step 1
Block Tools

Step 1
Set Block tool

Step 2

Step 3

Step 4 – Drag and drop a stencil to Layer 3 of the quilt

Step 4 – Drag and drop a motif to Layer 2 of the quilt
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SETTING PLAIN BLOCKS 
IN A QUILT
When you’d like to use a plain square or 
rectangle of fabric in a Custom Set layout, you 
can add a “plain block” to the Blocks palette. 

You can also set plain blocks on Layer 1 of a 
standard layout, but it’s not really necessary 
because you can just color the block spaces 
with the Paintbrush tool.

The following steps use a Custom Set layout. 

1.	 With a Custom Set quilt layout on the 
worktable, click the DESIGN tab. On the 
ribbon, click Block Tools, then Set Block 
in the palette, and the Blocks tab. 

2.	 Click the 3 dot button in the palette 
and choose Add Plain Block. A plain 
block will appear at the end of the 
palette and will automatically be 
selected.

3.	 Drag the block to where you want it on 
the quilt, and release. It will set at the 
default size (see Notes). See page 80 to 
learn about where the block will “snap” 
on the quilt.

4.	 After dragging and dropping the block 
on the layout, you can use the Adjust 
tool to make adjustments to the size, 
position, or rotation. See page 82.

5.	 Click Add to Project Sketchbook.

NOTES
To make the plain block the background block of 
your Custom Set quilt, check out the size of the 
center rectangle on the LAYOUT tab. Then use the 
Adjust tool to make the block’s position 0.000, 
0.000 and the block’s size match the numbers from 
the LAYOUT tab. See page 55.

Click the Worktable Options button on the main 
toolbar. Under Tool Options, click Setting Blocks 
and there are Drag and Drop Options. You can have 
blocks set at the size they were designed, or set at 
a default size you choose. 

Step 1
DESIGN tab

Step 1
Block Tools

Step 1
Set Block tool

Step 3 – Drag and drop the plain block on the quilt

Step 2

3 dot button
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FINDING A BLOCK, 
MOTIF, OR STENCIL 
USED IN A QUILT
If you want to find a block, motif, or stencil 
that you’ve already used in your quilt, but 
can’t remember where it is or quickly locate 
it (i.e., you have hundreds of blocks in your 
Project Sketchbook or many colorings of the 
same block), it’s as simple as clicking on the 
Eyedropper tool.

1.	 With the quilt where the item you want 
to find is on the worktable, click the 
DESIGN tab. On the ribbon, click Block 
Tools, then the Eyedropper tool in the 
palette.

2.	 Click the layer tab, below the quilt, 
where the item is set. 

3.	 Click on the item in the quilt you want 
to identify. That item will be selected 
with an outline around it in the palette.

4.	 If Toggle automatic tool snapping is 
selected in the palette, the Set Block 
tool will be engaged and you can 
immediately set the “found” item in the 
layout.

NOTES
If you want to keep finding blocks using the 
Eyedropper tool, click on the Toggle automatic tool 
snapping button to disengage it.

If the coloring is saved in the Project Sketchbook, 
the correct coloring will also be selected, but if 
the coloring is new, or not added to the Project 
Sketchbook yet, the last coloring in the block will be 
selected.

Step 1
DESIGN tab

Step 1
Block Tools

Step 1
Eyedropper tool

Toggle automatic tool snapping is selected, which means that after you “find” a block,  
the Set Block tool will automatically be selected so you can immediately set the block.

Step 3
Click on the block in the quilt and it will automatically be selected in the palette.

Step 2
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SETTING EMBROIDERY 
IN A QUILT
To set embroidery on Layer 3 of any quilt you 
need an embroidery design in your Project 
Sketchbook, see page 200. These steps are 
used for any quilt layout.

1.	 With the embroidery design in your 
Project Sketchbook, click the Quilt 
Worktable button, then click the 
DESIGN tab. 

2.	 Click the Layer 3 tab below the Quilt 
Worktable. 

3.	 On the ribbon, click Embroidery Tools, 
then Set Embroidery in the palette.

4.	 Click on the embroidery design in the 
palette to select it, drag it to where 
you want it on the quilt, and release. 
It will set at its recorded size. See page 
80 to learn about where the design will 
“snap” on the quilt.

5.	 Click Add to Project Sketchbook.

NOTES
The embroidery designs included with EQ8 are not 
sewable/digitized patterns. The digitizable designs 
are sold and copyrighted by the embroidery 
manufacturers. Contact the manufacturer listed 
on the Notecard for specific information regarding 
the actual files you would receive if you bought the 
embroidery card. 

EQ8 may allow you to manipulate the designs more 
than you can sew them. Pay attention to the size 
you set in EQ with regard to your possible hoop 
sizes. 

Color embroidery with the Thread Tools, see page 
105.

To delete the design, use the Adjust tool, select the 
design, and click your keyboard Delete key.

To learn how to rotate, flip, and adjust the size 
and position, see page 82. You can stay on the 
Embroidery Tools palette, as the tools will work the 
same way.

Embroidery designs are displayed in draft quality by default. To change to 3 dimensional, 
right-click on the design and choose Embroidery Drawing > 3 Dimensional. You can switch  

it back to Draft Quality by right-clicking on it again and selecting this option.

Step 1
DESIGN tab

Step 2

Step 3

Step 4

Draft Quality 3 Dimensional
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SETTING PHOTOS IN A QUILT
You can set a photo on Layer 2 of any quilt, but only on Layer 1 of a Horizontal or Custom Set layout. To set photos in your 
quilt, you need a photo in your Project Sketchbook. Photos can come from the Photo Library or be imported (see pages 200 or 
208).

Custom Set Quilts or Layer 2
1.	 Start with any quilt layout. Click the 

DESIGN tab and the layer tab below the 
Quilt Worktable where you want to set 
your photo: Layer 1 (Custom Set only), 
or Layer 2 (any style).

2.	 On the ribbon, click the Photo Tools 
option and Set Photo tool from the 
palette.

3.	 Click on the photo in the palette to 
select it, drag it to where you want it 
on the quilt, and release. It will set at 
its recorded size. See page 80 to learn 
about where the photo will “snap” on 
the quilt.

4.	 Click Add to Project Sketchbook. 

NOTES
Photos must be set as squares or rectangles. They 
will not clip to fit triangles or borders.

Photos can be rotated, resized and repositioned 
using the Adjust tool on Layer 1 (Custom Set) or 
Layer 2 (any style), see page 83. You can stay on the 
Photo Tools palette, as the Adjust tool will work the 
same way.

Step 1
DESIGN tab

Step 1
Layer 1 tab

Step 2

Step 3

Step 4

Layer 1 of a Horizontal Quilt
1.	 Start with a Horizontal Quilt layout on 

your worktable. Click the DESIGN tab 
and the Layer 1 tab below the Quilt 
Worktable.

2.	 On the ribbon, click the Photo Tools 
option and Set Photo tool from the 
palette.

3.	 Select the photo you wish to set.

4.	 Click in the block space on the quilt to 
set it.

This block space 
has been left blank 
because we intend 

to set a photo in 
the space.
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WORKING WITH QUILT 
SNAP SETTINGS
There are adjustable snap settings that make 
working in a Custom Set quilt layout or on 
Layers 2 or 3 of any quilt layout easier. If 
you’re in either the Sketchbook Blocks or 
Sketchbook Photos palette, the QUILT GRID 
SETUP will appear when you select the Adjust 
tool, but if you want to change the settings 
prior to setting an item, follow these steps.

Changing Snap Settings
1.	 Click the Worktable Options tool (on 

the main toolbar).

2.	 Click Snap Settings (under Tool 
Options).

3.	 The 3 checkboxes (under Grid Settings) 
correspond to the 3 buttons under the 
QUILT GRID SETUP, so you can check 
them here, or in the palette, when the 
Adjust tool is selected: 
 
Show grid (Custom Set) – determines 
whether or not you see the grid lines 
on a new Custom Set quilt (that doesn’t 
have Layer 1 completely filled yet). For 
small grid increments, not all the grid 
lines can draw when you’re zoomed out 
(or your whole quilt would be pink, or 
filled with grid lines). But, the grid lines 
are there and you’ll see more of them 
draw as you zoom in. 
 
Snap block position to grid – if this is 
turned on, when you move a block, 
motif, stencil, embroidery, applique 
text, or photo with the Adjust tool, it’s 
position will snap to the grid when you 
release. 
 
Snap block size to grid – if this is 
turned on, when you drag the corner 
or side handle of a block, motif, stencil, 
embroidery, applique text, or photo 
with the Adjust tool, the size will snap 
to the grid when you release.

Step 1
Worktable 

Options

Step 2

Step 3

The same three snap settings are available on the  
Quilt Worktable when you choose the Adjust tool.
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4.	 Beside Grid snap every (or under Grid 
Snap Increments in the palette when 
the Adjust tool is selected) change the 
setting by clicking the drop-down arrow 
and choosing a different increment. 	  

5.	 (Optional) Since you’re in the Quilt 
Worktable Options box, you may want 
to verify your Quilt Ruler origins and 
turn them on. Click View Settings 
(under Tool Options). Change the origin 
to one of the 3 options listed. We 
recommend setting it to Top left corner 
of quilt’s center layout so it matches 
the Graph Pad’s numbering system.

6.	 Click OK.

7.	 (Optional) Click View from the menu 
bar, then Quilt Rulers to put a check 
next to it and turn on your quilt rulers.

NOTES
You will not see the grid lines if you choose a quilt 
layout other than Custom Set. You will also not see 
the grid lines once your Custom Set quilt’s Layer 1 
is filled.

When you resize a block using the handles and 
Adjust tool, it may move slightly. Don’t forget to 
move the block slightly to snap its position back 
into place.

If you have trouble positioning a design on the 
quilt, check your snap settings. You may want to try 
turning Snap block position to grid off.

We recommend resizing a block before rotating if 
you are using the handles. The degree may change 
and the block may skew if you don’t.

Step 4

Step 5

Step 6

Step 7

Quilt rulers
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ADJUSTING BLOCKS IN A QUILT

Rotating or Flipping Blocks
The Rotate or Flip block tools work on all 
blocks, including motifs and stencils, and 
embroidery designs, set in all quilt layouts. 
The block must be asymmetric (not the same 
on all sides) to notice a rotation or flip.

1.	 On the Quilt Worktable click the 
DESIGN tab, then Block Tools on the 
ribbon. Be on the layer on which you 
set the block, motif, or stencil. (If you 
want to adjust an embroidery design, 
you’ll need to select the Embroidery 
Tools option and be on Layer 3 below 
the Quilt Worktable.)

2.	 Click the Rotate tool. Click on an 
asymmetrical block in the quilt. It will 
rotate 90 degrees clockwise with each 
click.  
Or 
Click the Flip tool. Click on an 
asymmetrical block in the quilt. It will 
flip horizontally (from left to right) with 
each click.

3.	 Click Add to Project Sketchbook to save 
your quilt with any rotation or flip you 
like.

NOTES
You can flip or rotate after you’ve flipped or 
rotated any blocks. Try clicking on the 2 tools in 
different orders to discover different patterns or 
arrangements.

CTRL+click (Command+click) rotates/flips every 
block in your quilt on that layer. ALT+click 
(Option+click) rotates/flips alternate blocks in your 
quilt on Layer 1 only.

Rotating and flipping works on sashes and borders.

When rotating a motif, stencil, or embroidery 
design, the design will rotate within the block and 
the position will not change. To rotate the position 
in a Custom Set layout, or on Layers 2 or 3, see 
page 83.

These tools do not work on photos or text. Instead, 
see pages 79 or 93.

Step 1
DESIGN tab

Step 1
Block Tools

Symmetrical block Asymmetrical block

Step 2
Rotate

Original block

1 click – 90 degrees 2 clicks – 180 degrees

3 clicks – 270 degrees 4 clicks – 360 degrees
(back to original)

Original block 1 click – Flips block 
horizontally

Step 2
Flip
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Move – Click in the center and drag to a new location

Moving, Resizing, Rotating, 
and Skewing Blocks
Begin with a quilt layout and blocks or photos 
set on Layer 1 of a Custom Set quilt, or blocks, 
motifs, stencils, photos, or embroidery designs 
on Layers 2 or 3 of any quilt layout.

1.	 On the Quilt Worktable click the 
DESIGN tab, then Block Tools on the 
ribbon.	

2.	 Click the Layer tab (below the Quilt 
Worktable) on which the item is set. 
Blocks and photos are on Layer 1 of a 
Custom Set quilt, motifs and text are on 
Layer 2, and stencils and embroidery 
are on Layer 3 of all other quilt layouts.

3.	 Click the Adjust tool. 

4.	 Click the item in the quilt to select it. 
It will have a dotted box around it with 
little black squares at the sides and 
corners. These squares are “handles” 
and are used to modify the block.

5.	 For the following adjustments, there 
are 2 options for every change: 
 
To move the block – Position your 
cursor inside the dotted box so your 
cursor looks like a cross with arrows 
and click and hold as you drag the block 
to a new location. Or, type directly in 
the X- and Y-Axis boxes in the palette to 
change the position. These coordinates 
are starting from the top-left corner of 
the quilt center (borders not included). 
If you drag the item to a new location 
you will see the numbers change in the 
X- and Y-Axis boxes. 
 

Step 1
DESIGN tab

Step 2

Step 3

Step 4

You can also move the selected item by changing 
the X- and Y-Axis coordinates in the palette.

Cursor becomes a cross with arrows
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To resize the block – Position your 
cursor over one of the handles so 
your cursor looks like a double-ended 
arrow and click and hold as you drag 
the handle to a new location. Or, type 
directly in the Width and Height boxes 
to change the size. If you use the 
handles to resize the item, you’ll also 
see the numbers change in the Width 
and Height boxes accordingly. 
 
To rotate the block – Hold down the 
keyboard CTRL key (Command key) and 
click in the center of the item you want 
to rotate. Position your cursor over 
one of the corner handles. Click and 
hold the corner handle as you move 
it around the center of the block. The 
block will spin around its center and 
stop when you release the mouse. Or, 
you can type a specific degree in which 
you want the item to rotate in the 
Block Rotation box. If you rotate the 
item using the handles, you will see the 
angle change in the Block Rotation box.

6.	 To skew the block – hold down your 
keyboard CTRL key (Command key) and 
click in the center of the block. Position 
your cursor over one of the side 
handles so your cursor looks like two 
parallel lines. Click and hold as you slide 
the side handle up/down or left/right 
to a new position. The selected item 
will reshape itself as you move the side 
handles. Notice the Width, Height, and 
X- and Y-Axis boxes all may change.

7.	 Click outside of the dotted selection 
box to deselect an item.

8.	 Click Add to Project Sketchbook to save 
any adjustments you like.

NOTES
Snap settings will affect moving, rotating, and 
resizing the blocks, motifs, stencils, photos, and 
embroidery designs. See page 80.

If you don’t like an adjustment, immediately after 
making the change, click the Undo button. Or press 
CTRL+Z (Command+Z) on your keyboard. 

Resize – Click and drag handle

You can also change the size of the selected item using the Width  
and Height boxes in the palette. Put a check in Preserve aspect ratio  

while resizing if you’d like to keep the proportions the same.

Cursor becomes a double-ended arrow when held over the handles

Cursor

Rotate – CTRL+click (Command+click) and spin handle

You can also change the rotation of the selected  
item using the Block Rotation box in the palette.

Cursor

Cursor becomes a circle with an arrow on one 
end when held over the corner handles

Skew – CTRL+click (Command+click) and slide side handle

Cursor

Cursor becomes two parallel lines 
when held over the side handles
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COPYING & PASTING, 
DELETING, OR ERASING 
BLOCKS IN A QUILT
Begin with a quilt layout and blocks or photos 
set on Layer 1 of a Custom Set quilt, or blocks, 
motifs, stencils, photos, or embroidery designs 
on Layers 2 or 3 of any quilt layout.

1.	 On the Quilt Worktable click the 
DESIGN tab, then Block Tools on the 
ribbon.	

2.	 Click the Layer tab (below the Quilt 
Worktable) on which the item is set. 
Blocks and photos are on Layer 1 of a 
Custom Set quilt, motifs and text are on 
Layer 2, and stencils and embroidery 
are on Layer 3 of all other quilt layouts.

3.	 Click the Adjust tool.

4.	 Click the item in the quilt to select it. 

5.	 To copy and paste a selected item -  
Using the palette: Under SINGLE SELECT 
OPTIONS, click Copy, then click Paste.  
 
Using the keyboard: Press CTRL+C 
(Command+C), then CTRL+V 
(Command+V). 
 
A copy of the selected item will appear, 
and this new pasted copy will be 
selected. You can now alter it by using 
any of the adjustment options, see 
page 82.

6.	 To delete the selected item – under the 
SINGLE SELECT OPTIONS, click Delete, 
or press the keyboard Delete key.

7.	 If you like the changes you made, click 
Add to Project Sketchbook to save the 
new designs.

Step 1
DESIGN tab

Step 2

Step 3

Step 4
Click the item on the 

quilt to select it.

The pasted block will appear down and 
to the right of the original block.

Step 5

Step 6

Step 7
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Erasing a Block in a Quilt
You can use the Erase (Block) tool to erase blocks, motifs, stencils, photos, or embroidery. The difference between this and the 
Delete tool is that whatever you erase will be gone, but the outline of that item will still be there and can now be filled with 
fabric or new applicable items (i.e., a new motif on Layer 2, a new stencil on Layer 3, etc.).

1.	 On the Quilt Worktable click the 
DESIGN tab, then Block Tools on the 
ribbon.	

2.	 Click the Layer tab (below the Quilt 
Worktable) on which the item is set. 
Blocks and photos are on Layer 1 of a 
Custom Set quilt, motifs and text are on 
Layer 2, and stencils and embroidery 
are on Layer 3 of all other quilt layouts.

3.	 Click the Erase (Block) tool. 

4.	 Click the item you want to erase and it 
will “disappear,” leaving a blank space 
in your quilt.

5.	 (Optional) If you used the Erase tool on 
Layer 1 of a Custom Set quilt, or Layers 
2 or 3 of any quilt layout, there will 
be a blank block outline. To get rid of 
this outline, click the Adjust tool, click 
on the outline, and click Delete in the 
palette.

6.	 You can now fill these “blank” spaces by 
coloring them with fabric or setting in 
new blocks, motifs, stencils, photos, or 
embroidery, see pages 96 or 73.

NOTES
To erase all the blocks in the quilt, click Quilt on 
the menu bar, then Erase Quilt, or hold down your 
keyboard CTRL key (Command key) as you click 
on the quilt with the Erase tool. You cannot use 
CTRL+Z (Command+Z) if you erase everything.

ALT+click (Option+click) erases alternate blocks 
in your quilt. On some complex quilt layout 
styles, you’ll need to repeat these steps to erase 
alternates or all.

Erasing is not really necessary; it’s quicker to just 
replace a “wrong” block with a “right” block in one 
step by clicking the new block on top of the old.

Step 1
DESIGN tab

Step 2

Step 3

Erase Block does not remove the space you’ve created for a motif or stencil.  
Use the Adjust tool and the Delete option if you’d like to remove the blank space.

Step 4
Using the Erase 

Block tool on Layer 
1 removes the block 

from the space

To erase all blocks in the quilt, click Quilt 
on the menu bar and choose Erase Quilt.
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CREATING FAST DESIGNS WITH SYMMETRY
The Symmetry tool automates flipping and rotating on all blocks simultaneously. It works on Layer 1 for all layouts, but works 
best with a Horizontal layout with no sashing, as in the example. Be sure to choose asymmetrical blocks, which are not the 
same on all sides, to see a difference.

Begin with a quilt completely filled with asymmetrical blocks (see pages 39 or 73).

1.	 On the Quilt Worktable, click the 
DESIGN tab. On the ribbon, click Block 
Tools, then Layer 1 below the Quilt 
Worktable.

2.	 Click the Symmetry tool from the 
palette.

3.	 Click on a block in the quilt and watch 
them all change, a combination of 
flipping and rotating. There are 16 
different symmetries built into the tool, 
so you can click 16 times to see all the 
variations. On click 17 the quilt will 
return to the way it looked before you 
used the tool.

4.	 Click Add to Project Sketchbook to save 
any quilt designs you like.

NOTES
If you use the Symmetry tool in quilt layouts other 
than Horizontal, you may have to click on different 
blocks to make them all flip and rotate (i.e., in a 
Baby Blocks layout, you will need to click on at least 
3 blocks on the different visual levels). If it takes 
more than one CTRL+click (Command+click) to set 
blocks in a layout, then it will also take the same 
number of clicks when using the Symmetry tool.

If your quilt design doesn’t change as you click, 
check your block. It must be asymmetric (not 
the same on all sides) in color or design, to make 
symmetries noticeable.

To replace rotated blocks and have the new blocks 
remain rotated, click the Worktable Options tool. 
Under Tool Options, click Setting Blocks and check 
Maintain the block rotation from the current quilt 
when replacing blocks. Click OK.

Step 1
DESIGN tab

Step 1
Block Tools

Step 2
Step 1

Original quilt

Three examples of the  
16 possible symmetries 

Step 4
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STACKING, CENTERING, AND CLIPPING BLOCKS
For all of these tools you must begin with a quilt layout and blocks or photos set on Layer 1 of a Custom Set quilt, or blocks, 
motifs, stencils, photos, text, or embroidery designs on Layers 2 or 3 of any quilt layout.

Step 1
DESIGN tab

Step 2

1.	 On the Quilt Worktable click the 
DESIGN tab, then Block Tools on the 
ribbon.	

2.	 Click the Layer tab (below the Quilt 
Worktable) on which the item is set. 
Blocks and photos are on Layer 1 of a 
Custom Set quilt, motifs and text are on 
Layer 2, and stencils and embroidery 
are on Layer 3 of all other quilt layouts.

3.	 Click the Adjust tool. You may need to 
use the vertical scrollbar beside the 
palette to see all the SINGLE SELECT 
OPTIONS.

4.	 Click the item in the quilt to select it. It 
will have a dotted box around it.

5.	 You can perform any of the following 
options: 
 
•	 Stacking blocks 
 
• Centering blocks 
 
• Clipping blocks 
 
See the following page for details on 
each of these options.

NOTES
Clipping works well for stencils on Layer 3 of on-
point quilts that need to be over the quilt blocks, 
but not over the borders.

Clipping a block only affects the way the block 
appears on the screen and in exported images. If 
you print the pattern for a clipped block, you will 
still get the full pattern.

Stacking 
options 

Centering 
options

Clipping 
options 

Step 3
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Stacking Blocks
You can layer blocks simply by moving them on top of one another, but 
they may not overlap in the order you like. To change this order, you can 
click on any of the four Order tools to change the stacking order.

Stacking blocks is a great technique for applique motifs in the corners of 
borders that need to overlap.

Bring to Front 
This will make the selected  
block the top-most block. 

Send to Back 
This will make the selected  

block the lowest block. 

Bring Forward  
This will move the selected block 

up one in the stacking order. 

Send Backward  
This will move the selected block 
down one in the stacking order. 

Centering Blocks 
You can calculate where a block is centered by measuring the size of the block and the quilt, or you can use either of the 
Center tools. Centering blocks is helpful for when you are starting a Custom Set quilt with a center medallion block.

Center Horizontally
This will space the block equally 
between the left and right sides 

of the quilt center. It will not 
change its vertical position.  

Center Vertically
This will space the block equally 

between the top and bottom 
of the quilt center. It will not 

change its horizontal position. 

Clicking both Center tools 
This will put the center  
of the block in the exact  

center of the quilt. 

Original block position

Original block 
position

Clipping Blocks at the Border
This tool is used when you have blocks at the edge of the quilt center or overlapping a border. (If your block is set in the center 
of your quilt, you will not notice any change.) There are three choices for this option.

 

Clip to Edge 
This will clip the block to stay within the 
quilt center (stop before the borders). 

Clip to Border 
This will clip the block at the outer 

edge of the quilt. 

Unclip Block
This will allow the block to hang over 

and past the quilt’s outer border.
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ADJUSTING MULTIPLE BLOCKS AT ONCE
For these tools, like for the Single Select Options (see page 88), they can be used if you are on Layer 1 of a Custom Set quilt or 
Layers 2 or 3 of any layout. The only difference is that you must have more than 1 block selected in order for these options to 
appear in the palette.

Step 1
DESIGN tab

Step 2

Step 3

1.	 On the Quilt Worktable click the 
DESIGN tab, then Block Tools on the 
ribbon.	

2.	 Click the Layer tab on which the items 
are set. Blocks and photos are on Layer 
1 of a Custom Set quilt, motifs and 
text are on Layer 2, and stencils and 
embroidery are on Layer 3 of all other 
quilt layouts.

3.	 Click the Adjust tool. You may need to 
use the vertical scrollbar beside the 
palette to see all the MULTI SELECT 
OPTIONS.

4.	 With both of the following options, 
you will need to decide which block 
is set in the correct position or is the 
correct size for the design you want. 
Click this block first to select it. It will 
have a dotted box around it and will be 
your anchor. All other blocks you select 
will move or resize according to your 
anchor’s position.

5.	 Hold down the SHIFT key on your 
keyboard and click on the remaining 
blocks you want to adjust according 
to your anchor block. An outline will 
encompass all the blocks you select. 
You can release your SHIFT key and all 
of the blocks will remain selected (until 
you click outside of the quilt area).

6.	 You can perform the following options: 
 
• Align blocks 
 
• Size blocks 
 
See the following page for details on 
each of these options.

Step 4

The first block you select is the “anchor.” The settings for the 
other blocks you select will come from the anchor block.

Step 5 – Select the remaining blocks 
while holding down the SHIFT key

Align 
options 

Same Size 
options 
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Using the Same Size Buttons
These three options allow you to quickly make multiple blocks the same size. 

Aligning Multiple Blocks
These four options allow you to quickly align 
multiple blocks to your anchor block.

Align Left Sides – this will make the selected 
blocks line up with the left side of the anchor 
block. 
 
Align Right Sides – this will make the selected 
blocks line up with the right side of the anchor 
block. 
 
Align Tops – this will make the selected blocks 
line up with the top of the anchor block. 
 
Align Bottoms – this will make the selected 
blocks line up with the bottom of the anchor 
block. 

Anchor block

Align Tops used to make the tops of all 
the blocks line up with the anchor block

Anchor block

Same Width
This will make the selected blocks have the 
same horizontal width as the anchor block.

Same Height
This will make the selected blocks have the  
same vertical height as the anchor block. 

Same Width/Height 
This will make the selected blocks have the  
same width and height as the anchor block.

Select the remaining blocks 
while holding down the SHIFT key

NOTES
Using the Aligning tools allows you to quickly and 
easily line up quilting stencils or rows of blocks.

Remember when using the Same Size options that 
they are for horizontal and vertical dimensions, not 
edge length of on-point blocks. When using the 
Same Size options on rotated and unrotated blocks 
at the same time don’t expect them to have the 
same edge length.
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ADDING TEXT TO YOUR 
QUILT
EQ8 is not a word processor, but it lets you 
“write” on your quilt (in any layout). You can 
print applique text as templates to get the 
patterns for each letter.

1.	 On the Quilt Worktable, click the 
DESIGN tab.

2.	 Click Layer 2 below the quilt worktable. 
The Text Tools option will become 
available.

3.	 On the ribbon, click the Text Tools 
option. The APPLIQUE TEXT palette will 
appear.

4.	 Under Select typeface, click the down 
arrow to see your list of font choices 
and click on one to select it. The name 
of the font is written in its style to give 
you a sneak peek of how your text 
will appear. These are TrueType fonts 
installed on your computer. (You can 
always change the typeface later.)

5.	 Under Approximate size in inches, 
drag the slider bar to set a starting size. 
The size is approximate (font sizes vary 
depending on the style). Rely on how 
the text looks on your quilt. (You can 
always change the size later.)

6.	 Under Additional formatting, select any 
other options you want, such as bolding 
the text or aligning it in the center. Be 
aware that all choices you make will 
apply to all words in the same text box. 
(You can make more than one text box 
in order to apply different options.)

7.	 Hold down your keyboard SHIFT key 
and point your mouse cursor at the 
quilt where you want the text to start. 
Click and hold as you drag diagonally 
to make a box, then release the mouse. 
Don’t worry about the size of the text 
box because it resizes to a small box 
which enlarges as you type.

Step 1
DESIGN tab

Step 2

Step 3

Step 4

Step 5

Step 6

Step 7
Hold down SHIFT while dragging to create a box for the text.
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8.	 Start typing and you’ll see your text 
appear in the box. The text won’t wrap, 
so to make a new line of text, press 
your keyboard ENTER key. You control 
how long each line is, and how many 
lines there are. While the Applique Text 
box is still selected on the quilt, you 
can resize or choose a different font 
(see steps 4-6 above) and your font will 
change accordingly on the quilt.

9.	 You can move, rotate, and resize your 
text, just as if it’s a block. To change 
the text box, click the Adjust tool and 
click the text box to select it. You can 
manually move, rotate or change the 
size of the text, or you can also use 
respective boxes in the APPLIQUE TEXT 
palette, under Adjust Text. See page 83. 
You can stay on the Text Tools palette, 
as the tool will work the same way.

10.	 Since the text box acts as if it’s a block, 
if you have multiple text boxes or other 
blocks/motifs on Layer 2, you can 
quickly stack them if they overlap, or 
reposition or align them. See page 88. 

NOTES
All text in one box will have the same format. 
You must have a new text box for each different 
typeface, size, format, or text color.

To change the text after it has been deselected, 
click the Set Text tool, click the text box to reselect 
it, and change the typeface, resize, or reformat as 
described in steps 4-6.

To recolor, click the Fabric Tools option, click the 
Paintbrush tool, select a fabric or solid color, and 
click on the text. The entire text in the box will 
change to the newly-selected color.

Text prints only as templates and all letters in the 
selected box will print together. Using the PRINT 
& EXPORT tab, remember to be on Layer 2, click 
the text-box outline and the Templates option will 
appear in the PRINT PATTERNS palette. To learn 
more about printing templates, see page 218.

You can copy and paste entire text boxes with the 
Adjust tool, see page 83. If you only want a portion 
of the text, you can create a new text box with only 
those letters or words.

Step 8

Each word in the quilt above is in a separate text box, 
allowing different typefaces to be used for each one.

Step 9

Click on the text box to select it.

Move your cursor over the text box and it  
will change to a cross with four arrows. You 

can then drag the text box to a new location.

Move your cursor over a handle and  
it will change to a double-ended arrow.  
You can then drag to resize the text box.
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CHAPTER 5
Design with Fabrics, Colors, and Thread

EQ8 lets you design your blocks or quilts with fabrics, solid colors, and threads by using easy and fun tools. You’ll have 

hundreds of solid colors and thread and thousands of fabrics to choose from. You can also import your own fabric scans 

and create new color palettes. Several tools help you fine-tune your design by fussy cutting or rotating fabric, or adding 

outlines of colored thread around patches. One feature even makes dramatic color changes with each click of the mouse.
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DESIGNING WITH THE PAINTBRUSH TOOL
Once you have drawn a block or set a block in a quilt layout, you can color it with fabrics or solid colors. If you don’t have a 
quilt set with blocks yet, see pages 38 and 73.

OR

Quilt Worktable

Step 1

Step 1
Paintbrush tool

Fabrics and 
Colors tabs

Display buttons

Most recently 
used fabrics  
and colors

Use the 
scrollbar to see 
more swatches

Block Worktable

Step 1
Coloring with the Default 
Paintbrush Style

1.	 On the Block Worktable, click the 
COLOR tab and then Fabric Tools or on 
the Quilt Worktable click the DESIGN 
tab, and then Fabric Tools. Click the 
Paintbrush tool. The SKETCHBOOK 
FABRICS & COLORS palette will 
appear. The palette is slightly different 
depending on the Worktable. 

The steps below use the Paintbrush tool’s 
One Dot Brush. It is the only brush style 
available on the Block Worktable and one of 
five Paintbrush styles on the Quilt Worktable 
(see page 98 for details). This brush is 
automatically selected for you unless you have 
previously chosen another brush style.

NOTE
Coloring errors are caused by drawing errors. 
Whether you’re drawing a pieced, applique, or 
combination block, there are requirements that 
need to be met. See pages 120, 129, and 140.

2.	 Click the Fabrics tab in the palette to 
see the fabric prints or the Colors tab 
to see the solid colors. Use the scrollbar 
below the swatches to see all of them. 
You can also change the number of 
items that display at one time. On the 
left below the horizontal scrollbar you 
will see a series of display buttons. 
Click a button with a larger square to 
see fewer items, or one with a smaller 
square to see more items. 
 
Above the Fabrics and Colors tabs, 
you will see a long rectangle showing 
the Most recently used fabrics and 
colors. If you have not used any fabrics 
or colors, this area will be a light gray 
(“blank”) rectangle. Once you have 
fabrics and colors in this palette, you 
can click on them and use them again 
to color your block. 
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Above the Most recently used rectangle 
you will see the Currently selected 
fabric or color. If you click on the 
horizontal arrow in the bottom-right 
corner, the rectangle moves on top of 
the worktable. It can be moved over 
the worktable by clicking on the white 
title bar of the rectangle and dragging 
it around. To position it back in the 
palette, click the X in the top-right 
corner.

3.	 Click a fabric or color to select it, then 
click a patch in your block to color it 
with the selected fabric or color. (If your 
whole block colors or you cannot color 
a patch, see the Notes below.)

4.	 To recolor, click a different fabric or 
color in the palette and click the patch 
again. The patch will be newly colored.

5.	 (Optional) On the Quilt Worktable, hold 
down the CTRL key (Command key) to 
color one patch in matching blocks. Or, 
hold down the ALT key (Option key) to 
color one patch in alternate matching 
blocks. This is a time-saving step.

NOTES
When drawing any style of a pieced block, if you 
lose lines, or the whole block colors at once when 
you click on the COLOR tab, you have a line that is 
not connected properly. You will have to go back to 
the DRAW tab and draw the lines again. You might 
have to Zoom In to be sure lines are connected, or 
change your grid, see pages 120 or 129.

If you’re drawing an applique block and can’t color 
patches, the entire background colors as one, or 
are only seeing lines on the COLOR tab, then your 
patch is not closed. Return to the DRAW tab and 
make sure patches are closed. You might have to 
Zoom IN to check that the nodes of the patch are 
connected. You can also use pre-drawn patches. 
See page 140.

Color your quilt quickly using the other design 
tools, see pages 99 and 100.

Currently selected 
fabric or color

Detach button

When the Fabric Preview is detached from the palette, it “floats” on the worktable. 
You can move it by clicking and dragging on the title bar, or resize it by hovering over 

an edge until your cursor changes to a double-ended arrow and dragging.

Detached Fabric 
Preview

Step 3
Click on a swatch in the palette to select it, 
then click on a patch in the quilt to color it.
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Coloring with the Other 
Paintbrush Styles
The four remaining styles are only on the Quilt 
Worktable. They are good for coloring quickly, 
especially on One Patch quilts.

1.	 On the Quilt Worktable, click the 
DESIGN tab. On the ribbon, click Fabric 
Tools, then the Paintbrush tool from 
the palette. Choose and click on one of 
the Paintbrush styles: 
 
Freehand Brush – paints a freehand 
line of color. 
 
Line Brush – paints a straight line of 
color. 
 
Rectangle Brush – paints a rectangle 
outline of color. 
 
Oval Brush – paints an oval outline of 
color.

2.	 Click a fabric or color in the palette.

3.	 Position your cursor over the quilt. 
Click and hold as you drag the brush 
across the quilt. A line or shape draws, 
indicating the brush path. Release the 
mouse to see all patches touched by 
this patch change to the selected fabric 
or color.

NOTES
Anything touching the brush path will be colored. 
Use the default One Dot Brush to recolor patches 
you did not intend to color. 

The keyboard shortcuts to color faster are only 
available when using the One Dot Brush

Step 1

Paintbrush 
styles

Freehand Brush

Line Brush

Rectangle Brush

Oval Brush
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DESIGNING WITH THE 
SPRAYCAN TOOL

Coloring with the Default 
Spraycan
The Spraycan “sprays” all similarly-colored 
patches in the block with the fabric or color 
you select. 

1.	 Click the Spraycan tool.

2.	 Click a fabric or color in the palette.

3.	 Click on a patch on the Block or Quilt 
Worktable. All of the patches that were 
filled with the same color will recolor 
with the newly-selected fabric or color.

4.	 (Optional) Hold down the CTRL key 
(Command key) to color all similarly-
colored patches on an entire Quilt 
Worktable layer. Or, hold down the ALT 
key (Option key) to color all similarly-
colored patches in alternate blocks on 
the same layer.

Coloring with the Select & 
Spray Tool
With the Select & Spray tool, choose the 
patches first, then click fabrics or solid colors 
in the palette to audition them while the 
patches remain selected.

1.	 On the Block Worktable, click the 
Select & Spray tool in the SKETCHBOOK 
FABRICS & COLORS palette. On the 
Quilt Worktable, select the Spraycan 
tool in the SKETCHBOOK FABRICS & 
COLORS palette. You will see 2 smaller 
buttons in the bottom left, under the 
other tools. Click the second button, 
the Select & Spray tool.

2.	 Click on a patch in a block. You will see 
an outline around the patches with the 
same coloring.

To find the Spraycan tool:  
On the Quilt Worktable, click the DESIGN tab, then choose Fabric Tools on the ribbon.
On the Block Worktable, click the COLOR tab, then choose Fabric Tools on the ribbon.

Step 1
Spraycan tool

Step 2 Step 3

Step 4
CTRL+click (Command+click) to color all 

similarly-colored patches at once

Step 4
ALT+click (Option+click) to color similarly-

colored patches in alternate blocks

Step 1
Select & Spray 

on Block Worktable

Step 1
On the Quilt Worktable, choose the Spraycan 
tool, then choose the Select & Spray sub-tool.

Step 2
Click on a patch and all matching patches 

will be selected with a green outline.
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3.	 Click a fabric or color in the palette 
to change those patches. Click other 
fabrics to audition them. Stop when 
you find one you like.

4.	 To deselect the fabrics, click a different 
tool on the toolbar or click in the white 
space outside of the quilt’s border or 
block’s outline.

5.	 (Optional) Hold down the CTRL key 
(Command key) to select all similarly 
colored patches on an entire Quilt 
Worktable layer. Or, hold down the ALT 
key (Option key) to select all similarly-
colored patches in alternate blocks on 
the same layer.

DESIGNING WITH THE 
SWAP COLOR TOOL

Coloring with the Default 
Swap Color Tool
The Swap Color tool works color by color 
across the entire quilt and on every layer (it is 
not available on the Block Worktable). It will 
change all patches of a given fabric or color in 
the quilt to the newly-selected fabric or color, 
regardless of which layer you are on. With this 
Swap tool, you choose your fabric first, then 
click to replace the color.

1.	 On the Quilt Worktable, click the 
DESIGN tab. On the ribbon, click Fabric 
Tools, then the Swap Color tool.

2.	 Click a fabric or color in the palette.

3.	 Click on a patch in the quilt.

Coloring with the Select & 
Swap Tool
With the Select & Swap tool, choose the 
patches first, then click fabrics or solid colors 
in the palette to audition them.

1.	 On the Quilt Worktable, click the 
DESIGN tab. On the ribbon, click Fabric 
Tools, then the Swap Color tool. Click 
the second sub-tool button, the Select 
& Swap tool.

Step 3
Select a fabric or color in the palette and the selected patches will change. 

Use your keyboard arrow keys to try out fabrics or colors quickly.

Step 1
Swap Color tool

Original quilt

Step 3

All the blue patches in the entire quilt 
have been changed to gray

Step 1
Choose the Swap Color tool, then  

choose the Select & Swap sub-tool.
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2.	 Click on a patch in the quilt. This can be 
on a border block, sash corner, motif, 
etc. All patches with that color (on that 
layer only) will select.

3.	 Click a fabric or color in the palette 
to change those patches. Click other 
fabrics to audition them. Stop when 
you find one you like.

4.	 To deselect the fabrics, click a different 
tool on the toolbar or click in the white 
space outside of the quilt’s border.

USING THE FUSSY CUT 
TOOL
Focal fabrics, striped fabrics, and other fabrics 
with a large pattern in their image give you 
lots of options for choosing which part of the 
fabric you want to see in the patch. The Fussy 
Cut tool lets you slide fabrics around in a 
patch to center or align patterns in the fabric 
image however you like. This tool is available 
on both the Block and any layer of the Quilt 
Worktable, as long as there is fabric.

1.	 Click on the Fussy Cut tool.

2.	 Click and hold on the fabric in a patch 
and drag it around to choose what 
part of the fabric you see. Release the 
mouse when you’re done fussy cutting.

3.	 The fabric is still selected. If you need to 
nudge the fabric in a certain direction 
in small increments, use your keyboard 
arrow keys. If you want to nudge the 
fabric in larger increments, hold down 
the CTRL key (Command key) while 
using the keyboard arrow keys.

4.	 Click on another fabric to fussy cut it or 
deselect the tool by clicking on another 
tool or outside the quilt’s border.

NOTE
You will use the Fussy Cut tool most often after you 
are done rotating fabrics, see page 102.

Step 2
Click on a patch and all matching patches will be selected with a green outline.

Step 3

All the selected blue patches in 
the quilt have changed to yellow.

To find the Fussy Cut tool:  
On the Quilt Worktable, click the DESIGN tab, then choose Fabric Tools on the ribbon.
On the Block Worktable, click the COLOR tab, then choose Fabric Tools on the ribbon.

Step 1
Fussy Cut tool

Block before fussy cutting

Block after fussy cutting
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USING THE ROTATE 
FABRIC TOOL
The Rotate Fabric tool lets you rotate fabric 
in several different ways on the quilt. (Don’t 
confuse it with the Rotate tool, which rotates 
blocks in the quilt.) To use the Rotate Fabric 
tool you must have fabric in a quilt on the 
Quilt Worktable. If you do not have this, see 
pages 200 or 208.  

1.	 Click the quilt layer tab (below the Quilt 
Worktable) where the fabric is that 
needs rotating.

2.	 On the Quilt Worktable, click the 
DESIGN tab. Select Fabric Tools in the 
ribbon and click the Rotate Fabric tool. 

3.	 Click on the circle next to Simple, 
Advanced or Align to edge, to select 
your ROTATE FABRIC OPTIONS method. 
(See Rotating Methods below.)

4.	 Click any fabric in the quilt to rotate it 
according to the method you selected.

Simple Rotating Method
A simple quarter turn rotation

Click the fabric to rotate it 90 degrees 
clockwise with each click. Four clicks will 
return the fabric to the original orientation. 

CTRL+click (Command+click) = rotates in all 
blocks

ALT+click (Option+click) = rotates in alternate 
blocks

Step 1

Step 2

Step 2
Rotate Fabric tool

Step 3

Simple Rotating Style

Original

1 Click – 90 degrees 2 Clicks – 180 degrees 3 Clicks – 270 degrees 4 Clicks – 360 degrees

Advanced Rotating Method
A custom rotation

Choose the Starting angle for first rotation (0 – 359); this impacts the first click only. Choose the Number of rotations (1-16) 
you want within 360 degrees for future clicks. You can either enter any number (1-16) or divide 360 degrees by the degree you 
want the fabric to rotate by and enter that number. For both of these numbers, you can use the arrows or double-click on the 
number and type a new number.

CTRL+click (Command+click) = rotates in all blocks

ALT+click (Option+click) = rotates in alternate blocks

See examples on the next page.

NOTE
Some advanced-rotation formulas won’t bring the 
fabric back to the starting position because the 
numbers chosen may not be divisible by 360.



103

Chapter 5: Design with Fabrics, Colors, and Thread

5

Example 1: 
Starting angle: 10 degrees 
Number of rotations: 8 (360 degrees ÷ 8 = 45) 
click 1: 55 degrees (10 + 45) 
click 2: 100 degrees (10 + 45 + 45) 
click 3: 145 degrees (10 + 45 + 45 + 45) 
And so on. It will take 8 clicks to rotate 370 
degrees (360 degrees + the initial 10 degrees). 

Align to Edge Rotating 
Method
Aligns the design of fabric to the patch edge

Click a patch to see a line appear along the 
patch’s long edge. The fabric will rotate to 
align along that edge. Click in the center of 
the patch to rotate the fabric 90 degrees each 
time with respect to the alignment edge. You 
can change the alignment edge in the patch, 
if you:

Click on the Move alignment edge around the 
patch arrow in the palette, OR

SHIFT+click in the patch.

This option works on one patch only, not 
multiple patches in the quilt. Therefore, CTRL 
(Command) and ALT (Option) do not affect 
other patches.

Example: 
To rotate the fabric 90 degrees from the 
alignment edge, you can just click. 
click 1: finds the long edge and rotates the 
fabric along that edge 
click 2: rotates the fabric 90 degrees more 
click 3: rotates 90 degrees more 
And so on. 

1 Click – 55 degreesOriginal 2 Clicks – 100 degrees 3 Clicks – 145 degrees

NOTES
The Rotate Fabric tool does not work on One Patch quilts. 

Tip: Set Advanced to 6 for hexagons and 8 for octagons.

You will usually leave the starting angle set to 0 for Advanced, unless you need to 
correct a crooked scanned fabric, or want to start out at an angle.

1 Click – 60 degreesOriginal 2 Clicks – 120 degrees 3 Clicks – 180 degrees

Example 2:  
Starting angle: 0 
Number of rotations: 6 (360 degrees ÷ 6 = 60) 
click 1: 60 degrees 
click 2: 120 degrees (60 + 60) 
click 3: 180 degrees (60 + 60 + 60) 
And so on. It will take 6 clicks to rotate 360 
degrees.

Alignment Edge marker

Original 1 Click – Finds edge and 
rotates fabric along that edge

2 Clicks – Rotates 90 degrees 3 Clicks – Rotates 180 degrees
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FINDING ITEMS WITH 
THE EYEDROPPER TOOL

Using the Default 
Eyedropper Tool
Find a fabric or color already used in a block 
or quilt.

1.	 Click the Eyedropper tool.

2.	 Click on a patch on either the Block or 
Quilt Worktable. The palette will jump 
to the fabric or color of the patch you 
clicked on.

NOTE
When you use the Eyedropper on the Block 
Worktable, it will automatically switch to the last 
used Fabric Tool so you can begin coloring again. 
On the Quilt Worktable, you can choose whether 
or not you’d like to switch tools by turning Toggle 
automatic tool snapping on and off.

Using the Matching Fabric 
or Color Eyedropper Tools
These additional Eyedropper tools are only 
available on the Quilt Worktable.

1.	 On the Quilt Worktable, with the 
Eyedropper tool selected, click the 
Fabric Eyedropper sub-tool to find a 
fabric or click the Color Eyedropper 
sub-tool to identify a solid color.

2.	 Click on a patch or part of a photo in a 
quilt. 
 
The Fabric Eyedropper tool will find the 
fabric used if you click on a fabric. If you 
click on a photo or solid color, it will 
find a fabric from the Sketchbook with 
a close average color. (If the closest 
average fabric is not close, you may 
have to add fabrics to the Sketchbook, 
see pages 27 and 200.) 
 
The Color Eyedropper tool will find the 
solid color used if you click on a solid 
color. If you click a fabric or a photo, it 
will find the closest average solid color. 

To find the Eyedropper tool:  
On the Quilt Worktable, click the DESIGN tab, then choose Fabric Tools on the ribbon.
On the Block Worktable, click the COLOR tab, then choose Fabric Tools on the ribbon.

Step 1
Eyedropper tool

Step 2
Click on a patch and the fabric will become selected in the palette

Fabric 
Eyedropper

Color 
Eyedropper

Step 2
Click on a patch or photo and a matching fabric  

or solid color will become selected in the palette

The Color 
Eyedropper is 
selected so a 

matching solid 
is found on the 

Color tab

Toggle automatic 
tool snapping
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USING THE THREAD TOOLS
The Thread Tools are used to change the thread color on quilting stencils and embroideries, and to color patch edges on 
blocks and motifs. You can change the thread color while still working on the block, motif or stencil, or after you’ve set it, or an 
embroidery, into a quilt. Have whatever item you want to change the thread in on your worktable.

1.	 Click on the thread tool you want to 
use: 
 
Brush Thread - changes thread 
color one section at a time. On the 
Quilt Worktable, use CTRL+click 
(Command+click) to change color in all 
identical designs. 
 
Spray Thread - changes thread color in 
one entire block, motif, or stencil. 
 
Swap Thread (only available on the 
Quilt Worktable) - changes thread color 
over the entire quilt.

2.	 Click to select a thread color in the 
palette.

3.	 (Optional) Under Quilting/Outline 
Thread Properties, check the boxes 
to change color, style, and/or weight. 
You must have at least one checked 
because without them being checked, 
the options won’t change. 
 
Color - check this and click a color 
below to change the thread color.  
 
Style - check this and select a style 
to change the line style from solid to 
dashed. 
 
Weight - check this and select a 
thickness to change the line weight 
(thread width).

4.	 Click the patch or any thread line in 
which you want to change the thread.

NOTE
Thread color changes will be saved with the block 
or quilt when you Add to Project Sketchbook.

Step 1
Choose a thread tool

Brush Thread Spray Thread

Swap Thread

Step 2

Step 3

To find the Thread tools:  
On the Quilt Worktable, click the DESIGN tab, then choose Thread Tools on the ribbon.
On the Block Worktable, click the COLOR tab, then choose Thread Tools on the ribbon.
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Step 1

ADDING THREAD COLORS
If you want different thread colors than what come with EQ8, you can add your own thread colors to the library.

Step 2

Step 4

Here is a chart of pure RGB colors. When adding thread colors, start with the closest 
pure color and then increase or decrease red, green, or blue to match your spool.
Black (0, 0, 0)	 Green (0, 255, 0)	 Cyan (0,255, 255)
White (255, 255, 255)	 Blue (0, 0, 255)	 Magenta (255, 0, 255)
Red (255, 0, 0)	 Yellow (255, 255, 0)	

1.	 Click Libraries from the menu bar, then 
Thread Library.

2.	 Click the section you want to add 
threads to (you cannot add to the EQ 
Thread Library):  
 
My Favorite Thread - to add your own 
thread colors to your personal library. 
 
Current Sketchbook - to add thread to 
the current project you are working on. 
 
Search Results - to add colors 
temporarily to use as the base of a 
search for “real” threads.

3.	 If you chose My Favorite Thread, click 
the library name and then the style to 
which you want to add them. If you do 
not have a library created, please do 
this first, see page 210. If you chose 
Current Sketchbook or Search Results, 
continue with the following steps.

4.	 Click the Add Thread button.

5.	 In the first box, type the Thread Name 
(usually a color name like Aqua).

6.	 In the second box, type the Thread 
Number. Check the spool for the 
number. If you do not have a number,  
it is okay to leave this field blank.

7.	 In the third box, type the Manufacturer 
name. It is okay to leave this field blank 
if you do not know the manufacturer. 

8.	 Enter numbers between 0 and 255 in 
the boxes for red, green and blue to 
make the thread color you want. See 
the chart at right for help. You may 
have to try different numbers in each 
field to achieve the color you want, 
which you can see in the display box.

9.	 Click Add when you are done.

Step 5

Step 6

Step 7

Step 8

Step 9

Display box
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SORTING FABRICS OR 
COLORS
Sorting fabrics or colors arranges them in the 
order you want, letting you put your favorites 
up front in the palette.

Sorting Fabrics or Colors 
Manually

1.	 On the Block Worktable, click the 
COLOR tab or on the Quilt Worktable 
click the DESIGN tab. Click Fabric 
Tools on the ribbon and then click the 
Paintbrush tool. 

2.	 On the Fabrics and Colors palette, click 
the Fabrics tab to sort the fabrics or the 
Colors tab to sort the colors.

3.	 Fabrics – Right-click over the swatches, 
then click Sort Fabrics. 
Colors – Right-click over the swatches, 
point to Sort Colors, then click Manual.

10.	 If you chose My Favorite Thread in 
step 2, click Save Library. If you change 
styles without clicking Save Library, you 
will be prompted to save. If you chose 
Current Sketchbook, the thread is now 
in your Project Sketchbook. If you chose 
Search Results, you can now use the 
color for searching purposes by clicking 
Search > By Color.

11.	 Click the Add Thread button again to 
add more thread colors or click Close to 
return to the worktable.

NOTE
To change the thread name or to create variations 
of the threads you added, visit the EQ8 Online 
Support site.

Step 10
If saving to My Favorite Thread, click Save Library

Step 10
If using Search Results, click Search > By Color

Step 2

Step 1

Step 3

You can also click 
the 3 dot button to 

view this menu
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Sorting Colors 
Automatically

1.	 On the Block Worktable, click the 
COLOR tab or on the Quilt Worktable 
click the DESIGN tab. Click Fabric 
Tools on the ribbon and then click the 
Paintbrush tool. 

2.	 Click the Colors tab. Right-click over the 
swatches, point to Sort Colors, then 
click Automatic. The Automatic Sort 
Colors box appears.

3.	 Choose your sorting options. You can 
learn more about these options by 
visiting the EQ8 Online Support site. 
Click OK.

Unsorting Fabrics or Colors
To unsort fabrics, follow steps 1-6 under 
Sorting Fabrics or Colors Manually, in the 
previous section, and click them back to the 
their original order.

To unsort colors, right-click on the swatches, 
point to Sort Colors, then click Unsort.

4.	 Click the swatches in the order you 
want them sorted. The first swatch 
clicked will appear first in your 
respective palette. When you click on 
a swatch, it will “disappear” from your 
Sort box so you won’t select the same 
one twice. Use the display buttons to 
see more or fewer swatches at a time 
or use the scrollbar.

5.	 Continue clicking the swatches in the 
order you want them to appear. Click 
the Start Over button if you make a 
mistake.

6.	 Click the Close button if you are 
finished or if you want EQ8 to place 
the remaining swatches in their current 
order after the ones you have already 
sorted.

Display 
buttons

Click directly on the 
swatches, in the order 

in which you’d like 
them to appear

Step 6

Step 2

Step 3

You can also click 
the 3 dot button to 

view this menu
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UNDERSTANDING 
BLOCK COLORINGS 
When you recolor and add a quilt or block 
to the Sketchbook (see page 27), each block 
coloring is stacked 2 times to save space in the 
palette. You only see the selected coloring.

See Stacked Colorings with 
Select Coloring

1.	 On the Quilt Worktable, click the 
DESIGN tab. On the ribbon, click Block 
Tools, then the Set Block tool, and a 
block in the Blocks palette.

2.	 Right-click the block and choose Select 
Coloring from the pop-up menu. You’ll 
see a strip showing all the colorings for 
that block. Click one of the colorings for 
that to display in the palette.

See Stacked Colorings with 
the Coloring Arrows

1.	 Click View Project Sketchbook, then 
click the Blocks section. Click a block to 
select it. Or, on the Quilt Worktable, 
click the DESIGN tab. On the ribbon, 
click Block Tools, then the Set Block 
tool, and a block in the Blocks palette.

2.	 Use the coloring arrows, found at the 
bottom of the Blocks palette and the 
Project Sketchbook, to move among 
and see the colorings: 
First arrow - moves to the front (line 
drawing). 
Second arrow - moves back one 
coloring. 
Third arrow - moves forward one 
coloring. 
Last arrow - moves to the last coloring.

3.	 Below the blocks in the Project 
Sketchbook, the number of colorings 
and which one you’re viewing are 
displayed. For example, 2 of 5.

Step 2
Right-click and choose Select Coloring.

Strip of block colorings appears.  
Click on one to select it.

Step 1
View Project Sketchbook

Step 2
Coloring arrows

Step 3
Displays which 

coloring is selected

The coloring arrows also appear at the  
bottom-right of the Blocks palette.

Blocks from the library have two colorings. The “base” is the line drawing of the block, and 
is not considered a coloring. The first coloring is in grayscale and the second is in color.

Coloring 0 of 2 Coloring 1 of 2 Coloring 2 of 2

You can also click 
the 3 dot button to 

view this menu
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To Split Stacked Colorings
If you want to group block colorings differently 
from how they appear in the Sketchbook or 
want to see a specific coloring first, follow the 
steps below.

1.	 Right-click on a block in the palette or 
Sketchbook and choose Select Coloring.

2.	 Click the coloring where you want to 
start the split.

3.	 Right-click the block again and click 
Split Colorings. There will now be 2 
identical blocks in the Sketchbook, 
except for the stacked colorings.

Changing the Number of 
Stacked Block Colorings
If you prefer to have a new block form each 
time you color and recolor a block, or you 
want more than 2 colorings to stack, click  
File from the menu bar, then Preferences. 
Under Project Properties, click General. 
Change Maximum number of colorings per 
block to however many colorings you want 
and click OK.

Note
When you save different colorings of quilts, they 
each save separately.

ADDING NEW SOLID 
COLORS
If you can’t find the solid colors you need for 
your block or quilt, you can create your own.

1.	 On the Block Worktable, click the 
COLOR tab or on the Quilt Worktable 
click the DESIGN tab. Click Fabric 
Tools on the ribbon and then click the 
Paintbrush tool. 

2.	 Click the Colors tab.

Change number 
of colorings

Click OK to save 
your changes.

Step 3

The Variable Star block has now 
been split between the grayscale 

and colored versions.

Step 1
Paintbrush

Step 2
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3.	 Place the cursor over a color swatch 
(don’t click). You will see an RGB 
number appear. 

4.	 Click any color swatch to select it.

5.	 Right-click on the swatch and click Add 
Colors. A standard Color box appears 
with 48 basic colors.

6.	 Click Define Custom Colors. If the box 
expands past the edge of your screen, 
move it to the left. To do this, click and 
hold on the title bar at the top of the 
box, then drag the box to the left until it 
fits on your screen.

7.	 Under Custom colors, click the top-
left white square. (You must select the 
boxes in order from left to right before 
you modify the color or it will not 
work as expected. Start in the top-left 
square, fill the top row, then start in the 
bottom-left square and fill the second 
row.)

8.	 At the far right is a thin, vertical bar 
with a black triangle. Drag the triangle 
up or down to the middle of the bar.

9.	 In the large colorful square, click near 
the color you want to make. Below you 
will see the Color/Solid box show the 
color you selected. Click elsewhere in 
the large colorful square and watch the 
Color/Solid box update as you slide it 
around.

10.	 On the vertical bar at the right, drag the 
arrow up or down to make the selected 
color lighter or darker.

11.	 When you see a color in the Color/
Solid box that you like, click the Add to 
Custom Colors button at the bottom.

12.	 If you are finished adding, click OK. 

If you would like to add another color, start at 
step 7 again and select the white box to the 
right of the last square you filled. Once you 
fill the top row, start in the bottom-left square 
and fill the second row. You can add 16 colors 
at a time.

NOTES
If you are having trouble using this, don’t skip steps 7 and 12 when you click the 
white squares in order.

You can manually type in any RGB (0-255) or HSL (0-240) number at step 8. Do 
steps 1-7, then double-click the number for Red or Hue so it turns shaded and 
type the new number. Press the TAB key and type the next number, then press 
the TAB key and type the last number. Click Add to Custom Colors if you like the 
new color, then go to step 12.

Step 3

Step 5

Step 8

Step 9

Step 11

The RGB number represents the 
amount of red (R), green (G), and blue 
(B) in that color. The palette can range 

from black (R:0 G:0 B:0) to white (R:255 
G: 255 B: 255). Every combination (over 

2,700,000 total) does not exist in the 
Sketchbook/palette, but can be made.

Step 6

Step 7

Title bar



112

EQ8 Reference Manual

5

ADDING SHADES & TINTS OR TONES
You can add shades (dark values) and tints (light values) of a selected color to your EQ8 palette.

Tones are pure colors to which gray has been added. This determines how saturated (pure) a color is. The more gray, the less 
saturated it is (like earthtones). You can also add a range of tones to your EQ8 colors.

1.	 On the Block Worktable, click the 
COLOR tab or on the Quilt Worktable 
click the DESIGN tab. Click Fabric 
Tools on the ribbon and then click the 
Paintbrush tool. 

2.	 Click the Colors tab and click the color 
you want to modify.

3.	 Right-click on the color swatch and 
select Add Shades & Tints (if you want 
it lighter or darker) or Add Tones (if you 
want to make it more gray). You’ll see a 
range of values.

4.	 You can add or remove swatches from 
the range and make 4-16 colors. 
 
To Insert a new color, click the swatch 
you want to insert in front of and click 
the Insert button. 
 
To remove a color, click the swatch and 
click the Remove button.

5.	 Click the Add to Sketchbook button 
to add this range to your EQ8 color 
palette. Your added colors will be at the 
end of the current palette. 
 
Click Cancel to close the window 
without adding shades & tints or tones.

NOTES
If you don’t want your new colors at the end of the 
palette, you can sort your color swatches, see page 
107.

You can also make Shades & Tints by using Add 
Grades. Mix the selected color with white or black, 
see page 113.

You can also make Tones by using Add Grades. Mix 
the selected color with any gray, see page 113.

Step 1
Paintbrush tool

Step 2

Step 3

Step 4

Step 5

The new shades and tints will be added to the 
end of the palette. Use the scrollbar to find them.

Step 4

Step 5

The new tones will be added to the end of  
the palette. Use the scrollbar to find them.
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ADDING GRADES
1.	 On the Block Worktable, click the 

COLOR tab or on the Quilt Worktable 
click the DESIGN tab. Click Fabric 
Tools on the ribbon and then click the 
Paintbrush tool. 

2.	 Click the Colors tab in the palette and 
click the color you want to mix.

3.	 Right-click on the color swatch and 
select Add Grades. You will see a box 
appear with two colors at the top. The 
color on the left will be the color you 
selected.

4.	 If you want to change the color on 
the right, click the down arrow beside 
it, then click another color from the 
picker. (To see all the colors, drag the 
bottom scrollbar.) The color on the right 
and the graded colors in between will 
change.

5.	 When you’re mixing colors you can add 
or remove swatches from the range. 
You can have 4-16 colors. 
 
To insert a new color, click the swatch 
you want to insert in front of and click 
the Insert button. 
 
To remove a color, click the swatch and 
click the Remove button.

6.	 Click the Add to Sketchbook button 
to add this range to your EQ8 color 
palette. Your added colors will be at the 
end of the current palette. 
 
Click Cancel to close the window 
without adding shades & tints or tones.

NOTES
If you don’t want your new colors at the end of the 
palette, you can sort your color swatches, see page 
107.

Add tints by mixing with white. Add tones by mixing 
with any gray. Add shades by mixing with black.

Step 1
Paintbrush tool

Step 2

Step 3

Step 4

Step 5

Step 6

The new tones will be added to the end of  
the palette. Use the scrollbar to find them.
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CHANGING THE DEFAULT PALETTE
The blocks, fabrics, colors, and threads you start with in every EQ8 project are in the default project. You can choose different 
defaults that will then appear each time you open EQ8 and start a new project.

1.	 Click View Project Sketchbook, then 
click the Blocks, Fabrics, Colors, or 
Threads section. Click an item and click 
Delete. Click Yes to delete it. 

2.	 Click Close when you have deleted all 
the items you do not want in your new 
projects.

3.	 Click Libraries from the menu bar, then 
the Block, Fabric or Thread Library. For 
colors, see pages 107.

4.	 Click to select a block, fabric or thread, 
then click Add to Sketchbook. Add as 
many as you’d like from any section or 
category. 

5.	 Click the respective Current Sketchbook 
section to check and approve your 
choices. If you want to add more items, 
click the Library section, and repeat 
step 4. If you want to remove items, 
select the item and click Delete.

6.	 Click Close when you’re finished.

7.	 When you are ready to make your new 
default palette, click File from the menu 
bar, then Save Palette as Default. Click 
OK. Your new palette will now appear 
each time you start a new project. 
 
Or, click Cancel to do nothing, and 
return to the worktable. The original 
EQ8 default palette will not change 
when you start a new project.

NOTE
Once you’ve changed the palette, you can revert 
back to the original default palette by clicking 
File from the menu bar, and Preferences. Under 
Workspace, click Restore, then click to put a check 
next to Also restore default blocks, fabrics, colors 
and thread. Click the Restore Default Settings 
button, then OK. Your palette will revert to the 
original EQ8 palette (and toolbars and dialog boxes 
will revert to their original settings and positions).

Step 1
View Project 
Sketchbook

Choose a section 
in the Project 
Sketchbook

Delete 
button

Step 2

Step 3

Step 4

Step 5

Step 6

Step 7
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USING THE RANDOMIZE TOOL
Testing out new colorations of the same quilt has never been this fun. With the Randomize tool you can switch your entire 
quilt back and forth from colors to fabrics, and even shift the colors randomly, by hue, saturation, or brightness. This is only 
available on the Quilt Worktable. (Before you start, with your quilt on the screen, you should Add to Project Sketchbook, in 
case you don’t like the recolored version.)

1.	 With the quilt you’d like to use on the 
Quilt Worktable, click the DESIGN tab. 
On the ribbon, click Fabric Tools, then 
the Randomize tool. 

2.	 Choose one of the modify color options 
(see details about each option on the 
following pages).

3.	 (Optional) Click on the quilt as many 
times as you like.

4.	 Modifying color sends the current 
colors through a calculation and returns 
different colors. If your quilt is colored 
with fabrics, they will be replaced by 
the average solid color of that fabric. 
Remember to Map to colors or Map 
to fabrics after any modifications, see 
page 118.

5.	 Click Add to Project Sketchbook 
whenever you find a new color version 
you want to keep.

NOTES
The Randomize tool does exactly what it says – it 
randomly recolors the quilt. You may find, after 
a few clicks, you would like to try a different 
option instead of the one you chose. To go back 
to your original quilt (which you Added to Project 
Sketchbook), click the View Project Sketchbook 
button, then the Quilts section. Find and click the 
quilt, then click the Edit button.

Don’t forget to color all parts of your quilt. The 
Randomize tool does not change uncolored areas 
filled with hatching lines.

Step 1

Randomize tool

Step 2

Step 4

Quilt after using the 
Randomize option

Quilt after using the  
Map to Fabrics option
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Shift Hue (-40 to +40)
Colors are identified by their hue. Hue is what 
makes something red, or green, or blue. If you 
think of a color wheel (or putting a rainbow in 
a circle), this is how Shift Hue works in EQ8. 
You can click a long time because you’re going 
in a circle. The higher the number, the more 
dramatic the change will be.

Set Hue to 0 and click on your quilt. The only 
change you will notice is that fabrics will be 
replaced by solid colors.  
 
Set Hue to a negative number and click on 
your quilt. Watch your colors go around the 
color wheel one way with each click.  
 
Set Hue to a positive number and click on your 
quilt. Watch your colors go around the color 
wheel the opposite way with each click.

Saturation (-20 to +20)
Saturation is the purity of color. High 
saturation is very rich in color, low saturation 
looks washed out. Saturation is changed by 
adding or subtracting gray. While hue change 
is circular, saturation is not. This means 
saturation will stop, because eventually the 
quilt cannot get any grayer or purer. The 
higher the number, the more dramatic the 
change will be.

Set Saturation to 0 and click on your quilt. You 
will notice the fabrics will be replaced by solid 
colors and may be slightly toned down.  
 
Set Saturation to a negative number and click 
on the quilt. Your quilt will become grayer 
with each click. 
 
Set Saturation to a positive number and click 
on the quilt. Most of the colors in your quilt 
will become richer. 

MODIFYING COLOR WITH THE RANDOMIZE TOOL
See page 115 for details on using the tool. Below are descriptions of the Modify Color options.

Original quilt

Shift Hue set to 0 – 
Fabrics changed to 

solid colors

Shift Hue set to -40 Shift Hue set to 40

Saturation set to -20 Saturation set to 20
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Brightness (-20 to +20)
Brightness is the intensity of a color. A high 
brightness would have a lot of white; a low 
brightness would have more black. Like 
saturation, a color is either bright or not. 
Because brightness is not circular, eventually 
brightness will stop since you can’t make the 
quilt any darker or lighter. The higher the 
number, the more dramatic the change will 
be.

Set Brightness to 0 and click on your quilt. You 
will notice the fabrics will be replaced by solid 
colors. 
 
Set Brightness to a negative number and click 
on the quilt. Your quilt will become darker 
with each click.  
 
Set Brightness to a positive number and click 
on the quilt. Your quilt will become lighter 
with each click.  

Randomize
Choosing randomize will replace all the colors 
in the quilt with a different solid color from 
the current Sketchbook palette. EQ8 will keep 
track of the colors used and try to prevent 
duplicating them (see Notes below). The more 
colors you have in your Sketchbook the better 
the results, see page 110. 

NOTES
When you use Shift Hue, Saturation or Brightness 
and choose a number close to zero, your changes 
will be gradual. If you choose a number farther 
away from zero, the changes will be quite drastic. 

When you choose Randomize, EQ8 will try to avoid 
duplicating the colors in the quilt. But, sooner or 
later, the color differences may “collapse” and 
some patches will be colored with the same solid 
color. Use the Paintbrush tool (pages 96) to recolor 
them again in different colors, if necessary. 

Brightness set to -20 Brightness set to 20

Example results of using Randomize
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NOTES
When only using colors, try a combination of the 
Randomize tool and Add Shades & Tints, Add 
Tones, or Add Grades so EQ8 will have more colors 
to use, see pages 112-113.

Suggestion: Put a check next to Don’t map unless 
within, and set the Tolerance somewhere between 
100 and 200. Choose Map to Fabrics and click on 
the quilt to replace your colors accurately. Then go 
to the Fabric Library and find fabrics similar to the 
ones not replaced.  

Map to Sketchbook
When you modify colors with the Randomize 
tool, the resulting colors are not in the 
Sketchbook. They are mathematical variations 
of the originals. You must map the modified 
colors to colors or fabrics in the Sketchbook 
before you continue to work on the quilt.

Map to colors – This replaces fabrics or colors 
with the closest color in the palette. When 
replacing a fabric, closeness means closest to 
the fabric’s average color. If Don’t map unless 
within is checked, a replacement will only 
occur if within the set tolerance. See Tolerance 
below.  
 
Map to fabrics – This feature will replace each 
color with the closest fabric in the current 
palette. Closeness for colors is compared to 
a fabric’s average color. If Don’t map unless 
within is checked, a replacement will only 
occur if within the set tolerance. See Tolerance 
below. 
 
Tolerance (0 to 500) - Tolerance is the “trade-
off” between the accuracy of a replacement 
and the number of replacements. To require 
a Tolerance when mapping, be sure there is a 
check in the checkbox and that the tolerance 
value has been adjusted. Tolerance setting 
keeps your mapping accurate. For example, 
if you have 300 solid colors and 10 fabrics 
in your Sketchbook for a specific project, 
and choose Map to fabrics, some of your 
solid colors may be mapped to the same 
fabric because there are no fabrics in the 
Sketchbook that are a close match.

Original quilt with fabrics After choosing Map to colors

Original quilt with solid colors After choosing Map to fabrics

Tolerance setting

Find the mapping options in the Sketchbook Fabrics & Colors 
palette, with the Randomize tool selected
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CHAPTER 6
Section A: Pieced Blocks

6A

EQ8 is very versatile in the drawing styles it offers when creating your own block designs. Chapter 6 is broken into four 
sections: Pieced Blocks, Applique Blocks, Pieced & Applique Blocks, and Serendipity Blocks. We’ll begin with the pieced 
blocks section, which offers you two different drawing styles:

EasyDraw gives you tools for drawing pieced blocks like you would if you were using graph paper and a pencil. Use the 
Line or Arc tools to draw an individual line or arc, as if you were drawing on the worktable with a pencil. After you’re done 
drawing, EQ8 converts those intersecting lines and arcs to create patches.

PolyDraw also creates pieced blocks, but it’s not like drawing with a pencil. Instead, it uses a tool that is most often used 
in Computer-Aided Design (CAD) programs which, in EQ8, allows you to make complete patches versus individual lines 
or arcs. Because you’re drawing completed patches, you must think of the “background” behind patches as additional 
patches since PolyDraw doesn’t have a block outline (like in EasyDraw). For this block style you have six grids, such as 
Circle, Kaleidoscope, and Octagon, to choose from to help guide your block design.



120

EQ8 Reference Manual

6

DRAWING AN 
EASYDRAW BLOCK
EasyDraw is like drawing with a pencil. The 
rule is: as long as the lines intersect or 
connect to one another, or to the edge of the 
block, you can fill the patches they create 
with color (solid or fabric). Any segments 
breaking the rule will disappear or cause color 
to bleed through multiple patches when you 
try to save or color it.

You can see from the picture at the top that it 
is not necessary to think in terms of outlining 
all sides of a patch. You are not required to 
draw one triangle patch, then draw a second 
triangle exactly the same size (as for an 
applique block) to create the block. Instead, 
you draw one line and EQ does the rest. That’s 
why it’s called EasyDraw!

Beyond the Line and Arc tools, EasyDraw also 
has a Grid tool that allows you to draw all 
lines of the selected grid in one stroke, making 
it that easy to draw some block styles. You 
choose how many columns and rows you want 
in the grid. See page 124.

NOTES
Both ends of a line or arc must touch another 
segment or the block outline. Anything floating  
at one end or both ends will disappear when you 
click Add to Project Sketchbook or click on the 
COLOR tab.

All lines must fall within the block outline when you 
click Add to Project Sketchbook. Do not drag lines 
outside of the block outline or have them extend 
past the block outline.

Draw a diagonal line to divide 
the block into two triangles.

EQ understands the drawing and 
creates the two patches that 

make up the block.

Good - All lines touch, 
creating a pieceable block.

Bad - If we bump the left point off 
the block outline, the lines still touch, 

but the left side cannot be easily 
pieced and color will bleed.

Although this may be a beautiful 
block, the center is not connected 

to the other lines of the block.

The Log Cabin “border” 
will be all that remains when you 

switch to the COLOR tab.

Lines floating or extending past 
an existing line will disappear.

Only lines connected to the 
outline or each other will remain 

after adding to the Project 
Sketchbook.
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SETTING UP THE 
PRECISION BAR
Here you’ll learn how to select the size of the 
block and other important drawing features 
for this style.

1.	 On the Block Worktable, click the NEW 
BLOCK tab. On the ribbon, click Pieced, 
then EasyDraw in the palette. You will 
be on the DRAW tab, click Drawing 
Tools on the ribbon (if it is not already 
selected). No matter what Drawing Tool 
is selected, you will see the Precision 
Bar above the Block Worktable. 

We will address each option working from left 
to right.

2.	 Block Size: Double-click in the boxes for 
Block Width and Block Height and type 
a new size. Remember that the size you 
enter here is the finished size of your 
block. 

3.	 Snap Points: Double-click in the boxes 
for Snaps Horizontal and Snaps Vertical 
and type a new number to change the 
snaps. See About Snap Points (below) 
and Example Snap Settings (left).

4.	 Graph Paper Cells: To see graph paper 
lines on the worktable, press the Hide/
show graph paper button. (These will 
not print, they are only there to help 
as you draw). To change the divisions 
of the graph paper, double-click in the 
boxes for Horizontal and Vertical  
and type a new number.

ABOUT SNAP POINTS
These numbers control the snap grid. They should 
be equal to, or a multiple of, your block size. The 
more snap points, or higher the Horizontal and 
Vertical numbers are, the harder it will be to 
see every single snap point. If EQ8 tried to show 
every snap point, the worktable would look like a 
filled space with dark dots, so don’t be nervous if 
you don’t see every snap because EQ8 will react 
accordingly to your settings. (If you have the graph 
paper showing this could also “hide” snap points by 
overlapping the same space.)

EXAMPLE SNAP SETTINGS:
For a 6” by 6” block: 
For snaps every inch: 6 (6 x 1 = 6) 
For snaps every ½ inch: 12 (6 x 2 = 12) 
For snaps every ¼ inch: 24 (6 x 4 = 24) 
For snaps every 1/8 inch: 48 (6 x 8 = 48) 
 
For a 6” by 10” block: 
For snaps every inch: 6 x 10 (6 x 1, 10 x 1) 
For snaps every ½ inch: 12 x 20 (6 x 2, 10 x 2) 
For snaps every ¼ inch: 24 x 40 (6 x 4, 10 x 4) 
For snaps every 1/8 inch: 48 x 80 (6 x 8, 10 x 8) 
 
For a 15 cm by 15 cm block: 
For snaps every cm: 15 (15 x 1 = 15) 
For snaps every 0.5 cm: 30 (15 x 2 = 30) 
For snaps every 2 mm: 75 (15 x 5 = 75) 
For snaps every mm: 150 (15 x 10 = 150)

Step 1

After choosing EasyDraw as the Block Style, you’ll be switched to the DRAW tab.

Precision Bar

Step 2
Block Size

Step 3
Snap Points

Step 4
Graph Paper Cells
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5.	 Snapping Options: Decide what 
snapping options you want turned on 
or off. The default is Snap to grid points 
on worktable and Snap to nodes of 
drawing are on and Snap to lines and 
arcs of drawing is off. We recommend 
sticking with the default settings 
and turning Snap to grid points on 
worktable on and off as needed. See 
descriptions of each snap setting to the 
right.

6.	 Guide Options: With one or more 
segments selected with the Pick tool 
(see page 125), click the Convert 
selected segments to guides button 
to turn the segments into guidelines. 
If you click this button without any 
segments selected, the entire drawing 
will convert to guides. These guides will 
also not appear on a printout, but are 
there to help in your drawing.  
 
Click Clear the current guides to erase 
all of the guides on the worktable. The 
guides will stay on the worktable until 
you choose to clear them (even if you 
start a new block), so if you don’t want 
them you can simply click this button.

7.	 Hide/show image for tracing: See page 
158 to learn more about tracing.

NOTES
No matter which Snapping Options you choose, 
you must still follow the “rules” for drawing. 
For instance, if you have Snap to grid points on 
worktable selected, draw a line so it snaps to a 
grid point, but then have no intersecting lines or 
arcs and the initial line doesn’t touch the edge, so 
it appears to float, it will disappear when you click 
Add to Project Sketchbook or the COLOR tab.

As you are drawing and lines and arcs intersect, you 
will not see the nodes, or black squares, appear 
until you click on the COLOR tab or Add to Project 
Sketchbook.

Step 5
Snapping Options

Step 6
Guide Options

offon

Step 7
Tracing Image

Original drawing Drawing converted to guides

Snap to lines and arcs of drawing: is rarely used, but will snap to a 
line or arc whether or not there is a node present.

Snap to grid points on worktable: snaps the ends of lines or 
arcs to grid points on the worktable. It matches your snap point 
settings in step 3. 

Snap to nodes of drawing: snaps the ends of your lines or arcs to 
existing intersections or ends of other lines or arcs where a black 
(square) node is present. 
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DRAWING WITH THE LINE AND ARC TOOLS
When drawing with EasyDraw, remember you are drawing the seam lines in your block. Therefore, all lines must touch or cross 
other lines or the block edge. You cannot have any patches “floating” inside your block. You should also not draw lines on top 
of other lines. 

1.	 On the Block Worktable, click the NEW 
BLOCK tab. On the ribbon, click Pieced, 
then EasyDraw in the palette. You will 
be on the DRAW tab, click Drawing 
Tools on the ribbon (if it is not already 
selected). 

Line Tool
The Line tool draws straight lines.

2.	 Click the Line tool.

3.	 Click, hold, and drag from where you 
want the line to start and where it is 
to end, then release. The line draws as 
you drag. The line must touch another 
line or arc, or the outside of the block, 
at a snap point, before you release.  

Arc Tool
The Arc tool draws semi-circular arcs which 
may be edited to form deeper or shallower 
curves.

2.	 Click the Arc tool.

3.	 Click, hold, and drag from where you 
want the arc to start to where it is to 
end, pressing your keyboard Spacebar if 
you want to change the direction of the 
arc, then release. The arc draws, as you 
drag. The arc must touch another line 
or arc, or the outside of the block, at a 
snap point, before you release. 

NOTES
If the line or arc is left “floating,” it will disappear 
when you click Add to Project Sketchbook or the 
COLOR tab.

When you release the mouse, the line or arc may 
seem to move a bit. This is because lines drawn in 
EasyDraw will snap to points on a grid. The number 
of grid points can be adjusted using the Precision 
Bar, see page 121. Snapping to a grid helps ensure 
that your lines are connected. Any segments not 
connected to other lines or arcs will disappear or 
cause color to bleed through multiple patches.

Step 3 – Position mouse 
at starting point

Click, hold, and drag to 
the end point of the arc

Press the SPACEBAR before releasing 
the mouse to flip the arc

Step 2
Line tool

Step 3 – Position mouse  
at starting point

Click, hold, and drag to 
the end point of the line

Step 2
Arc tool
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DRAWING A GRID
Use the Grid tool to quickly draw grid-style 
blocks.

1.	 On the Block Worktable, click the NEW 
BLOCK tab. On the ribbon, click Pieced, 
then EasyDraw in the palette. You will 
be on the DRAW tab, click Drawing 
Tools on the ribbon (if it is not already 
selected). 

2.	 Click the Grid tool. The GRID TOOL 
OPTIONS boxes will appear and your 
cursor will look like a plus sign with 
a 9-patch square in the bottom-right 
quadrant.

3.	 Under the GRID TOOL OPTIONS, 
double-click in the boxes for Columns 
and Rows and type a new number 
to change the grid. You can also click 
the up or down arrows to change the 
number.

4.	 To create the grid, position your cursor 
where you want the grid to start, click 
and drag diagonally (you’ll see it appear 
as you drag), and release. 
 
If you want the grid to fill the entire 
block, start with the cursor at the top-
left corner, drag diagonally, and release 
at (or just outside) the bottom-right 
corner of the block.

NOTES
No matter where you draw the grid or what size it 
is, make sure it’s snapping to grid points, especially 
if you’re not filling the entire block.

Make sure the grid works for the block size and 
snap points, in that area. You will be able to draw 
the grid, but may get unexpected results when you 
try to draw other lines. Example: Don’t drag out a 
3x3 grid to fill a 7 inch block.

You can draw a grid within a grid, and even 
change the number of Columns and Rows for the 
inner grid. Use this tool to save you time drawing 
individual lines.

Step 2

Step 3

Step 4 – Position mouse  
at starting point

Click, hold, and drag 
to the ending point

You can draw grids within a grid. After drawing the initial nine 
patch grid, three more grids were drawn inside the squares.
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EDITING EASYDRAW 
BLOCKS
The Pick and Edit tools can be used on blocks 
you’ve drawn or blocks from the Library.

Using the Pick Tool
This tool allows you to move or delete 
segments.

1.	 With an EasyDraw block on the Block 
Worktable, click the DRAW tab, then 
click Drawing Tools on the ribbon (if it 
is not already selected).

2.	 Click the Pick tool.

3.	 Click on a line or arc to select it.  
 
To select multiple segments, click the 
first segment, then hold your keyboard 
SHIFT key while clicking the other 
segments.  
 
To select the entire drawing, press 
CTRL+A (Command+A) on your 
keyboard.

4.	 To move the selection, click and hold 
in the center of the selection and drag 
it to a new location. Note whether the 
new position has the segment snapping 
to a grid point.  
 
To Delete the selection, click the Delete 
button under the PICK TOOL OPTIONS 
or press the DELETE key on your 
keyboard.

5.	 (Optional) Click the arrow beside 
Advanced Symmetry in the palette to 
see more options. 
 
Click Flip Left to Right to flip the 
selection horizontally. 
 
Click Flip Top to Bottom to flip the 
selection vertically. 
 
Click Flip Diagonally L to flip the 
selection diagonally left. 
 
Click Flip Diagonally R to flip the 
selection diagonally right. 
 

Step 2

Step 5
Click the arrow 

to see additional 
options

Flipping 
options

Step 3

Step 4 – Move
Drag the selected segment to a new location

Step 4 – Delete 
Click the Delete button to  

delete the selected segment
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Using the Edit Tool
This tool allow you to adjust the endpoints, 
or nodes, or the shape of the curve, where 
applicable. You can split a line or arc, adding 
nodes, with the Edit tool which gives you 
more nodes to play “connect the dots.”

1.	 With an EasyDraw block on the Block 
Worktable, click the DRAW tab, then 
click Drawing Tools on the ribbon (if it 
is not already selected). 

2.	 Click the Edit tool. An ADD NODES 
palette will appear.

3.	 Click on any line or arc to select it. 

Step 2

ADD NODES
palette

Step 3 – Select a line or arc

Click Clone to make a copy of the 
selection.  
 
Click Rotate 90, 180, or 270 to rotate 
the selection 90, 180, or 270 degrees. 
 
Click Rotate to choose a specific degree 
of rotation by either typing a number in 
the box or using the slider bar. 
 
Click Resize to choose the specific 
horizontal and vertical percent the 
selection will resize to by typing a 
number in either or both boxes, or 
using the slider bars.

6.	 After using any of the above options, 
the segment(s) will still be selected. 
Click and hold in the center of the 
selection and drag it so it snaps into 
place. 

NOTES
To undo either a move or deletion, click the Undo 
button.

Refer to Help to ensure proper snapping of all 
segment endpoints, particularly if you decide to use 
the Advanced Symmetry tools.

Flipping 
options

Rotating 
options

Clone

Resize

If you click Rotate, a new window 
appears where you can enter the 

specific degree of rotation. 

If you click Resize, a new window 
appears where you can enter the  

resize percentage.
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4.	 You can then add nodes to the selected 
segment in any of the following ways: 
 
At Location: Click At Location in the 
palette, then click on the segment 
where you want a new node to appear. 
(The reason you’d want a new node is 
so that segments could snap there, if 
it’s not the location of a grid point or 
intersection.) 
 
At Intersections: A node (or nodes) 
will appear every place where a line 
intersects with the selected segment. 
See Notes on the next page. 
 
Half: A node will appear in the middle 
of a segment, splitting it into two equal 
pieces, or halves. 
 
Thirds: Two nodes will appear to split 
the segment into three equal pieces. 
 
Partition Segment: Allows you to 
choose how many equal sections you 
want a segment to be split. You can 
double-click on the number and type 
a new number, or use the arrows to 
change the number. After setting the 
number, click Apply. 
 
Stagger Segment: Allows you to choose 
how many sections you want a segment 
to split into in a “half-drop” version 
of that many equal pieces. You can 
double-click on the number and type 
a new number, or use the arrows to 
change the number. After setting the 
number, click Apply.

Half Thirds

Partition set to 5 Stagger set to 5

Click At Location in the menu, then click on the selected 
line or arc where you would like a node to appear.

At Intersections places nodes at every point 
where a line or arc crosses the selected segment.
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5.	 If you don’t like the placement of the 
nodes, click the Undo button. 
 
Otherwise, click the Line tool to draw 
lines or the Arc tool to draw arcs to the 
new nodes created.

6.	 To move an individual node, click 
directly on the node and drag it to a 
new location. When you move the 
node, it will “snap” according to the 
settings you’ve select in the Precision 
Bar (see page 121). 

7.	 To change the curve of an arc, click 
directly on an arc to display the “tent,” 
and drag the tent to adjust the shape 
and direction of the arc. When the tent 
is displayed, you can also drag the “hot 
spot” at the center of the arc closer or 
farther from the tent.

NOTES
Make sure to keep all parts of an arc inside the 
block outline when dragging the tent.

The EasyDraw block outline cannot be split. 
However, lines drawn on top of the outline can be.

When drawing EasyDraw blocks, nodes get 
automatically added at every line intersection 
as soon as you click Add to Project Sketchbook, 
or when you click the COLOR tab. When you are 
working on a more complex block, you may not 
want all those nodes to appear while you are still 
drawing, but need them in certain parts of the 
block. You’ll find At Intersections useful if you want 
more control over when and where nodes are 
added while you are working on an in-progress 
drawing. Remember, once you Add to Project 
Sketchbook or switch to the COLOR tab, nodes will 
be added at all intersections.

Use Partition Segment (set to the same 
number each time) on two segments to 

create a straight line effect.

Use Partition Segment on one segment and 
Stagger Segment on another (both set to the 

same number) to create a zigzag effect.

After adding nodes, you can use them to draw new lines or arcs.

Step 5 – Move a node

Step 6 – Change the curve of an arc

Tent

Hot spot
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DRAWING A POLYDRAW BLOCK
PolyDraw uses a tool that is most often used in CAD programs. Unlike EasyDraw, you draw one complete patch at a time. 
You must start and stop at the same point to finish your patch. Double-clicking at that start/stop point will close the patch 
and release the tool from the worktable. This type of drawing can be a lot of fun because there are special grids that make 
designing easier. 

CHOOSING A 
POLYDRAW GRID
There are six grid options. In order to begin 
drawing a Pieced PolyDraw block, you need to 
choose one of these grids. Whichever one you 
choose, it will not appear on your printout, 
but will be a drawing guide and determine 
which tools you can use (see page 132).

1.	 On the Block Worktable, click the NEW 
BLOCK tab. On the ribbon, click Pieced, 
then PolyDraw in the palette. You will 
be on the DRAW tab, click Drawing 
Tools on the ribbon (if it is not already 
selected). No matter what Drawing 
Tool is selected, you will see the GRID 
PROPERTIES in the POLYDRAW BLOCK 
palette.

2.	 Select a Grid option in the palette.

3.	 Under the Grid options, there  are 
two snap boxes. What these snaps 
represent depends on the grid you 
choose in step 2: 
 
Rectangle – has typical Horizontal and 
Vertical snaps. Example: Log Cabin 
 
Circle – Rings controls the number 
of full circles (the center counts as 1, 
and there will be parts of other, not-
fully-seen or complete, circles in the 
corners). Spokes controls the number 
of spaces between the lines radiating 
from the center. Example: Compass 
 
Arc – Rings are the number of complete 
quarter circles (the center counts as 1, 
and there will be parts of other, not-
fully seen or complete, arcs in the 
corners). Spokes are the number of 
spaces between the lines radiating from 
the corner. Example: New York Beauty 
 

Step 1

Step 2

The snapping options 
listed here will change 
depending on the grid 

chosen above.

Rectangle Circle

Arc
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SETTING UP THE 
PRECISION BAR

1.	 On the Block Worktable, click the NEW 
BLOCK tab. On the ribbon, click Pieced, 
then PolyDraw in the palette. You will 
be on the DRAW tab, click Drawing 
Tools on the ribbon (if it is not already 
selected). No matter what Drawing Tool 
is selected, you will see the Precision 
Bar above the Block Worktable. 

Step 1

Eight Point Star – Dimension 1 controls 
the number of horizontal snaps in a 
corner square. Dimension 2 controls 
the number of vertical snaps in a corner 
square. The diamond sides will line 
up with the dimensions according to 
which dimension they meet. Example: 
LeMoyne Star 
 
Kaleidoscope – Dimension 1 is 
the number of rows/rings in the 
kaleidoscope. Dimension 2 is the 
number of diagonal rows possible 
within a wedge. Example: Maltese Cross 
 
Octagon – Dimension 1 is the 
number of rows/rings in the octagon. 
Dimension 2 is the number of diagonal 
rows possible within a wedge. Example: 
Kaleidoscope Rotated 

After choosing the grid and setting the snaps, 
you can move on to Setting Up the Precision 
Bar below and then Drawing with the PolyLine 
and PolyArc Tools (page 132).

NOTES
You can switch between grid layouts while drawing  
to allow you to include patches with arcs in a layout 
that only has lines, but you don’t want to overlap 
patches because they can’t be layered in this 
drawing style. If you want to overlap patches, you 
may want to draw an applique block, see page 149.

Since the lines and arcs have to follow the grid 
guides, you can change the snap numbers while 
working on the same layout (i.e., go from 4 to 8 
spokes in an Arc layout).

Eight Point Star Kaleidoscope

Octagon

The Eight Point Star grid 
was used while drawing  

in  the upper-left and 
lower-right quadrants.

The grid was then 
switched to Circle.

Using the PolyArc tool, curved patches 
were drawn in the upper-right and 

lower-left quadrants.
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After choosing PolyDraw as the Block Style, you’ll be switched to the DRAW tab.

Precision Bar

Step 2
Block Size

Step 3
Graph Paper Cells

Step 5
Guide Options

We will address each option working from left 
to right.

2.	 Block Size: Double-click in the boxes for 
Block Width and Block Height and type 
a new size. Remember that the size you 
enter here is the finished size of your 
block. 

3.	 Graph Paper Cells: To see graph paper 
lines on the worktable, press the Hide/
show graph paper button. (These will 
not print, they are only there to help 
as you draw). To change the divisions 
of the graph paper, double-click in the 
boxes for Horizontal and Vertical  
and type a new number.

4.	 Auto Fill: When Hide/show Auto Fill 
on closed patches is selected, closed 
patches will automatically fill with a 
cream color. 

5.	 Guide Options: With one or more 
segments selected with the Pick tool 
(see page 134), click the Convert 
selected segments to guides button 
to turn the segments into guidelines. 
If you click this button without any 
segments selected, the entire drawing 
will convert to guides. These guides will 
also not appear on a printout, but are 
there to help in your drawing.  
 
Click Clear the current guides to erase 
all of the guides on the worktable. The 
guides will stay on the worktable until 
you choose to clear them (even if you 
start a new block), so if you don’t want 
them you can simply click this button.

6.	 Hide/show image for tracing: See page 
158 to learn more about tracing.

Step 4
Auto Fill

Step 6
Tracing Image

Auto Fill on Auto Fill off
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DRAWING WITH THE POLYLINE AND POLYARC TOOLS
When drawing with PolyDraw, remember you are drawing completed patches. Therefore, all lines or arcs must start and stop 
at the same point (after you’ve clicked other points). Although adjacent patches will share edge lines, they will be drawn twice, 
once for each patch. You should not draw patches that overlap. 

Which grid you choose will determine which tool will be applicable. The PolyLine tool is active for all six grids, but the PolyArc 
is only available if you choose the Circle or Arc grids because those grids incorporate curves. No matter what grid layout 
you choose, none of them have a block outline, so you must fill the entire block with patches. For example, when you have 
finished drawing the rings in a Circle layout, you must still make patches for the areas outside of the last full ring that extend to 
the edge of the dotted block outline.

Drawing with the PolyLine 
Tool
The PolyLine tool draws straight lines and 
can be used in each of the grids (though the 
PolyArc tool will be preferable in the Circle 
and Arc grids).

1.	 On the Block Worktable, click the NEW 
BLOCK tab. On the ribbon, click Pieced, 
then PolyDraw in the palette. You will 
be on the DRAW tab, click Drawing 
Tools on the ribbon (if it is not already 
selected).

2.	 Click the PolyLine tool. Your cursor will 
look like a pen. The Rectangle, Eight 
Point Star, Kaleidoscope, and Octagon 
grids are all applicable for this tool. 

3.	 Place your cursor where you want to 
start the patch and double-click (this 
anchors your line to that point). The 
node will automatically snap to the 
nearest grid point. When you move 
your mouse you’ll see there is a blue 
line “attached” to your cursor.

4.	 Click (once) on another grid point to 
place a node. Again, the node will 
automatically snap to the nearest grid 
point. 

5.	 Continue to single-click on grid points 
to create the patch. 

6.	 When you are ready to complete the 
patch, double-click the first grid point. If 
Auto Fill is turned on, the newly-drawn 
patch will fill with a cream color.

The Kaleidoscope grid is used in the following illustrations. This is a zoomed-in view.

Step 3
Double-click to anchor 

the starting point for the patch.

Step 4
Single-click on the next point.

Step 2

Step 5
Continue single-clicking 

on points to create the patch.

Step 6
Double-click on the starting 

point to close the patch.
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7.	 Repeat steps 3-6 to draw as many 
patches as you want.

NOTE 
If you decide you no longer want to finish the patch 
you started drawing, press the keyboard ESC key or 
double-click anywhere on the worktable, to release 
the blue line attached to the cursor.

SHIFT+click to release the last node that was 
placed. Holding the SHIFT key and clicking multiple 
times will release a node, one at a time, back until 
the initial node.

You must complete an entire patch before starting 
a new one when drawing with these tools.

Drawing with the PolyArc 
Tool
The PolyArc tool draws arcs on the Circle and 
Arc grids, so before you begin, choose one of 
these grid layouts. (You can select this tool for 
the other grids, but it will only draw straight 
lines since it is “forced” to follow the grid 
guides.) 

1.	 With either a Circle or Arc grid, click the 
PolyArc tool. Your cursor will look like 
a pen.

2.	 Place your cursor where you want to 
start the patch and double-click (this 
anchors your line to that point). The 
node will automatically snap to the 
nearest grid point. When you move 
your mouse you’ll see there is a blue 
line “attached” to your cursor.  
 
Although the PolyArc tool makes arcs, if 
you’re following the outline of the grid 
and move your cursor over the block 
edge or another non-arced line, it will 
draw a straight line for that segment.

3.	 Click (once) on another grid point to 
place a node. Again, the node will 
automatically snap to the nearest grid 
point.

4.	 Continue to single-click on grid points 
to create the patch. 

Continue drawing patches until the entire block is filled.
The snap points you set under GRID PROPERTIES in the palette determine  
where you can draw the patches (see page 129). You can change the snaps  

while working on a block to manipulate the grid.

Step 1

The Arc grid is used in the following illustrations. This is a zoomed-in view.

Step 2
Double-click to anchor 

the starting point for the patch.

Step 3
Single-click on the next point.

Step 4
Continue single-clicking 

on points to create the patch.
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5.	 When you are ready to complete the 
patch, double-click the first grid point. If 
Auto Fill is turned on, the newly-drawn 
patch will fill with a cream color.

6.	 Repeat steps 2-5 to draw as many 
patches as you want.

NOTES
When using the PolyArc tool, be sure to click on 
each intersecting point on either the Circle or 
Arc grids to ensure the arc follows the grid as 
accurately as possible.

EDITING POLYDRAW 
BLOCKS
As in EasyDraw, there are the Pick and Edit 
tools, and although similar, have a few 
differences.

Using the Pick Tool
This tool allows you to move, flip, clone, 
rotate, or delete segments.

1.	 With a PolyDraw block on the Block 
Worktable, click the DRAW tab, then 
click Drawing Tools on the ribbon (if it 
is not already selected).

2.	  Click the Pick tool.

3.	 Click on any edge of a patch to select 
it. No matter what shape the patch is, 
EQ will create a rectangle of 8 nodes 
around it with a crossed, double-sided 
arrow as the cursor in the center. 
 
To select multiple patches, click the first 
patch, then hold your keyboard SHIFT 
key while clicking the other patches.  
 
To select ALL the patches, press CTRL+A 
(Command+A) on your keyboard.

4.	 To move the selection, click and hold 
in the center of the selection and drag 
it to a new location. Note whether the 
new position has the segment snapping 
to a grid point.  
 

Step 5
Double-click on the starting 

point to close the patch. Continue drawing patches until the 
entire block is filled.

Step 2

Step 3 Step 4 – Move
Drag the selected patch to a new location.
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To Delete the selection, click the Delete 
button under the PICK TOOL OPTIONS 
or press the DELETE key on your 
keyboard.

5.	 Using the options under Selected 
Patch Properties, you can do any of the 
following: 
 
Click Flip Left to Right to flip the patch 
horizontally.  
 
Click Flip Top to Bottom to flip the 
patch vertically.  
 
Click Clone to make a copy of the patch. 
The new patch will be selected and 
overlapping the original patch, so you’ll 
want to move it so it snaps into place 
on the grid. 
 
Click Rotate to rotate the patch 
clockwise at different angles specific to 
the grid you are using.

6.	 After using any of the above options, 
the patch(es) will still be selected. Click 
and hold in the center of the selection 
and drag it so it snaps into place.

NOTES
When you use the Pick tool and make any 
adjustments, you want to be sure the patch isn’t 
on top of other patches or floating outside the 
block outline. Be sure to move them so there is no 
overlap.

To undo any action made with the Pick tool, click 
the Undo button.

The PolyDraw Clone and Rotate Method is a fast 
way to create unique designs. See the EQ8 Online 
Support site for directions.

Step 4 – Delete 
Click the Delete button to  

delete the selected segment.

Step 5

PolyDraw Clone and Rotate Method
You can draw just a portion of the block and then quickly fill the rest of the block  

using Clone and Rotate. See the EQ8 Online Support site for full directions.

After drawing the patches that make up 
one of the star points, you can select all the 

patches and click Clone and Rotate. 

Move the new set of patches to the 
next star point so they snap into place.

Continue cloning and rotating 
to fill all the star points.

Don’t forget to fill the rest 
of the block with patches.
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Using the Edit Tool
This tool allows you to move an existing node, 
add new or delete nodes.

1.	 With a PolyDraw block on the Block 
Worktable, click the DRAW tab, then 
click Drawing Tools on the ribbon (if it 
is not already selected).

2.	 Click the Edit tool.

3.	 Click on the outline of any patch. Nodes 
will appear.

4.	 To move a node, click directly on the 
node and drag it to a new grid point. 

5.	 To add a node, double-click anywhere 
on a line to add a node at that location. 
After adding a node, you can move it as 
described in step 4.

6.	 To delete a node, double-click on the 
node and it will disappear.

NOTES
To undo any Edit action, click the Undo button.

Whether you are dragging an existing or new node, 
it will snap to a grid point. If it’s not snapping 
where you’d like, you can change your snap points, 
see page 129.

When dragging nodes, be sure to keep all segments 
and patches inside the block outline.

Step 2

Step 5
Double-click on a line to add a node (left). You can 

then move the node to a new location (right).

Step 6
Double-click directly on a node to delete it.

Step 3 Step 4
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UNDERSTANDING 
BLOCK VS. MOTIF
If you want to draw an applique block, EQ8 
gives you two choices: Block or Motif. With 
the addition of the StencilMaker for a Motif 
(see page 148), the tools and techniques are 
the same in both styles. The only, but big, 
difference is Block has a background patch 
and Motif does not.

An applique Block will create a plain 
background patch for your design when you 
click the Color tab. The design gets saved as 
a block and can be set on any layer of a quilt 
(see page 73).

An applique Motif has no background patch. 
These designs get saved to the Motifs tab of 
the Block Sketchbook. They are used on Layers 
2 or 3 of a quilt design (see page 75).

Since the tools are almost identical for both 
styles, we’ll go over all of them together.

SETTING UP THE 
PRECISION BAR
The Precision Bar for an applique block has all 
of the same options as an EasyDraw block (see 
page 121), the Hide/show Auto Fill on closed 
patches button from a PolyDraw block (see 
page 130), and has additional snapping points 
options, so we’ll explain those here.

1.	 On the Block Worktable, click the 
NEW BLOCK tab. On the ribbon, click 
Applique, then Block (or Motif) in the 
palette. You will be on the DRAW tab, 
click Drawing Tools on the ribbon (if 
it is not already selected). No matter 
what Drawing Tool is selected, you will 
see the Precision Bar above the Block 
Worktable.

2.	 Block Size: Double-click in the boxes for 
Block Width and Block Height and type 
a new size. Remember that the size you 
enter here is the finished size of your 
block. 

An applique block has 
a background square.

An applique motif does not 
have a background square.

In the Project Sketchbook, applique with a background will be on the 
Blocks tab. Applique without a background will be on the Motifs tab.

After choosing Block or Motif as the Applique Style, you’ll be switched to the DRAW tab.

Precision Bar

Step 1
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3.	 Snap Points: Double-click in the boxes 
for Snaps Horizontal and Snaps Vertical 
and type a new number to change the 
snaps. 

4.	 Graph Paper Cells: To see graph paper 
lines on the worktable, press the Hide/
show graph paper button. (These will 
not print, they are only there to help 
as you draw). To change the divisions 
of the graph paper, double-click in the 
boxes for Horizontal and Vertical  
and type a new number.

5.	 Snapping Options: Decide what 
snapping options you want turned on 
or off. The default is Snap to nodes and 
Auto join segments are on. Snap to grid 
and Snap whole patch to a grid could 
be helpful if you are working with a 
specific grid. See descriptions of each 
snap setting to the left.

6.	 Auto Fill: When Hide/show Auto Fill 
on closed patches is selected, closed 
patches will automatically fill with 
a cream color. If you think you’ve 
finished, or closed, a patch and  it 
doesn’t fill with the cream color, then 
you know it isn’t actually closed (see 
page 140).

7.	 Guide Options: With one or more 
segments selected with the Pick tool 
(see page 149), click the Convert 
selected segments to guides button 
to turn the segments into guidelines. 
If you click this button without any 
segments selected, the entire drawing 
will convert to guides. These guides will 
also not appear on a printout, but are 
there to help in your drawing.  
 
Click Clear the current guides to erase 
all of the guides on the worktable. The 
guides will stay on the worktable until 
you choose to clear them (even if you 
start a new block), so if you don’t want 
them you can simply click this button.

8.	 Hide/show image for tracing: See page 
158 to learn more about tracing.

Step 2
Block Size

Step 3
Snap Points

Step 4
Graph Paper Cells

Step 5
Snapping Options

on

Step 7
Guide Options

Step 6
Auto Fill

Step 8 
Tracing Image

on

Auto join segments when drawing – snaps nodes together as 
you’re drawing. If it is off you will not have closed patches. (This 
is particularly helpful when drawing and not using the automatic 
shapes.)

Snap to grid points on worktable – snaps the ends of lines or arcs 
to grid points on the worktable. 

Snap to nodes of drawing – snaps the ends of your lines or arcs to 
existing intersections or ends of other lines or arcs where a black 
(square) node is present.

Snap whole patch to a grid point on worktable – snaps the 
closest node (in a patch) to the closest snap grid point, so that the 
whole patch snaps to the grid. 

Snap aligned segments – auto aligns the edges of patches, 
especially for polygons when you want triangles or hexagons to be 
exactly side by side. 
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USING THE DRAW 
TOOL
When using the Draw tool, you need to use 
your mouse like you would a pencil. Once 
you have selected a specific drawing tool you 
will press and hold your cursor, acting like 
the pencil, drag it where you want on the 
worktable, and release to create your line or 
curve. 

1.	 On the Block Worktable, click the 
NEW BLOCK tab. On the ribbon, click 
Applique, then Block (or Motif) in the 
palette. You will be on the DRAW tab, 
click Drawing Tools on the ribbon (if it 
is not already selected).

2.	 Click the Draw tool. There are five sub-
tools available for the Draw tool. We 
will cover each sub-tool in the following 
sections.

Drawing with the Line and 
Bezier Curve Tools

3.	 Click the first sub-tool, Line, to draw 
straight lines. Or the second sub-tool, 
Bezier Curve, to draw line segments in 
C and S formations.

4.	 Position your cursor inside the block 
outline. Click and hold to start the 
segment and drag your cursor across 
the screen to change its length. Release 
to stop that segment, but do not move 
your mouse cursor.

5.	 Continuing from the stopping point of 
the last segment, click and hold to start 
the next segment. Drag to the desired 
ending point and release, but do not 
move your mouse cursor.

6.	 Repeat step 5 until you release the 
segment where you started the initial 
line or curve (in step 4) in order to close 
the patch. If Auto Fill is turned on, the 
patch will fill with a solid color. If it 
does not fill, it means all the segments 
are not joined and the drawing will be 
considered thread (because it is not a 
closed patch).

Step 2

Draw sub-tools

Step 4 – Drag out 
the first segment.

Step 5 – Drag out each 
segment from the ending 

point of the previous 
segment.

Step 6 – End at the starting 
point to close the patch.

Step 3 – Line sub-tool draws straight lines. Step 3 – Bezier Curve sub-tool draws curves.

Step 1
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NOTES
There may be cases where you do not want segments to form patches and simply be threads, such as when making cat whiskers. If you’re 
drawing straight-line quilting, you also don’t need to close the patch.

The Bezier Curve tool is not like the Freehand tool. A single arc drawn with this tool can never be more complicated than an “S” curve. To 
draw a complex shape with this tool you must “build it up” by joining together several curves.

If you want to draw a patch combining lines and curves, use the Bezier Curve tool and CTRL key (Command key). When you draw with the 
CTRL key (Command key) held down, it will draw lines; when the key is released, it will draw curves.

Drawing with the Freehand 
Tool
When drawing curves, the Freehand tool gives 
you more flexibility than the Bezier Curve 
tool. It is often used when tracing an applique 
image, see page 158.

3.	 Click the third sub-tool, Freehand, 
to draw a curvy line with multiple 
segments and nodes.

4.	 Position your cursor inside the block 
outline. Click and hold to start the 
segment and move your cursor freely 
across the worktable (you will see the 
line forming). Release to stop that 
segment. If you stop the cursor where 
you started it, a patch will form (if Auto 
Fill is on, the shape will fill with a solid 
cream color).

5.	 If you created a patch in step 4 then 
you can repeat it again to draw 
new patches. If you did not create a 
patch, then you can continue drawing 
segments until you release a connected 
segment on the starting point where 
you started to close the patch. (If a 
patch is still not formed, you may 
need to use the Edit tool to connect 
“floating” nodes, see page 152.)

NOTES
Any unclosed shapes will be interpreted as threads.

Do not cross over the line when drawing it because 
you will not be able to cut or sew the patch, and 
will receive an error message if you try to print a 
template of the block.

Do not draw patches extending past the block 
outline.

Step 3 – Freehand sub-tool draws curved 
lines with multiple segments and nodes.

Step 4 – Drag your mouse around 
freely to form the patch.

Step 4 – Release the mouse at the 
starting point to form a closed patch.

To adjust the way the Freehand tool draws, click the Worktable Options button. 
Under Applique, click Freehand, Rectangle, Ellipse. Under Freehand Default Settings, 

drag the slider bar to change the settings. 

The closer the slider bar is to Better Fit,  
the more nodes created when you draw.  
This will require a lot of editing, but will 

make your drawing more accurate. 

The closer the slider is to Looser Fit,  
the fewer nodes created when you 
draw. This will create a smoother 

drawing with less editing. 
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Drawing with the Brush 
Stroke and Swath Tools
Drawing with the Brush Stroke and Swath 
tools are very similar in how they are created, 
as you will see in the steps below. When 
you draw with either of these tools, you will 
initially see a line appearing on the worktable, 
but when you release your cursor, a very 
different segment will display.

3.	 Click the fourth sub-tool, Brush Stroke, 
to draw a brush stroke, or the fifth, 
Swath, to create unique flying geese or 
diamond patches.

4.	 Position your cursor inside the block 
outline. Click and hold to start the 
segment and move your cursor freely 
across the worktable (you will see a line 
forming). Release to stop that segment. 

After you release, the brush stroke or swath 
will be selected, so you can make changes 
to the settings under STROKE or SWATH 
PROPERTIES in the palette. 

5.	 To change the brush stroke’s body or 
ends, click on the down-arrow beside 
the Contour or End Caps boxes and 
choose the image you desire.  
 
To change the swath’s body or internal 
patches, click on the down-arrow 
beside the Contour or Style boxes and 
choose the image you desire.

6.	 To change the thickness of the brush 
stroke or swath, you can change the 
minimum width and/or boldness.  
 
Minimum Width – All of the contour 
styles (except the first one), have a 
place at the beginning, end, or middle 
where the line tapers in. This is the 
“location” in the line where the width 
is at its minimum. Set the Minimum 
Width to zero and this “location” will 
be basically flat (no width). As the 
minimum width number increases, this 
“location” will grow wider. 
 

Step 4 – Brush Stroke
 When you release the mouse, it will now look like there are three lines.  
The middle line (the one you drew), is called the spine, and you’ll have  

the ability to reshape your brush stroke using the spine. 

Step 4 – Swath
When you release the mouse, it will either look like a strip of flying geese or diamonds, 

depending which style is selected. The middle line (the one you drew), is called the spine, 
and you’ll have the ability to reshape your swath using the spine. 

Steps 5 & 6
Properties available for brush stroke

Steps 5 & 6
Properties available for swath
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Boldness – Boldness or “fatness” refers 
to the size of the brush stroke or swath 
around the spine. If you set it to 1, you 
have a very narrow area surrounding 
the spine. As you increase this number, 
the brush stroke or swath gets fatter 
and fatter, or bolder and bolder, 
around the spine. The overall style, or 
contour, does not change so it still has 
a “location” where it’s tapered and 
that area does not get fatter unless you 
change the Minimum Width for it.

7.	 Click the Edit tool and click the spine to 
change its shape. Click and hold on any 
node and drag to a new position. You 
can also click a node to see its handles. 
Click and hold on a handle and drag it 
to a new position.

8.	 When you are happy with your brush 
stroke or swath, click Convert to patch.

NOTES
You can change the order of steps 5-7, editing first 
and then changing properties, or you can repeat 
those steps several times until you create the 
desired patch.

When you make changes to the properties, you 
may have to move the brush stroke or swath so it 
does not extend past the block outline.

When you make changes to the Contour, Width, 
and Boldness in Swath Properties, the number of 
triangles or diamonds may change.

Once you have converted the brush stroke or swath 
to a patch, the property options are no longer 
available. You can still move the patches using the 
Pick tool (the flying geese or diamonds for the 
swath will now be individual patches), and make 
adjustments to individual nodes with the Edit tool, 
but the spine will no longer be available. 

If you have used the Line or Bezier Curve tools to 
draw, you can easily change those segments to 
brush strokes or swaths. Select the Brush Stroke 
or Swath tool and then double-click on the line or 
curve to change it to that drawing style.

Do no draw lines that cross.

Steps 5 & 6
Make changes to properties of the brush 
stroke in the palette. The brush stoke will 

update accordingly on the worktable.

Steps 5 & 6
Make changes to properties of the swath 

in the palette. The swath will update 
accordingly on the worktable.

Step 7
Use the Edit tool to make adjustments to the spine. This can only be 

done before the brush stroke or swath has been converted to a patch.

Step 8
When you are done editing and making adjustments to the properties, click Convert to 
patch to change the drawing into patches. When you click Add to Project Sketchbook, 

or switch to the Color tab of the Block Worktable, the drawing is also converted to 
patches. Make sure you are done making adjustments before converting.
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USING THE ELLIPSE AND RECTANGLE TOOLS
Using the Ellipse tool you can draw an ellipse, pie, or arc and decide how many partitions you want and how they are 
segmented. The Rectangle Tool makes squares, rectangles, or rounded rectangles.	

1.	 On the Block Worktable, click the 
NEW BLOCK tab. On the ribbon, click 
Applique, then Block (or Motif) in the 
palette. You will be on the DRAW tab, 
click Drawing Tools on the ribbon (if it 
is not already selected).

2.	 Click the Ellipse or Rectangle tool. The 
respective PROPERTIES for that tool will 
appear in the palette.  

3.	 Position your cursor inside the block 
outline, then click and hold to start 
the shape. Drag your cursor across the 
screen to change the size, then release 
to stop the shape.  
 
This is a drawing-in-progress, so it will 
not fill automatically if you have Auto 
Fill turned on. You can still change the 
shape’s size and other properties until 
you Convert to patch.

NOTE
If you hold down your keyboard CTRL key 
(Command key) while dragging out the shape, it 
will make a perfect circle or square.

Steps 4-7 are optional. If you are happy with 
your drawing, skip to step 7. 

4.	 To change the ellipse’s shape, click one 
of the shape buttons in the palette: 
 
Ellipse – makes your ellipse or circle 
without gaps (a circle or an oval). 
 
Pie – makes your ellipse or circle into 
a pie; choose the starting and ending 
angles to increase the gap in the pie. 
 
Arc – makes your ellipse into an arc; 
choose starting and ending angles to 
increase the gap in the arc. 
 

Step 2

Step 3 – Ellipse tool Step 3 – Rectangle tool

Ellipse properties applied

Starting angle
Ending angle

Pie ArcEllipse

Step 4 – Ellipse



145

Chapter 6B: Drawing Blocks–Applique Blocks

6

To change the rectangle’s shape, click 
one of the shape buttons in the palette: 
 
Rectangle – makes the corners sharp 
(90 degrees). 
 
Rounded Rectangle – makes the 
corners rounded; choose the roundness 
setting for each corner. 

5.	 If you are making an ellipse, pie, or arc, 
you can section it into pieces. Click the 
arrows beside Sections to choose how 
many sections you want (if you are 
adding sections for an arc, it will not be 
as visible, but nodes will be added). 
 
Click either the Partition evenly 
into sections or Stagger initial/final 
sections button to determine how the 
segments will appear in the ellipse.

6.	 When you are finished editing the 
shape, click the Convert to patch 
button in the palette. (You can also click 
on the COLOR tab or the Add to Project 
Sketchbook button to convert the 
shape to a patch.)	

NOTES
If you deselect the shape before you convert it to a 
patch or are finished changing its properties, click 
the Pick tool, then click the shape to select it again.

Once you have converted to patch, you can no 
longer change the shape’s properties. You can 
still move the patches using the Pick tool (if you 
sectioned the ellipse, each section will now be 
an individual patch), and make adjustments to 
individual nodes with the Edit tool.

Rounded rectangle properties applied

Roundness 
numbers for 
each corner

Rounded RectangleRectangle

Step 4 – Rectangle

Step 5

Partition Stagger

Change number 
of sections

These shapes have been converted to patches.

Step 6
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USING THE SHAPES TOOL 
This tool allows you to draw patches instantly, as well as making your own star, posy, or stencil (for Motif only).

1.	 On the Block Worktable, click the 
NEW BLOCK tab. On the ribbon, click 
Applique, then Block (or Motif) in the 
palette. You will be on the DRAW tab, 
click Drawing Tools on the ribbon (if it 
is not already selected).

2.	 Click the Shapes tool. The OVAL AND 
POLYGON SHAPES and PATCHMAKER 
SHAPES tools will appear.

Using the Oval and Polygon 
Shapes
Under OVAL AND POLYGON SHAPES, you will 
see a number of shapes, including a heart, 
leaves, triangles, a hexagon and more. The 
oval shapes are in purple and the polygons are 
in teal. They are all drawn in the same way.

3.	 Click on one of the Oval or Polygon  
sub-tools.

4.	 Click on the point on the worktable 
where you want to start the shape. 
Hold down the mouse and drag it 
across the worktable in any direction 
for the shape to appear. The farther you 
drag, the bigger the shape will become.

5.	 Release the mouse to stop the shape. It 
will be selected, so you can easily move 
or resize it (see page 149). 

NOTES
Do not start or extend a shape outside of the block 
outline.

If you hold down the keyboard CTRL key (Command 
key) while you drag the patch, it will constrain the 
proportions and angle of the patch. 

Don’t feel as though the pre-determined shape 
that you see on the tool is your only option. After 
drawing the initial shape, you can then use the Edit 
tool to re-position nodes, adjust curves, etc. 

To reshape, or edit, patches, see page 152.

Step 2

Step 3

Step 5
When you release the mouse, you create a 
closed shape. If Auto Fill is turned on, the 

shape will fill with a solid cream color.

Step 4
Click, hold, and drag to make the shape.
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Using the StarMaker or 
PosieMaker
These tools can be used in either an applique 
Block or Motif. What you create is based 
on what options you choose, including the 
number of points and size of the center.

3.	 Under PATCHMAKER SHAPES, click 
either StarMaker or PosieMaker. 
The respective window with options 
appears.

4.	 Make adjustments to the available 
options using the sliders. You can also 
double-click on a number and type a 
new number. Where applicable, click 
the circle next to the option you want 
to choose. 
 
The Preview will automatically update 
when you change the settings.

5.	 When you are happy with the star 
or posy you see in the Preview, click 
OK. EQ8 will put the patch on your 
worktable. (A StarMaker patch will be 
in the center of the worktable, while a 
PosieMaker patch will be in the top-left 
corner.) The patch will be selected, so if 
you want to move it, place your cursor 
over the center, click, hold, and drag it 
to a new location. 
 
If you decide you do not want one of 
these automatic shapes, click Cancel.

NOTES
You can use the Edit and Pick tools on these shapes. 
See pages 149 and 152.

You can move the patch at any time by using the 
Pick tool, but do not move it outside of the block 
outline.

Step 3

StarMaker
options

Step 5

Step 5

PosieMaker
options

You can choose a pre-designed PosieMaker 
shape here. The shape can be used as-is, 
or you can you use it as a starting point 

and adjust the settings above.

After clicking OK in Step 5, the new shape will be placed on the worktable.
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Using the StencilMaker 
This tool is intended to make quilting stencils 
to be set on Layer 3 of a quilt design. It can 
only be used on the applique Motif worktable, 
so make sure you choose Motif in Step 1 (on 
page 146).

3.	 Click on the StencilMaker tool. The 
StencilMaker window will appear.

4.	 Make adjustments to the available 
options using the sliders. You can also 
double-click on a number and type a 
new number. Click on the checkbox 
next to Add end loop to petals if you’d 
like to add that option. 
 
The Preview will automatically update 
when you change the settings.

5.	 When you are happy with the stencil 
you’ve created, click OK. EQ8 will put 
it on the worktable. The stencil will 
be selected, so if you want to move it, 
place your cursor over the center, click, 
hold, and drag it to a new location. 
 
If you decide you do not want a stencil, 
click Cancel.

NOTES
You can change the thread color, style, and weight 
by using the Thread Tools. See page 105.

You can use the Edit and Pick tools on the stencil. 
See pages 149 and 152.

Learn how to set a stencil in a quilt, see page 75.

The StencilMaker tool will only be available if you chose Motif as your Applique Style.

Step 3

StencilMaker
options

Step 5

After clicking OK in Step 5, the new stencil will be placed on the worktable.

When you add 
the stencil to the 

Project Sketchbook, 
it will be on the 

Stencils tab of the 
Blocks section.
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If you click the Resize button, a new 
window appears where you can enter 

the resize percentage.

EDITING APPLIQUE BLOCKS OR MOTIFS
There are two editing tools for patches you have drawn on a block or motif worktable, the Pick and Edit tools.

Step 2

Step 3
You can select multiple patches at once by dragging 

a marquee rectangle around the patches.

Step 4
Drag the selected patch(es)  

to a new location

Using the Pick Tool
Whether you have drawn a patch from scratch 
or used the Shape tool, you can change its 
size, location on the worktable, flip, rotate, 
or clone it, alter the layering of patches, and 
even make a wreath, all using the Pick tool.

1.	 With an applique block or motif on the 
Block Worktable, click the DRAW tab, 
then click Drawing Tools on the ribbon 
(if it is not already selected). 

2.	 Click the Pick tool.

3.	 Click on any edge of a patch to select it.  
 
To select multiple patches, click the first 
patch, then hold your keyboard SHIFT 
key while clicking the other patches. Or 
click and hold the mouse button and 
drag a dotted marquee rectangle so 
that it entirely surrounds the patches 
you want to select. When you release 
the mouse, the patches are selected.  
 
To select ALL the patches, press CTRL+A 
(Command+A) on your keyboard.

4.	 To move the selection, click and hold 
in the center of the selection and drag 
it to a new location. To select an exact 
location, you can click the up and down 
arrows beside the X- and Y-axis boxes.

The following options are found in the palette, 
under Selected Segment/Patch Properties. 
These options are only enabled when you 
have one or more patches selected. You may 
have to use the vertical scrollbar to see all the 
options.

To resize the patch, click the arrows 
beside the Width and Height boxes to 
change the size. You can also click the 
Resize button at the bottom to change 
the Horizontal and Vertical percentage 
for the patch.  
 

Resize

Step 5
Resize using the Width and Height boxes or by 

clicking the Resize button below
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To rotate a patch, type in the exact 
degree (0-360) you want to rotate in 
the Segment Rotation box, then click 
Apply. You can also click the Rotate 
90, 180, or 270 buttons to rotate the 
patches by those degrees. The rotation 
of some patches may be difficult to see 
if it is symmetrical. 
 
To flip a patch, you have four options 
to choose from (you may not notice 
a difference if the patch has any 
symmetrical sides):  
Flip Left to Right (a horizontal flip) 
Flip Top to Bottom (a vertical flip) 
Flip Diagonally L (a left-diagonal flip)  
Flip Diagonally R (a right-diagonal flip)  
 
To place the patch in the exact center 
of the block, both horizontally and 
vertically, click the Center in Block 
button. 
 
To make a copy of the patch, click the 
Clone button. The copy will be on top 
of the original patch, so you can click 
on the center crosshair and drag it to a 
new location. 
 
To delete a patch, click the Delete 
button. You can also use the DELETE key 
on your keyboard. 
 
To rearrange overlapping patches, you 
can click the Bring to Front or Send 
to Back buttons, which will place the 
patch on top or bottom, respectfully. 
This tool can be especially helpful after 
making a wreath.

5.	 After using any of the above options, 
the patch(es) will still be selected. Click 
and hold on the center crosshair if 
you’d like to drag it to a new location.

Flipping 
options

Rotating 
options

Make a copy

Resize

Rotate by degrees

Delete

Center

Layering options 
for overlapping 

patches

See the following 
page for info on 
Wreathmaker

Step 5 options

Step 5 – Changing the layering of patches

To move the flower head on top of the leaves, click the 
flower head patch then click Bring to Front in the palette.

To move the stem behind the flower head, click the 
stem patch and click Send to Back in the palette.
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Making a Wreath	
You can use the Wreathmaker tool on any 
patch(es), whether you’ve drawn it yourself or 
are using a block or motif from the library.

1.	 With an applique block or motif on the 
Block Worktable, click the DRAW tab, 
then click Drawing Tools on the ribbon 
(if it is not already selected). 

2.	 Click the Pick tool.

3.	 Select the patch(es) you’d like to use for 
the wreath (see page 149).

4.	 Click Wreathmaker in the palette.

5.	 Make adjustments to the available 
options using the sliders. You can also 
double-click on a number and type a 
new number.  
 
The Preview will automatically update 
when you change the settings.

6.	 When you are happy with the wreath 
you’ve created, click OK. EQ8 will put 
it on the worktable. (Wreaths are 
automatically centered in the block.)  
 
If you decide you do not want a wreath, 
click Cancel.

NOTES
Wreathmaker can be used on segments or patches. 
It will not work on a “drawing-in-progress” until it 
is converted to a patch (drawings made with the 
Brush Stroke, Swath, Ellipse, or Rectangle tools).

If you want to layer the patches differently, use the 
Bring to Front or Send to Back buttons.

If you set Cluster Spacing to 0% the wreath will 
be touching in the center. If you set it to 100%, 
WreathMaker may automatically change the value 
for Resize cluster to ensure that the wreath fits 
inside the block.

If you set Resize cluster to 100% the patches will 
not change size. If you set it to anything higher than 
100%, the patches will increase in size. 

Step 2

Step 3

Number of clusters – changes the number of patch groups (Range: 3-20) 
 
Cluster spacing – changes the amount of space between patch groups (Range: 0-100%)

Resize cluster – changes how much the patch groups are resized (Range varies; 100% = no 
change in size) 

After clicking OK in Step 6, the 
new wreath will be placed on the 

worktable.

Step 5
See descriptions 

below

Step 6

Step 4

You can use WreathMaker on a wreath for 
interesting effects. WreathMaker is also great 

for creating quilting stencils.

Starting with the wreath created in Step 6, 
the three bottom flowers were deleted, and 

then Wreathmaker was used again.



152

EQ8 Reference Manual

6

Using the Edit Tool
The Edit Tool allows you to add or delete 
nodes, convert arcs to lines or lines to curves, 
and apply other segmenting options.

1.	 With an applique block or motif on the 
Block Worktable, click the DRAW tab, 
then click Drawing Tools on the ribbon 
(if it is not already selected).  

2.	 Click the Edit tool.

3.	 Click on any edge of a patch to select 
it. There will be two nodes, one at each 
end of the segment, and if it’s a curve, 
it will have handles. 

You can shape patches using any of the 
following options.

4.	 To add a node, double-click on the line 
or curve at the point where you want a 
node. Or click Add Node in the palette 
to add a node in the center of the 
selected segment.

5.	 To delete a node, double-click directly 
on node. Or select the node and click 
Delete Node in the palette.

6.	 To move a node, click directly on the 
node and drag it to a new location.

The options available under EDIT NODES AND SEGMENTS will 
enable/disable based on what is selected on the worktable. 

Step 2

Step 4 – Add a node by double-clicking on the line or curve. 
Or click Add Node to add a node in the center of the selected line or curve.

Step 5 – Delete a node by double-clicking on the node. 
Or click on the node to select it and click Delete Node.

Step 6 – Move a node by clicking on the node and dragging it to a new location.
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7.	 To split the patch or segment at a node, 
click the node to select it, then click 
Break at Node in the palette. 

8.	 To join two segments, click the first 
node and then hold down the SHIFT key 
while you click the second node. Click 
Join Segments in the palette to connect 
the two nodes.

9.	 To change a curve to a line, click on the 
curve to select it, then click Convert to 
Line.

10.	 To change a line to a curve, click on the 
line to select it, then click Convert to 
Curve.

11.	 To change the shape of a curve, click 
directly on the curve to display the 
“handles” at each node. Click and drag 
a handle to change the shape.

To change the smoothness of a node’s 
handles, there are four options for 
changing how the handles for that node 
work:  
 
Corner – allows the curves to reshape 
independently of each other. Moving 
the handle on one side does not affect 
the other handle. The other handle 
stays in place until you’re ready to 
adjust it.  
 
Cusp – the handles lie on top of each 
other to create a sharp point at the 
node. Move the node and the handles 
around to reshape the point. 
 
Smooth – adjusts both curves like a 
teeter-totter. When one side goes up, 
the other goes down. The length of 
the handles are not equal. One can be 
really long and the other really short.  
 
Symmetrical – the handles also act 
like a teeter totter, but the length of 
the handles stays the same, creating a 
symmetrical curve at that node. 

Step 7 – Split a segment by clicking on the node to select it, then click Break at Node 
in the palette. If you break the node of a closed patch, and have Auto Fill turned on, 

you’ll see that the patch is no longer filled (because it’s no longer closed).

Step 8 – Join two segments by clicking on the first node, then SHIFT+click on the second 
node to select it. Click Join Segments in the palette. If joining the two segments closes a 

patch, and you have Auto Fill turned on, the patch will fill with a cream color.

Step 12 – There are four options for changing the node’s handles:

Corner - handles move independently Cusp - handles are locked together

Smooth - handles form a straight line;  
length of the handles can be different

Symmetrical - handles form a straight line; 
length of the handles are the same size
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MAKING AN APPLIQUE 
BLOCK A MOTIF
The only difference between an Applique 
Block and Motif is the background patch in 
an applique block. If you decide you want to 
eliminate the background, you can copy and 
paste the other patches into a Motif.

1.	 With an applique block on the Block 
Worktable, click the DRAW tab, then 
click Drawing Tools on the ribbon (if it 
is not already selected). 

2.	 Click the Pick tool.

3.	 Click on the Applique tab below the 
worktable.

4.	 If you want to select all of the patches, 
press CTRL+A (Command+A). Or you 
can click Edit on the main menu, then 
Select All. If you only want to select 
some of the patches, click on the first 
patch, then SHIFT+click on the rest of 
the patches you want.

5.	 With the patches selected, press 
CTRL+C (Command+C). Or you can click 
Edit on the main menu, then Copy.

6.	 Click the NEW BLOCK tab. On the 
ribbon, click Applique, then Motif in 
the palette. (If you have not added 
the Applique Block to the Project 
Sketchbook yet, you will be asked if 
you want to save before starting a new 
block.)

7.	 Press CTRL+V (Command+V) to paste 
the patches. Or you can click Edit on 
the main menu, then Paste.

8.	 The patches will be slightly off-center, 
but they will still be selected, so 
you can move them by clicking and 
dragging. Or click the Center in Block 
button in the palette.

9.	 Click Add to Project Sketchbook. 
The motif will be on the Motifs tab 
in the Blocks section of the Project 
Sketchbook.

Step 2

Step 3

Step 4
Select the patches you 

want to use for the motif.

Step 6

Step 7
Paste the patches on the Motif worktable. 

They will be slightly off-center.

Step 8
Drag to re-position the pasted patches,  

or click Center in Block in the palette 
to center all the patches.

Step 9
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UNDERSTANDING EASY + APPLIQUE VS. POLY + APPLIQUE
The only difference in these two block styles is the tools that are used to draw the bottom, pieced layer. You will start by 
selecting the tools that you want to use, choosing from EasyDraw or PolyDraw (see pages 120 and 129). The drawing rules that 
applied for each of these pieced block styles when drawing them alone (not with an applique layer), applies for either of these 
combinations.

The worktable will display tabs along the bottom of the screen. Use these tabs to change layers and load the appropriate tools 
in the palette. The tools for the pieced layer will be either EasyDraw or PolyDraw, depending on your choice. The tools for the 
applique layer are the same for both styles. Review Sections A and B from this chapter for help with these tools.

COMBINING PIECED AND APPLIQUE BLOCKS
You can draw a combination block from scratch, but if you already have separate pieced and applique blocks and want to 
combine them, follow these steps. You can start with any block you want on the worktable, but for this example we’ll begin 
with a Pieced block, whether it be EasyDraw or PolyDraw.

Pay attention to the block style 
listed above the Drawing Tools, so 

you know which to choose in Step 5. 
This is especially helpful if the block 

is from the library and you’re not 
sure how it was drawn.Step 2

Step 1

Step 5

Choose one of the combination block styles based on the block that you used in steps 1-4.

1.	 With the Pieced Block on the Block 
Worktable, click the DRAW tab, then 
click Drawing Tools on the ribbon (if it 
is not already selected). 

2.	 Click the Pick tool.

3.	 If you want to select all of the 
segments, press CTRL+A (Command+A). 
If you only want to select some of the 
segments, click on the first one and 
then SHIFT+click on the additional 
segments.

4.	 With the segments selected that 
you want to copy, press CTRL+C 
(Command+C).

NOTE
When you are copying and pasting pieced blocks, 
you should make sure that the new worktable 
has the same snap settings or grid settings as the 
original worktable. See pages 121 and 130.

5.	 Click the NEW BLOCK tab. On the 
ribbon, click Pieced & Applique. Which 
block style you select will depend on 
what type of Pieced block you copied. If 
you copied segments from an EasyDraw 
block, then click Easy + Applique. If 
you copied segments from a PolyDraw 
block, then click Poly + Applique.(If 
you have not added the Pieced Block 
to the Project Sketchbook yet, you will 
be asked if you want to save before 
starting a new block.)
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6.	 On the EasyDraw or PolyDraw tab 
(below the worktable), press CTRL+V 
(Command+V) to paste the segments. 

7.	 The segments will be slightly off-center, 
but they will still be selected, so you 
can move them by clicking on the 
center crosshair and dragging to a new 
location. If you have your snaps set 
properly, the segments should snap 
into place when you move them.

8.	 Click Add to Project Sketchbook.

9.	 Click View Project Sketchbook.

10.	 In the Blocks section, click on the 
applique block you want to combine 
with your pieced block, and click Edit.

11.	 Make sure the Applique tab (below the 
worktable) is selected, then click the 
Pick tool in the palette. 

12.	 If you want to select all of the patches, 
press CTRL+A (Command+A). If you 
only want to select some of the 
patches, click on the first one and then 
SHIFT+click on the additional patches.

13.	 With the patches selected that 
you want to copy, press CTRL+C 
(Command+C).

14.	 Click View Project Sketchbook. 

Step 6
Paste the segments

Step 7 
Move the segments so they  

are centered in the block and  
snap into place

Step 8 Step 9

Step 10

Applique tab

Step 11

Step 14
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15.	 In the Blocks section, click on the block 
you saved in step 8, and click Edit.

16.	 Make sure the Applique tab (below 
the worktable) is selected, then press 
CTRL+V (Command+V) to paste the 
patches. 

17.	 The patches will be slightly off-center, 
but they will still be selected, so you 
can move them by clicking on the 
center crosshair and dragging to a new 
location. Or click the Center in Block 
button in the palette to center them.

18.	 Click Add to Project Sketchbook.

NOTE
You can copy patches from an applique block first 
and then add, or paste, segments from a pieced 
block second. Use the same directions above, only 
switch to the applique block when talking about 
pieced blocks, and pieced for applique.

TRACING AN IMAGE 
You can trace an image on any Block 
Worktable in order to make it a pieced, 
applique, or combination block. If you are 
tracing an image for a foundation pieced 
block, you’ll most likely use EasyDraw. If you’re 
tracing an image for applique, you can use 
Applique Block or Motif (see page 138). 

PolyDraw gives you the least flexibility in 
drawing because of the special grids, and 
would only be applicable in a small number of 
tracing situations.

Importing an Image
1.	 On the Block Worktable, click the NEW 

BLOCK tab and choose what kind of 
block you’d like to make on the ribbon. 
Then choose the Block Style in the 
palette. You’ll then be switched to the 
DRAW tab.

2.	 If the tracing image is already in the 
Project Sketchbook, click View Project 
Sketchbook, then click the Photos 
section. Select the image, then click 
Edit >> to Block worktable. 
 

Step 15

Step 6
Paste the patches

Step 7 
Move the patches while they are still 
selected. Click Center in Block if you’d 

like them centered.

Choose which 
kind of block 

on the ribbon.

Then, choose 
the block style 
in the palette.

Step 1

If the tracing image is in the Project Sketchbook:

Step 2
Select the image and Edit to the Block Worktable.



159

Chapter 6C: Drawing Blocks–Pieced & Applique Blocks

6

If the tracing image is on your 
computer, click Tracing Image on the 
ribbon. Click Import Image in the 
palette. Navigate to the location of 
the image file on your computer. Click 
on the file to select it and click Open.  
Click OK in the Crop Image box. These 
options are available in the palette and 
we’ll adjust them in the next steps

3.	 (Optional) After editing or importing, 
the palette will switch to the Position & 
Resize tool. You can choose one of five 
POSITION & RESIZE RELATIVE TO BLOCK 
options: 
 
Inside Fit – this takes the longest edge 
of your image and fits it proportionally 
inside the outline, thus fitting the entire 
image inside. 
 
Outside Fit – this takes the shortest 
edge of your image and lines it up 
proportionally with the block outline. 
Part of the longer part of the image 
may fall outside the outline. 
 
Distort Fit – this ignores your image 
proportions and fits each edge of 
the image to each edge of the block 
outline. 
 
Center Image – this centers the image 
at its actual size/pixels in the block. 
 
Upper Left Image – this places the 
image at its actual size/pixels in the 
upper-left corner of the block.

4.	 (Optional) Drag the slider bar under 
Image lightness for tracing to change 
how light or dark the tracing image 
appears. You can change this at any 
point during your tracing.

If the tracing image is on your computer:

Step 2
Tracing Image 

on ribbon

Import Image

Navigate to the file on your computer, select it and click Open.

Step 3

Step 4

Smaller number = darker image, larger number = lighter image
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5.	 (Optional) Click the Crop tool. Crop by 
sight by dragging a handle on the image 
to a new location. Crop by numbers 
using the palette. Under CROP VALUES 
RELATIVE TO IMAGE, increase the X- 
and Y-axis, or decrease the Width and 
Height (you can type in new numbers 
or use the arrows). You can use both 
methods to get the box close to where 
you want to crop and then change the 
Width and Height to make it precise. 
Click the green Apply Crop checkmark 
to make your crop permanent or click 
the blue Reset Crop arrow to undo 
changes and cancel the crop.

6.	 Click the Drawing Tools option on 
the ribbon. Draw the block using the 
tools provided (see previous drawing 
sections to revisit how to use specific 
tools). See the next section for tips.

7.	 (Optional) Click the COLOR  tab to color 
your block.

8.	 Click Add to Project Sketchbook.

NOTES
When working on an applique block, you many find 
it helpful to turn off Auto Fill while tracing.

When using the Freehand tool to trace an applique 
patch, you may want to adjust the way the 
Freehand tool draws. See page 141 for details.

To learn how to edit photos from the Sketchbook, 
see page 30.

To learn how to scan, import (onto the Image 
Worktable), and edit an image, see Chapter 7.

Step 5

Choose whether or not to 
make the crop permanent.

Step 6

Color the block on the COLOR tab.

Trace the image on the DRAW tab.

Step 8
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TIPS FOR TRACING
All images are different. Following are 
guidelines and tips to help you trace your 
image. 

1.	 Before drawing, study your image 
and consider how you will divide your 
image into patches which can be sewn. 

2.	 Decide if you’d like to make a pieced or 
applique block. Then determine which 
block style would be most appropriate 
for the block you want to create.

3.	 Click the Hide/show image for tracing 
button on the Precision Bar, when you 
want to hide the image and see only 
your drawing. If you want to delete 
the image, click Tracing Image on the 
ribbon, and click Delete Image in the 
palette.

4.	 Click the Add to Project Sketchbook 
button as you are drawing to save the 
block in stages. If you decide you like 
an initial patch, but not some later 
patches, you can edit an earlier version 
of the block from the Sketchbook and 
start again.

Applique
5.	 Applique will allow for the layering 

of patches and gives you the most 
flexibility in shaping individual patches.

6.	 Each drawn patch must be a complete, 
closed patch. No patch can share a line 
with another patch.

7.	 Any unclosed shapes will be considered 
embroidery or quilting stitches, not 
patches. Lines can be colored using 
the Thread Tools, but they cannot be 
printed as Template patterns or filled 
with fabric, as patches can.

8.	 The drawing order of patches 
determines the layering order. You can 
change the patch layering order at any 
time, but it is easier to draw them in 
the order you’d like them layered: first 
drawn = bottom; last drawn = top.

Choose Pieced or Applique

If making an applique, decide if you  
want your traced block to have a  

background (Block) or not (Motif).

For a pieced block, EasyDraw would be 
appropriate for foundation pieced blocks 

and most grid-based blocks. PolyDraw 
gives you the least flexibility in drawing 
because of the special grids, but may be 

applicable in some situations.

Tip 3
Hide/show image for tracing

Show image for tracing Hide image for tracing

Tip 7
The cat’s body is made up of closed patches, but its whiskers are 

only lines and therefore are considered quilting stitches.
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9.	 You may want to click the Hide/show 
Auto Fill on closed patches button on 
the Precision Bar in order to still see the 
image.

Foundation Pieced Blocks
10.	 You can turn Snapping Options on and 

off while drawing to give you more 
flexibility. Drawing a foundation pieced 
block would be one of the instances 
when you may want to turn Snap to 
lines and arcs of drawing on.

11.	 You can also change your Snaps 
Horizontal and Vertical while working. 
For example, increase the number of 
snaps while working on a more detailed 
portion of the tracing. Remember, 
if you’ve turned Snap to Grid off, 
changing these snap numbers won’t 
matter because you’re no longer 
snapping to these points. 

12.	 When drawing a foundation pieced 
block, it’s usually best to start by 
drawing the lines that split the block  
into the large sections you intend to 
sew. Then begin adding detail to each 
section to make the block. 

13.	 Using At Intersections (available 
with the Edit tool, in the ADD NODES 
palette) is particularly helpful while 
drawing foundation pieced blocks 
because it allows you to add nodes at 
select intersections.

Grid-Based Pieced Blocks
14.	 If you’re trying to draw a block based 

on a photograph of a traditional pieced 
block (i.e. Ohio Star, Log Cabin, etc.), 
you may find it easier to draw the block 
by studying the grid of the block and 
setting your Precision Bar appropriately, 
rather than trying to trace the 
photograph directly.

Tip 9
Hide/show Auto Fill on closed patches

Show Auto Fill on closed patches Hide Auto Fill on closed patches

Tip 10
Turn the Snapping 

Options on and 
off, as needed, 
while tracing. 

Tip 11
Change the Snaps 

Horizontal and Vertical 
while drawing.

Tip 12
Start by drawing the lines for the major seams in the block, then add detail.

EasyDraw Precision Bar
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SERENDIPITY
Using the Create Serendipity option allows you to make new blocks without drawing so much as a line! All you have to do is 
have a block, whether it’s one you’ve drawn or one from the library, in the Project Sketchbook. You will use the same first step 
for all of the Serendipity options:

1.	 With one or more blocks in your Project 
Sketchbook (see page 200), click the 
Block Worktable button, NEW BLOCK 
tab, and Create Serendipity on the 
ribbon.

Frame Block
Use this to add any of the pre-drawn frames 
in EQ8 around your Project Sketchbook block. 
There are over 140 frames to choose from!

2.	 Click Frame Block. The Frame Block box 
will appear. It has three sections: the 
frame, the result, and the block.

3.	 In the left column, use the vertical 
scrollbar to see all the frame choices, 
and click the frame you want to use. 
(Optional: Use the coloring arrows 
below the column to choose either a 
grayscale or uncolored frame.)

4.	 In the right column, use the vertical 
scrollbar to see your Project 
Sketchbook blocks. Click the block 
you want to frame. (Optional: Use the 
coloring arrows below the column to 
choose from the block colorings.)

5.	 In the center, you will see the resulting 
block. This picture is interactive. If your 
block is asymmetrical (not the same 
on all sides), click on the block in the 
center picture to rotate it 90 degrees 
with each click.

6.	 If you like the new framed block, click 
Add to Sketchbook. (If you click Add 
to Sketchbook, that button will be 
disabled until you choose a different 
frame or block, or you rotate the block.) 
If you don’t like it, start over at step 3.

7.	 Repeat steps 3-6 to try framing other 
blocks, or click Close to return to the 
worktable.

NOTES
These frames are pre-drawn for you. To draw your own frames, try Merge Blocks 
instead (see page 166).

Blocks created can be edited further on the Block Worktable.

Step 3 Step 4

Coloring arrows 
for frames

Coloring arrows 
for Sketchbook blocksStep 6

Step 5

Step 7

Step 1

Serendipity
Toolbox
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Tilt Block
Use Tilt Block to rotate or tilt the block inside 
a square (like Diamond in the Square at 
varying angles). Tilt 45 degrees to turn a block 
on-point. Or create a fun, twisted effect by 
continuing to “tilt” each newly-created block.

2.	 Click Tilt Block. The Tilt Block box will 
appear. It has three sections: the block, 
the result, and a slider to control the 
tilt.

3.	 In the left column, use the vertical 
scrollbar to see your Project 
Sketchbook blocks. Click the block you 
want to tilt. (Optional: Use the coloring 
arrows below the column to choose 
from the block colorings.)

4.	 Below the “result” block, drag the slider 
rectangle to the desired tilt. 

5.	 You will see the block tilt as you 
drag the slider rectangle. This 
picture is interactive. If your block is 
asymmetrical (not the same on all 
sides), click on the block in the “result” 
picture to rotate it 90 degrees with 
each click.

6.	 If you like the new tilted block, click 
Add to Sketchbook. (If you click Add 
to Sketchbook, that button will be 
disabled until you change the tilt or 
block, or you rotate the block.) If you 
don’t like it, start over at step 3.

7.	 Repeat steps 3-6 to try tilting other 
blocks, or click Close to return to the 
worktable.

NOTE
Blocks created can be edited further on the Block 
Worktable.

Step 2

Step 3

Coloring arrows
Step 6

Step 5

Step 7

Step 4
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Merge Blocks
Use this to combine two blocks from your 
Project Sketchbook to create one new block. 

2.	 Click Merge Blocks. The Merge Blocks 
box will appear. It has three sections: 
the background block, the result, and 
the inner block.

3.	 In the left column, use the vertical 
scrollbar to see your blocks that fit 
the requirement. (Not all blocks will 
show because they do not fit the 
requirements. Click the Help button for 
more info.) Click the block you want 
as the background. (Optional: Use the 
coloring arrows below the column to 
choose from the block colorings.)

4.	 In the right column, use the vertical 
scrollbar to see all your Project 
Sketchbook blocks. Click the block you 
want to merge into the background. 
(Optional: Use the coloring arrows 
below the column to choose from the 
block colorings.)

5.	 In the middle, you will see the resulting 
block. This picture is interactive in two 
ways: 
 
If there is more than one square, 
rectangle, or 4-sided spot in the 
background block, click a different spot 
of the background block to change the 
location of the merged block. 
 
If your block is asymmetrical (not the 
same on all sides), click on the block in 
the picture to rotate it 90 degrees with 
each click.

6.	 If you like the new merged block, 
click Add to Sketchbook. (If you click 
Add to Sketchbook, that button will 
be disabled until you change the 
background or merging block.) If you 
don’t like it, start over at step 3.

7.	 Repeat steps 3-6 to try merging other 
blocks, or click Close to return to the 
worktable.

Step 2

Step 3 Step 4

Coloring arrows 
for background blocks

Coloring arrows 
for Sketchbook blocks

Step 6

Step 5

Step 7

Click Help to see 
background block 

requirements
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Clip & Flip
Use this to flip and rotate the upper-left 
quadrant block to create a new version of the 
block.

2.	 Click Clip & Flip. The Clip & Flip box 
will appear. It has three sections: the 
block to choose, the preview, and 
buttons (flags and a die) to choose the 
orientation.

3.	 In the left column, use the vertical 
scrollbar to see your Project 
Sketchbook blocks. Click the block you 
want to clip and flip. (Optional: Use the 
coloring arrows below the column to 
choose from the block colorings.)

4.	 Below the preview, click to choose one 
of the flag orientation blocks or the 
red die button to generate random 
samples. You can click the die multiple 
times for different orientations.

5.	 If you like the block preview, click 
Add to Sketchbook. (If you click Add 
to Sketchbook, that button will be 
disabled until you change the block, or 
flag or die orientation.) If you don’t like 
it, start over at step 3.

6.	 Repeat steps 3-5 to try clipping and 
flipping other blocks, or click Close to 
return to the worktable.

NOTES
You will have more interesting results if you choose 
blocks that are asymmetrical (not the same on all 
sides).

EQ clips the block to the top-left quadrant and uses 
that for the flipping, so if there are different colors 
or designs in the other quadrants of the block, you 
will not see them in the new block.

Blocks created using this feature can be printed 
for patterns, set in quilts, and colored on quilts. It 
is recommended that you do not edit to the Block 
Worktable for further editing or coloring. 

Step 2

Step 3

Coloring arrows
Step 5 Step 6

Step 4
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Shrink & Flip
Use this to shrink a block and then flip and 
rotate it in the four quadrants to create a new 
block.

2.	 Click Shrink & Flip. The Shrink & Flip 
box will appear. It has three sections: 
the block to choose, the preview, and 
buttons (flags and a die) to choose the 
orientation.

3.	 In the left column, use the vertical 
scrollbar to see your Project 
Sketchbook blocks. Click the block you 
want to shrink and flip. (Optional: Use 
the coloring arrows below the column 
to choose from the block colorings.)

4.	 Below the preview, click to choose one 
of the flag orientation blocks or the 
red die button to generate random 
samples. You can click the die multiple 
times for different orientations.

5.	 If you like the block preview, click 
Add to Sketchbook. (If you click Add 
to Sketchbook, that button will be 
disabled until you change the block, or 
flag or die orientation.) If you don’t like 
it, start over at step 3.

6.	 Repeat steps 3-5 to try shrinking and 
flipping other blocks, or click Close to 
return to the worktable.

NOTES
You will have more interesting results if you choose 
blocks that are asymmetrical (not the same on all 
sides).

Blocks created using this feature can be printed 
for patterns, set in quilts, and colored on quilts. It 
is recommended that you do not edit to the Block 
Worktable for further editing or coloring. 

Step 2

Step 3

Coloring arrows
Step 5 Step 6

Step 4
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Kaleidoscope
Use this to turn a simple block into a 
kaleidoscope!

2.	 Click Kaleidoscope. The Create 
Kaleidoscope from Block box will 
appear. It has three sections: the block 
to choose, the preview, and which 
triangular portion of the block to 
choose.

3.	 In the left column, use the vertical 
scrollbar to see your Project 
Sketchbook blocks. Click the block you 
want to kaleidoscope. (Optional: Use 
the coloring arrows below the column 
to choose from the block colorings.)

4.	 In the right column, choose the 
triangular portion of the block you wish 
to use. There are 8 options in all, so 
make sure you use the vertical scrollbar 
on this column to see all the options.

5.	 If you like the block preview, click 
Add to Sketchbook. (If you click Add 
to Sketchbook, that button will be 
disabled until you change the block or 
triangular portion.) If you don’t like it, 
start over at step 3.

6.	 Repeat steps 3-5 to try kaleidoscoping 
other blocks, or click Close to return to 
the worktable.

NOTE
Blocks created using this feature can be printed 
for patterns, set in quilts, and colored on quilts. It 
is recommended that you do not edit to the Block 
Worktable for further editing or coloring. 

Step 2

Step 3 Step 4

Coloring arrows 
Step 5 Step 6
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Fancy Star
Fills star points with your selected block.

2.	 Click Fancy Star. The Fancy Star box will 
appear. It has three sections: the block 
to choose, the preview, and settings at 
the bottom to choose.

3.	 In the left column, use the vertical 
scrollbar to see your Project Sketchbook 
blocks. Click the block you want to 
make a fancy star. (Optional: Use the 
coloring arrows below the column to 
choose from the block colorings.)

4.	 Decide if you want to create a motif 
or block. Put a check next to Add a 
background patch to star motif to 
create a block. Leave it clear if you 
want to create a motif.

5.	 Click the Select number of points drop-
down box to choose the number of star 
points (you can choose between 5 and 
10 points).

6.	 If you chose to create a block in step 4, 
drag the slider bar to choose how large 
the star is on the background block.

7.	 If you like the block preview, click 
Add to Sketchbook. (If you click Add 
to Sketchbook, that button will be 
disabled until you change the block, 
number of points, size, or whether 
there is a background patch.) If you 
don’t like it, start over at step 3.

8.	 Repeat steps 3-7 to try creating other 
fancy star blocks, or click Close to 
return to the worktable.

NOTES
Create a motif and block, if unsure which you’ll 
use. Click Add to Sketchbook with a check in Add 
a background patch to star motif and without a 
check. The motifs will be saved on the Motif tab in 
your Project Sketchbook Blocks section.

Blocks created using this feature can be printed 
for patterns, set in quilts, and colored on quilts. It 
is recommended that you do not edit to the Block 
Worktable for further editing or coloring. 

Step 2

Step 3

Coloring arrows
Step 7 Step 8

Step 6

Step 4

Step 5
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CHAPTER 7
Working with Photos and Fabric Images

EQ8 comes with hundreds of photos and fabrics that you can use “as is” in your quilt designs. You can also import  

pictures you’ve taken, or scans of your favorite fabrics. Whether working with photos or fabrics from the built-in  

libraries, or importing your own, they can all be edited, including cropping, resizing, and changing their coloring.  

These options, similar to those in a photo-editing software, will help you create your own fabric designs to print  

on fabric, prepare images for your next memory quilt, and much more. 

7
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UNDERSTANDING PHOTOS
“Image” is the generic term EQ8 uses for any item that can be edited on the Image Worktable. In more technical terms, any 
file that is saved in an image file format (BMP, GIF, JPG, PNG, or TIF files). 

These images can be photos you’ve taken with your camera, fabrics you’ve scanned, etc. When importing and saving from the 
Image Worktable, these items are saved in the Photos section of the Project Sketchbook. So, even if the image you’re working 
with is a scanned fabric, EQ8 interprets the image as a photo. If you’d like to treat the image like a fabric, you can use the Copy 
to Fabrics button (see page 30) in the Photos section of the Sketchbook, or use the Add as Fabric button (see page 181) in the 
Image Worktable palette after editing on the worktable.

SCANNING FABRICS OR 
PHOTOS
You can scan any image and use it in your quilt 
design, including actual fabric. Because there 
are so many scanners available, you will need 
to be familiar with how your scanner works. 
Following are general suggestions for the best 
results when scanning. When you scan an 
image, we suggest saving it in a subfolder of 
Documents or Pictures so you can find it again 
easily.

Quilt Worktable
You can set images in your quilts for planning 
any type of printable fabric quilt (memory 
quilts, art quilts, photo effect quilts), quilts 
where portions are already finished (large 
panels, T-shirt quilts, embroidered blocks, 
etc.), and even for planning borders for quilt 
centers. To set an image on your quilt, make 
sure it is in your Project Sketchbook, then see 
page 79. 

In addition, you can use an image to create a 
One Patch Quilt using the Photo Patchwork 
Layout. This quilt will be filled with solid 
colors based on the image. To create a Photo 
Patchwork quilt, see page 49.

Block Worktable
Images can be traced to create printable 
patterns, using the tools provided for the 
block type you choose. See page 158.

Image Worktable
Images can be cropped, rotated, flipped, 
sheared, and their colors can be modified in 
many different ways. 

A photograph printed on fabric is the focal point of this quilt design.

Flower photograph used as a tracing image for an applique block.

Circular symmetries effect used to create this kaleidoscopic image.
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Scanning Fabrics
Suggested Size for Fabrics 
Approximately 5” x 5” (350 pixels). The fabric 
image does not need to be square, especially 
if you’re trying to crop to the design repeat. 
Generally speaking, anywhere from 3” to 7” is 
an acceptable size. See Note below, left.

Resolution for Scanned Fabrics  
	 •	 72 or 75 dpi – all files but GIF or PNG 
	 •	 96 dpi – GIF or PNG files

Other Fabric Scanning Tips 
	 •	 Iron the fabric and place the fabric as  
		  straight as possible on the scanner bed,  
		  especially with striped or checked fabric.  
		  If you need to straighten the fabric image  
		  after importing, see page 178. 

	 •	 Don’t waste fabric by cutting out a swatch  
		  to use. Just drape an ironed portion of  
		  your fabric over the scanner bed. 

	 •	 If the fabric shifts when closing the  
		  scanner lid, use a book to hold it in place  
		  instead. If your fabric is light-colored, and  
		  you can see the book through the fabric,  
		  try covering the book in white paper.

	 •	 Scaling – Don’t change the scale of the  
		  fabric because EQ8 will correctly scale the  
		  fabric on the block or quilt for you, as  
		  long as you follow the resolution (dpi)  
		  guidelines above. If you need to adjust  
		  the scale of the fabric after importing, see  
		  page 177.

	 •	 Normal vs. Photo Color – choose a  
		  setting such as Normal rather than Photo  
		  color, if possible.

	 •	 Descreening – A scanned fabric’s weave  
		  can produce a moiré pattern. To avoid  
		  this, use a setting such as Descreen, or  
		  Magazine/Newspaper. Or slightly turn  
		  the fabric on the scanner bed.

	 •	 Cropping – The image you save is what  
		  will appear when you color in EQ8. Be  
		  sure to crop your fabric to cut out any  
		  white edge caused by the scanner bed  
		  behind the fabric. See page 180.

NOTE
To keep file sizes as small as possible, fabric in EQ8 “tiles” (repeats) the small 
fabric design you save, in order to simulate the effect of a large piece of fabric on 
your quilt. To make this tiling less noticeable, it is important to find your fabric’s 
design repeat, and spend time cropping your scan at the appropriate place. It’s 
also important to keep the cropped image as small as possible. Small repeats 
mean small files (which is good), and large repeats mean larger files (which can 
make your computer run slower). Make EQ8 run most efficiently by keeping your 
project file sizes manageable. This means not loading in too many fabrics at once, 
and keeping your scanned image sizes small.

Fabric cropped without 
regard for the design repeat.

When the fabric is “tiled” in the quilt,  
it’s very obvious where the fabric  

has been cropped.

Fabric has been cropped 
to the design repeat.

The tiling is seamless in this quilt because 
the fabric image was cropped properly.

Look for options like Color Mode or Color Setting, and Descreen or 
Magazine/Newspaper. Every scanner software is different. Experiment to 

find which settings work best for your particular scanner.
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Scanning Photos
Suggested Size for Photos 
If you will be printing the photo from EQ8, 
import it (see below) in the same dimension 
you’ll set and print it. For example, import a 
5” x 7” photo and set it in your quilt at 5” x 7”.

Resolution for Scanned Photos  
	 •	 72 dpi – when not printing from EQ8 
	 •	 150 dpi or higher – when printing from  
		  EQ8 (See Notes, right.)

IMPORTING AN IMAGE
To import an image onto the Image 
Worktable, whether you’ve scanned, 
downloaded, or gotten it on to your computer 
some other way, follow these steps. (If you 
want to import the image into a Library, see 
page 208.)

1.	 Click on the Image Worktable button, 
then the IMAGE tab. On the ribbon, 
click Edit, then the Import Image 
option in the palette.

2.	 Navigate to the location of the file on 
your computer.

3.	 Click on the image file you want to 
import.

4.	 Click Open. The image will appear on 
the Image Worktable.

5.	 Click Add to Project Sketchbook to 
make the original image part of your 
current project.

NOTES
You can now change the size, orientation, and 
colors on the image, apply filters and effect, and 
much more, see pages 175-196.

You can only import one image at a time on the 
Image Worktable. If you’d like to import multiple 
photos at once, use the Import button in the Photo 
Library, see page 208.

If you are replacing an image on the worktable and 
have not saved changes to the previous image, you 
will receive a prompt. Click Yes to save the previous 
image in the Project Sketchbook Photos section. 
Click No to discard the changes.

Step 1

Step 3 Step 4

The selected image will open on the Image Worktable.

Step 5

NOTES
Resolution - 72 dpi 
If you do not plan to print directly from EQ8, say you have a t-shirt quilt you are 
working on, or want to use a panel print, keep the resolution low to save file 
space. Low resolution images (screen-res) is fine for visual representations in EQ8.

Resolution - 150 dpi or higher  
If you plan to print the photo onto inkjet fabric sheets directly from EQ8, a 
resolution of 150 dpi or higher is best. Remember to leave some extra printed 
space around your photo for seam allowance.
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Step 1

EDITING AN IMAGE
There are many ways to edit images on the Image Worktable. First, you must have the image you want to edit on the 
Image Worktable. You can import the image, as explained on the previous page, or edit it from the Photo Library or Project 
Sketchbook.

RESIZING AN IMAGE
It’s a good idea to add the original image 
to the Project Sketchbook before you start 
making size adjustments.

1.	 With your image on the Image 
Worktable, click the IMAGE tab. On 
the ribbon, click Edit, then the Resize 
Image option in the toolbox. The Resize 
Image box will appear.

2.	 (Optional) The Width and Height 
numbers are in the Units specified. 
If you want to use another unit of 
measurement (Pixels, Inches, or 
Centimeters), change the Units first and 
then change the Width and Height.

3.	 Use the arrows next to the size or 
double-click on the numbers and type 
a new size. If you have Maintain aspect 
ratio checked, changing one number 
will change the other to keep them 
proportional.

Edit to Image Worktable –  
Adds the selected item to your Project Sketchbook 
and immediately places it on the Image Worktable.

Libraries menu >  
Photo Library

Edit from the Photo Library

Edit from the Project Sketchbook

From the Photo Library
In the Photo Library (from Libraries on the 
main menu), you can find and select an image 
and click the Edit to Image Worktable button 
to instantly be able to work on that image. 
The selected image will also be added to the 
Project Sketchbook.

From the Project 
Sketchbook
In the Photos section of the Project 
Sketchbook, you can click the Edit button and 
then click the to Image worktable option. 

If you have a fabric in the Project Sketchbook 
that you want to edit on the Image Worktable, 
find and select it, and click the Copy to 
Photos button. Then go to the Photos section 
and click the Edit button and then to Image 
Worktable option.

Step 2

Step 3
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4.	 (Optional) To change the Resolution, 
double-click the existing number 
to highlight it and type something 
different. Note: Resolution is in pixels 
per inch or pixels per centimeter. If 
Units is set to Pixels, changing the 
Resolution will adjust Width and Height 
automatically when you click OK.

5.	 If you are decreasing the size of an 
image, set Resampling to Normal.  
 
If you are increasing the size of an 
image, set Resampling to Bicubic and 
averaging (or Linear and averaging). 

6.	 Click OK to apply your changes or 
Cancel to leave the image unchanged. 
When you change the size of an image, 
the image on your screen and the rulers 
will re-scale to reflect the change.

7.	 Click Add to Project Sketchbook to save 
the new image.

NOTE
Typically, you do not want to increase the size 
of images past what their resolution and size 
will allow because the quality of the picture will 
degrade. We recommend a resolution of 150-200 
dpi when printing an image on printable fabric.

Step 4

Step 5

Step 6

DELETING AN IMAGE
To clear the Image Worktable, so you can work 
on a new image, follow these steps. Delete 
Image will not remove a saved image from the 
Sketchbook. However, if you have not saved 
the image previously, the image will be lost. 
Add to Project Sketchbook if you’re not sure. 

1.	 On the Image Worktable, click the 
IMAGE tab. On the ribbon, click Edit, 
then the Delete Image option in the 
palette. You may receive a prompt 
asking if you want to delete. 

2.	 Click Yes, if you’re sure you want 
to delete the image. The image will 
disappear and the worktable will be 
blank. You can click No, and you’ll 
remain on the Image Worktable with 
that image on the screen.

Increasing the size of a small image may 
make it blurry. Decreasing the size of an 
image may make it appear slightly sharper.

Doubling this photo’s size has created a 
blurry image.

Step 1

Step 2
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SCALING FABRIC
A new feature in EQ8 is the Scale Fabric tool. 
You will not need this for fabrics already in 
EQ8, as all the fabrics that are built into the 
software are already scaled properly. Instead, 
you can use it when you import fabrics you’ve 
taken a photo of, or saved from a website. For 
example, if the fabric has flowers that are 1” 
wide, but the flowers are only ½” wide when 
you import the image, you can use this feature 
to adjust the fabric.

1.	 With the image on the Image 
Worktable, click the IMAGE tab. On the 
ribbon, click Edit, then the Scale Fabric 
option in the toolbox. You will see the 
FABRIC SCALING palette.

2.	 Measure the actual fabric with a ruler. 
Compare to the rulers on the screen.

3.	 Enter the correct size for the fabric 
in the palette. Using the arrows 
will change the size in quarter-inch 
increments. Or you can double-click on 
0.000 and type a number.

4.	 Click the Apply Scale button. You will 
see the image and rulers change.

5.	 (Optional) Now that the fabric is scaled 
to the right size, you can use the Crop 
tool to crop the fabric image to the 
repeat. See page 180.

6.	 Click Add as Fabric to save the new 
image to the Fabrics section of the 
Sketchbook. You may need to use 
the vertical scrollbar to find the Add 
as Fabric button below the FABRIC 
SCALING palette. See page 181.

7.	 (Optional) If you would also like this 
newly scaled fabric image to appear in 
the Photos section of the Sketchbook, 
click the Add to Project Sketchbook 
button.

IMAGE tab

Edit

Step 1

Step 2
When measuring the actual fabric (top), three polka dots are 4” wide. 

But the rulers on the screen show this same section of fabric as only 3 3/8” wide.  
This means the fabric image is not true to scale.

Step 3 Step 4

After applying the scale, the rulers on screen now 
show that the three polka dots are 4” wide.

Step 6
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STRAIGHTENING, FLIPPING, ROTATING, OR SHEARING AN IMAGE
1.	 With the image on the Image 

Worktable, click the IMAGE tab. On 
the ribbon, click Edit, then the Rotate 
tool in the palette. You will see many 
ROTATE & SHEAR OPTIONS.

Straightening an Image
This new tool is extremely helpful when 
you’ve scanned a fabric, particularly with 
a stripe or design in a column or row. Use 
the design printed on the fabric to help you 
straighten it. See the EQ8 Online Support site 
for more examples of when this tool is useful.

2.	 Click the Straighten tool. Your cursor 
will change to a crosshair.

3.	 Click, hold, and drag your cursor on 
the fabric to draw a line. This line will 
determine the angle that the fabric is 
adjusted to make the design straight. 
In other words, draw the line next 
to something that should be straight 
(vertically or horizontally) on the fabric.

NOTES
The line does not have to be the entire length or 
width of the image. 
 
If you don’t like the line you’ve drawn, you can just 
draw it again (no need to erase or undo). 

4.	 When you are happy with your line, 
click Apply Straighten. EQ will adjust 
the image so that the line is perfectly 
horizontal or vertical.

5.	 (Recommended) Use the Crop tool to 
get rid of the solid background added 
after straightening. See page 180.

6.	 Click Add as Fabric to make the 
straightened fabric image appear 
in the Fabrics section of the Project 
Sketchbook. See page 181.

IMAGE tab

Edit

Step 1

After Apply Straighten, the pink triangles are vertically straight. You can now 
use the Crop tool to get rid of the background and then Add as Fabric.

Step 2

Step 3 – Draw a line on the fabric.  
This line was drawn following the alignment 
of the solid pink triangles so that they will be 

vertically straight after applying.

Step 4

Zoomed in view

Step 6
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Flipping an Image
Your image must be asymmetrical in order to 
notice any changes when flipping or rotating.

2.	 Click the Flip Horizontally tool to flip 
the image from left to right. 

3.	 Click the Flip Vertically tool to flip the 
image from top to bottom. 

Rotating an Image 
There are 2 ways to rotate the image; a simple 
90 degree rotation or by specific degree.

2.	 Click the Rotate 90 tool to rotate the 
image clockwise 90 degrees with each 
click.

3.	 Click the Rotate -90 tool to rotate the 
image counter-clockwise 90 degrees 
with each click.

4.	 (Optional) Prior to the exact-degree 
rotation, you can change the color 
of the background canvas. Click the 
Change Color button for the Create a 
Color box to appear. Select the hue and 
adjust the Saturation and Lightness 
sliders. When you are happy with the 
selected canvas color shown in the 
bottom rectangle, click OK.

5.	 Double-click the number next to 
Rotation (-360 to 360) and type a new 
number.

6.	 (Optional) Leave the Crop image after 
rotation box unchecked if you want 
to see all four corners of your image 
inside the rotation. Check this option 
if you want your image to rotate inside 
its current dimensions and cut off 
the portions that fall outside those 
dimensions. 

7.	 Click the Apply button to rotate. (You 
may have to click the Fit in Window 
tool to reposition the image on the 
worktable.)

8.	 (Optional) You can repeat steps 5-7 as 
many times as you’d like.

Original Image

Step 4
Select hue by dragging yellow #1 

around the color wheel

Adjust 
sliders

Selected color appears here. 
Make adjustments above until 
you are happy with the color.

Step 5Step 6 Step 7

Crop image after rotation 
unchecked

Crop image after rotation 
checked
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CROPPING AN IMAGE
You can use this tool to cut out unneeded 
portions of an image.

1.	 With the image on the Image 
Worktable, click the IMAGE tab. On the 
ribbon, click Edit, then the Crop option 
in the palette. The image worktable will 
have a dotted border with black corner 
and side handles.

2.	 To crop by sight, position your cursor 
over one of the corner or side handles 
and drag it to a new location. The 
portions that will be cut out will show 
as a transparency. 
 
To crop precisely to a custom size, type 
in X- and Y-axis numbers for where you 
want the top-left corner of the crop box 
to start and Width and Height numbers 
for how large you want the box to 
be. (All numbers can be changed by 
double-clicking on the existing numbers 
and typing, or using the arrows.) 
 

Shearing an Image
You can shear the image horizontally, 
vertically, or both.

2.	 (Optional) Prior to shearing, you can 
change the color of the background 
canvas. Click the Change Color 
button for the Create a Color box to 
appear. Select the hue and adjust the 
Saturation and Lightness sliders. When 
you are happy with the selected canvas 
color shown in the bottom rectangle, 
click OK.

3.	 Double-click on either the Shear 
horizontally or Shear vertically boxes 
and type new numbers (between -45 to 
45).

4.	 Click the Apply button to sheer. (You 
may have to click the Fit in Window 
tool to reposition the image on the 
worktable.)

Step 2

Step 3

Step 4

Shear horizontally

Shear vertically

Step 2 – Crop by sight
The cursor will change to a 

double-headed arrow with a crop 
icon when positioned over one of 

the crop box handles.
Step 2 – Crop precisely to custom size

Enter coordinates and sizes in the palette.

IMAGE tab

Edit

Crop
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To crop precisely to a preset size, click 
the drop-down box beside Presets and 
choose a dimension. If the choice you 
make won’t fit, click OK and choose a 
different (smaller) dimension.

3.	 Once the crop box is established, you 
can still edit it if needed. To change the 
position, click inside the crop box and 
drag it to a new position (or change the 
X- and Y-axis numbers). To change the 
size, use the handles (or change the 
Width and Height numbers).

4.	 When you are ready to crop, click the 
Apply Crop green checkmark button. 
 
If you don’t want to crop, click the blue 
Reset Crop button.

5.	 If you like the new, cropped image, click 
Add to Project Sketchbook.

WORKTABLE TOOLS
These tools appear in all palettes on the 
IMAGE tab of the Image Worktable (you 
may have to use the vertical scrollbar to see 
these tools). You must have an image on the 
worktable for the tools to be enabled.

View Actual Size –  Displays the image at its 
actual resolution. Large images will display 
beyond the worktable.  

Fit in Window – Resizes the image to fit the 
full size of the worktable. Use after zooming 
in, or after editing the image.

Pan – Click, hold and drag to move the image 
around on the worktable. This is helpful when 
zoomed in really close. 

Add as Fabric – the images on this worktable 
are saved in the Photos section of the Project 
Sketchbook (even if they are images of fabric). 
In order to make these images into usable 
fabric to color your designs with, click this 
tool to make them save as fabric. (You will 
find them in the Fabrics section of the Project 
Sketchbook.)

Step 2

Crop precisely to preset size
Click the drop-down arrow and choose a size.

Step 5

Step 4

Depending on which 
palette is open, you may 
need to use the scrollbar 

to see the Worktable Tools.

The Worktable Tools are available 
in all palettes of the IMAGE tab.

NOTE
If you import an image of a fabric on the Image Worktable and click the Add to 
Project Sketchbook button, rather than the Add as Fabric tool, the fabric image 
will appear in the Photos section of the Sketchbook. 

You can copy a fabric image from the Photos section of the Sketchbook to the 
Fabrics section. Click the View Project Sketchbook button > Photos section. Select 
the fabric image and click the Copy to Fabrics button in the Sketchbook. 
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COLORING AN IMAGE
You can adjust the colors in an image in creative ways using these various tools. Each feature will give you different results and 
may work better on one image than another. As always, it’s a good idea to save the original image in the Project Sketchbook 
before you start changing colors (just in case you don’t like the result, and also to have a copy of the original image). 

Color Options
Color Balance – adjusts color levels in the 
image and makes dark pixels darker and light 
pixels lighter. Auto adjust may be enough 
without needing to use the sliders. 
 
Red/Green/Blue – adjusts red, green, and 
blue in an image to add color casts or remove 
them. Leave a number set to 0 if you don’t 
want the value to change. 
 
Hue/Sat/Light – adjusts the color, intensity of 
color, and lightness of color in an image. Leave 
a number set to 0 if you don’t want the value 
to change. 
 
Colorize – creates a two-color image based 
on the chosen color and its intensity. When 
saturation is low, the image looks like a subtly 
colored black and white photo. 
 
Color Accent – select a hue or range of hues 
to emphasize or isolate while minimizing the 
hues in the rest of the image. 
 
Hue Map – replaces specific hues (colors) 
in your image. See page 184 for more 
information. 
 
Channel Mixer – adjusts how much each of 
the three color channels (red, green, and blue) 
contribute to the final image. 
 
Create Colorway – swaps all colors in the 
image for a new set of colors based off 
palettes of color. See page 185 for more 
information.

Color Accent used to highlight purple umbrella

Before After

Colorize used to create 
a sepia-tone image

Before

After
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Using the Color Options
1.	 With the image on the Image 

Worktable, click the IMAGE tab. On the 
ribbon, click Color. 

2.	 In the ADJUST IMAGE COLOR palette, 
choose one of the color options. See 
descriptions on page 182.

3.	 If you are using the Channel Mixer 
option, click the down arrow on the box 
next to Output channel to select the 
Red, Green, or Blue channel.

4.	 Use the sliders to adjust the image (and 
where applicable, you can double-click 
on a number and type a new number). 

5.	 Click Help at any time on a tool box 
to learn more about the specific way 
settings affect the image. Close the 
Help before continuing.

6.	 Click Preview to see the “After” image 
temporarily on your worktable for a 
closer view. (Hue/Sat/Light doesn’t 
have a Preview button because it shows 
you automatically as you adjust the 
sliders.)  

7.	 Click Add to Project Sketchbook to 
save the new image in the Project 
Sketchbook and put it on the 
worktable.  
 
Click Close if you do not wish to keep 
your changes, or you want to go back to 
the worktable.

NOTES
Before adjusting any image, pay attention to the 
starting numbers in case you want to switch back 
to them. Or, click Close to discard your changes and 
repeat step 2 to choose the same tool again, but 
use different values/numbers.

You can also Increase or Decrease Color Depth, see 
page 196.

Step 3

Step 4

Step 5Step 6Step 7

Step 2

Step 1
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USING THE HUE MAP
The Hue Map replaces specific hues (or colors) 
in your image. 

1.	 With the image on the Image 
Worktable, click the IMAGE tab. On the 
ribbon, click Color, then the Hue Map 
option in the palette.

2.	 Select which color you want to change 
by clicking on a wedge in the outer 
color wheel or moving the small dot 
around the outside of the color wheel. 
(You have 12 choices, each representing 
a 30 degree range.) The selected color 
range will appear as a color chip and 
set of numbers at the top of the vertical 
slider.

3.	 The vertical slider bar starts at the top 
by default. Drag the slider down to 
adjust the hue/color. The new value will 
appear as a color chip and one number 
at the bottom of the vertical slider. The 
“After” image and inner color wheel 
will update to reflect the change. 

4.	 You can repeat steps 2-3 to change 
other colors on the color wheel. (See 
Note.)

5.	 Saturation shift affects the entire 
image. Leave this number set to 0 if 
you don’t want the value to change. 
Negative numbers will desaturate or 
gray out the image. Positive numbers 
will oversaturate the image.

6.	 Lightness shift affects the entire image. 
Leave this number set to 0 if you don’t 
want the value to change. Negative 
numbers will darken the image. Positive 
numbers will lighten the image.

7.	 Click Help at any time to learn more 
about the way specific settings affect 
the image. Close the Help before 
continuing.

8.	 Click Preview to see the “After” image 
temporarily on your worktable for a 
closer view.

IMAGE tab

Color

Step 1

Step 2

Step 3

Step 5 Step 6

Step 7Step 8Step 9
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9.	 Click Add to Sketchbook to save the 
new image in the project and put it on 
the worktable.  
 
Click Close if you do not wish to keep 
your changes.

NOTES
Each time you click Add to Project Sketchbook 
the image is saved in its current condition and 
put on the worktable, but the Hue Map window 
does not close. Use this to your advantage to save 
intermediary images in the Sketchbook and reset 
the controls to their starting point, especially if you 
are unsure about which colors to change.

If you want to undo one of your color changes 
represented on the color wheel, select that color, 
and drag the slider bar back to the top of the 
vertical bar.

If you don’t see much of a difference in the After 
box after following steps 2-3, it may be that the 
selected color isn’t used much in the image.

Before

After

Using the Hue Map, we changed 
the flower from pink to blue.

CREATING YOUR OWN 
COLORWAY
This tool swaps all colors in the image for a 
new set of colors based off palettes of color.

You may want to check out the histogram to 
understand better how this works. Spikes in 
the histogram determine whether your image 
is a 1-, 2-, 3-, or 4-color image. For more info 
about the Histogram, see page 187.

1.	 With the image on the Image 
Worktable, click the IMAGE tab. On 
the ribbon, click Color, then the Create 
Colorway option in the palette. The 
Create Colorway box will appear with 
Before and After images. It will also tell 
you what type of color image it is (it can 
be 1-4).

NOTE
Images must have a color depth of 24 bits to use 
this tool. If your image is not the right depth, EQ8 
will display a box asking to automatically convert it 
for you. Click OK.

IMAGE tab

Color

Step 1
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2.	 Click one of the top three buttons on 
the left to pick your palette: 
 
Select from ready-made palettes – 
Click one of the available color wheels 
at the bottom to update the twelve 
palettes at the top. Adjust Saturation 
or Lightness with the sliders, if needed. 
Click one of the twelve palettes at the 
top to choose that palette. Click OK. 
 
Create a custom palette – Drag the 
yellow numbers to new positions 
around the outside of the color wheel 
to pick custom colors. Adjust Saturation 
or Lightness with the sliders, if needed. 
Your new colors will appear at the 
bottom. Click OK. 
 
Click to create random palettes – Click 
this button repeatedly to see different 
computer-generated options.

3.	 Click the Rearrange/Shift button to 
keep the current palette, but switch 
which colors in the image get which 
colors from the new palette.

4.	 Click Help at any time to learn more 
about the way specific settings affect 
the image. Close the Help before 
continuing.

5.	 Click Preview to see the After image 
temporarily on your worktable for a 
closer view.

6.	 Click Add to Sketchbook to save the 
new image in the project and put it on 
the worktable. 
 
Click Close if you do not wish to keep 
your changes.

NOTE
The number of spikes in the histogram (see page 
187) may change as you use this tool. Pixels may 
be averaged together. You could start out with a 
3-color image, go to 2-color, and back to 3-color, 
using it repeatedly. Typically, a 1-color image will 
stay a 1-color image (unless you use Hue Map, page 
184, or something else to create more spikes).

Step 3

Step 5Step 6 Step 4

Ready-made palettes

Custom palettes

Step 2

Step 2 (left) – 
Select from ready-made palettes

Step 2 (right) – Create a custom palette 
The number of yellow circles you see here  

depends on the number of colors in your image.

Random palettes
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USING AND VIEWING 
THE HISTOGRAM
A histogram is a graph that provides useful 
information on lighting, contrast, pixel values, 
and saturation. It goes from dark (left) to 
light (right) and shows the number of pixels 
in the photo at each value as height on 
the graph. Some digital cameras show you 
this information, too, which can help you 
fix your shot before taking a picture that is 
underexposed or overexposed.

Viewing the Histogram
To view the Histogram you must have an 
image on the Image Worktable.

1.	 With the image on the Image 
Worktable, click Image on the menu 
bar, point to Histogram, then click 
Histogram in the side menu. The 
Histogram box will appear.

2.	 Use the checkboxes to determine which 
values you want to display.

3.	 Close this window by clicking the X in 
the top-right corner when you’re done 
viewing the information.

Equalizing and Adjusting 
the Histogram
For either of the following options you must 
have an image on the Image Worktable.

1.	 With the image on the Image 
Worktable, click the IMAGE tab. On the 
ribbon, click Histogram. The ADJUST 
IMAGE HISTOGRAM palette will appear.

Equalizing the Histogram
This option spreads out the spikes in the 
histogram for you automatically.

2.	 Click the Equalize button. The Equalize 
Histogram box will appear.

Step 1

Step 3

Step 2

Step 1

Step 2
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3.	 Choose the color space: 
RGB space – does each channel (red, 
green, blue) separately. 
 
YUV space – (recommended) 
incorporates human perception of 
luminance. 
 
Grayscale – equalizes according to gray 
levels.

4.	 Click OK to equalize the histogram. Click 
Cancel to make no changes.

5.	 If you don’t like the changes, click the 
Undo button on the left vertical toolbar. 
If you do like the changes, click Add to 
Project Sketchbook.

Adjusting the Histogram 
This option allows you to control the 
histogram adjustments.

2.	 Click the Adjust button. 

3.	 Use the Glow, Lighten, Warm, or Pastel 
buttons to see artistic presets. Click the 
Reset to default button if you want to 
try it on your own.

4.	 Make adjustments to the available 
settings. Click the Help button for 
detailed information on these settings.

5.	 Click Add to Sketchbook to save the 
new image in the project and put it on 
the worktable. 

6.	 Click Close if you do not wish to keep 
your changes or you want to return to 
the worktable.

NOTES
As you make adjustments, you will see a second 
histogram (gray = before, pink = after).

Click Preview at any time to see the After image on 
your worktable temporarily. Your original worktable 
image will come back once you move the controls 
again.

Step 2

Step 3

Step 4

Step 5
Undo

Step 5
Add to Project 

Sketchbook

Step 3

Step 4Step 5 Step 6
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CHANGING 
BRIGHTNESS OR 
CONTRAST
If an image is too dark or too light, you can 
use the Bright/Contrast option to adjust it. 

1.	 With the image on the Image 
Worktable, click the IMAGE tab. On 
the ribbon, click Histogram, then the 
Bright/Contrast option in the palette. 
The Brightness/Contrast box will 
appear.

2.	 Drag the triangles on the Brightness 
and Contrast sliders to adjust the 
image. See Notes below.

3.	 Click Preview to see the After image 
temporarily on your worktable for a 
closer view.

4.	 Click Add to Sketchbook to save the 
new image in the project and put it on 
the worktable. You can then repeat step 
2 to create different colorings for your 
image.

5.	 Click Close if you do not wish to keep 
your changes or you want to return to 
the worktable.

NOTES
Brightness: 
Drag the Brightness slider to the right to increase 
brightness to the point of making the image white.

Drag the Brightness slider to the left to decrease 
brightness to the point of making the image black.

Leave this number set to 0 if you don’t want it to 
change. (Range -100 to 100)

Contrast: 
Drag the Contrast slider to the right to increase 
contrast or the saturation/intensity of the image.

Drag the Contrast slider to the left to decrease the 
contrast and give the image a gray, dull-looking 
cast.

Leave this number set to 0 if you don’t want it to 
change. (Range -100 to 100)

IMAGE tab

Histogram

Step 1

Step 2

Step 3Step 4 Step 5
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USING SPECIAL EFFECTS FOR AN IMAGE
You can create countless variations for your images using the Special Effects options. To use any of these effects, you must 
start with an image on the Image Worktable, and make sure it’s saved to the Project Sketchbook (Add to Project Sketchbook) 
before you start creating new images. Since there are so many variations, it’s impossible to describe them all, so be sure to use 
the Help buttons to see illustrated color examples of how each control affects the image. If you are using large images, please 
be patient while EQ8 does the rendering.

Applying Effects to an 
Image

1.	 With the image on the Image 
Worktable, click the IMAGE tab. On the 
ribbon, click Special Effects, then the 
Effects option in the palette. The Apply 
Effects box will appear with your image 
displayed.

2.	 From the top menu in this box, choose 
the type of effect, then choose the 
name of the effect. (For example, 
choose Pixelate > Roman Mosaic.)

3.	 A Samples window may appear 
showing you four examples of the 
desired effect. Click on one of the four 
examples to choose it or click on the X 
in the top-right corner to close it.

NOTE
If you put a check next to Turn off Auto-samples 
dialog, the Samples window will not automatically 
appear. You can see the window and its examples 
by clicking the Click to select from auto-samples 
button. If you want to always show the window 
again, uncheck Turn off Auto-samples dialog.

4.	 Each effect has different controls. 
Where applicable, move the sliders, 
change the drop-down boxes, and drag 
the red bull’s eye around on the image 
for different looks.

Step 2

IMAGE tab

Step 1

Special Effects

Step 3
Choose a sample or close the window.

Auto-samples
checkbox

(See Note)
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5.	 If you don’t know which settings you 
want to use, try clicking the Generate 
random samples button (the dice cube).

6.	 Click Preview to see the “After” image 
temporarily on your worktable for a 
closer view.

7.	 Repeat steps 2-6 to continue to change 
the different controls until you find an 
effect you like (these changes will be 
made to the original image, until you 
add it to the Project Sketchbook). 

8.	 Click Add to Sketchbook to save any 
new images in the project and put it on 
the worktable. With this new, affected 
image, you can again repeat steps 2-6. 
Or, click Close to discard any changes.

9.	 The Apply Effects window will remain 
open until you are done and click Close.

NOTE
To return to the original image and start adding 
special effects to it again, you will need to select 
and edit it from the Project Sketchbook. (You 
cannot Undo the special effects.)

Applying Filters to an Image
1.	 With the image on the Image 

Worktable, click the IMAGE tab. On the 
ribbon, click Special Effects, then the 
Filters option in the palette. The Image 
Filters box will appear with your image 
displayed.

2.	 From the top menu in this box, choose 
the type of filter, then choose the name 
of the filter. (For example, choose Edge 
Detection > Brightness.)

3.	 Each filter has different controls. Where 
applicable, move the sliders and change 
the drop-down boxes.

Step 5

Step 6Step 8 Step 9

IMAGE tab

Step 1

Special Effects

Step 2
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Applying Circular 
Symmetries to an Image

1.	 With the image on the Image 
Worktable, click the IMAGE tab. On the 
ribbon, click Special Effects, then the 
Circular Symm option in the palette.

2.	 Choose your petal shape by clicking the 
first button along the top and clicking 
on a petal style in the drop-down 
menu.

3.	 Choose the number of petals by 
clicking the second button along the 
top and clicking on a number in the 
drop-down menu.

4.	 If you chose an even number of petals, 
you can choose whether or not you 
want the petals mirrored every other 
one to face each other by clicking the 
Toggle petal reflection button.

4.	 If you don’t know which settings you 
want to use, try clicking the Generate 
random samples button (the dice cube).

5.	 Click Preview to see the new image 
temporarily on your worktable for a 
closer view.

6.	 Repeat steps 2-5 to continue to change 
the different controls until you find a 
filter you like (these changes will be 
made to the original image, until you 
add it to the Project Sketchbook). 

7.	 Click Add to Sketchbook to save any 
new images in the project and put it on 
the worktable. With this new, filtered 
image, you can repeat steps 2-5. Or, 
click Close to discard any changes.

8.	 The Image Filters window will remain 
open until you are done and click Close.

NOTE
To return to the original image and start adding 
special effects to it again, you will need to select 
and edit it from the Project Sketchbook. (You 
cannot Undo the special effects.)

Step 4

Step 5Step 7 Step 8

IMAGE tab

Step 1

Special Effects

Step 2

Step 3 Step 4
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5.	 You can flip the image horizontally by 
clicking the Flip image left and right 
button.

6.	 You can flip the image vertically by 
clicking the Flip image up and down 
button.

7.	 The background of the “After” image on 
the worktable is decided by the Select 
the background color drop-down box. 
Click the drop-down arrow beside the 
background color. In the new window, 
drag the yellow #1 around the outside 
of the circle to a new position to 
determine the color. Adjust Saturation 
or Lightness with the sliders. When you 
are happy with the color at the bottom 
of the Create a Color box, click OK.

8.	 To move the petal around on the 
image, position your cursor over the 
center of the petal, click and drag the 
petal to a new location.

9.	 Resize the petal by clicking it once 
in the center to put resizing handles 
around it. Position your cursor over one 
of the corner handles, click and drag 
the handle to a new location. Click on 
the petal two more times to get out of 
“resizing-mode”.

10.	 Rotate the petal by clicking it twice in 
the center to go into “rotate-mode”. 
Position your cursor over one of the 
corner handles, click and drag the 
handle around the center to a new 
location. Click on the petal one more 
time to get out of “rotate-mode”.

11.	 Repeat steps 2-10 in any order to adjust 
your image until you like the results.

12.	 Click Add to Sketchbook to save any 
new images in the project. 

13.	 Click Close when you are done. The 
original image used to create the 
circular symmetries will appear on the 
worktable. To see your new images, 
go to the Photos section of the Project 
Sketchbook.

Select hue by dragging yellow #1 
around the color wheel

Adjust 
sliders

Selected color appears here. 
Make adjustments above until 
you are happy with the color.

Step 5 Step 6

Step 7

NOTE
You can move the petal while it’s 
in Resize or Rotate mode, as long 
as your cursor is over the center.

Step 8
Move the petal.

Step 9
Click the petal once to enter resize-mode.

Step 10
Click the petal twice to enter rotate-mode.

Step 12 Step 13

Example of Circular Symmetries results
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Applying Square 
Symmetries to an Image

1.	 With the image on the Image 
Worktable, click the IMAGE tab. On 
the ribbon, click Special Effects, then 
the Square Symm option in the palette. 
The Square Symmetries box will appear 
with your image displayed.

2.	 Choose your symmetry style by clicking 
the first button along the top and 
clicking on a style in the drop-down 
menu.

3.	 Choose the number of repeats by 
clicking the second button along the 
top and clicking on a grid size in the 
drop-down menu.

4.	 You can flip the image horizontally by 
clicking the Flip image left and right 
button.

5.	 You can flip the image vertically by 
clicking the Flip image up and down 
button.

6.	 If you drag the square in the Square 
Symmetries window beyond the edges 
of the original image, you will want to 
adjust the background color. Click the 
drop-down arrow beside the Select the 
background color button. In the new 
window, drag the yellow #1 around 
the outside of the circle to a new 
position to determine the color. Adjust 
Saturation or Lightness with the sliders. 
When you are happy with the color at 
the bottom of the Create a Color box, 
click OK.

IMAGE tab

Step 1

Special Effects

Select hue by dragging yellow #1 
around the color wheel

Adjust 
sliders

Selected color appears here. 
Make adjustments above until 
you are happy with the color.

Step 2

Step 3

Step 4 Step 5

Step 6
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7.	 To move the square around on the 
image, position your cursor over the 
center of the square, click and drag the 
square to a new location.

8.	 Resize the square by clicking it once 
in the center to put resizing handles 
around it. Position your cursor over one 
of the corner handles, click and drag 
the handle to a new location. Click on 
the square two more times to get out 
of “resizing-mode”.

9.	 Rotate the square by clicking it twice 
in the center to go into “rotate-mode”. 
Position your cursor over one of the 
corner handles, click and drag the 
handle around the center to a new 
location. Click on the square one more 
time to get out of “rotate-mode”.

NOTE
You can move the square while it’s in Resize or 
Rotate mode, as long as your cursor is over the 
center.

10.	 Repeat steps 2-9 in any order to adjust 
your image until you are pleased with 
the results.

11.	 Click Add to Sketchbook to save any 
new images in the project. 

12.	 Click Close when you are done. The 
original image used to create the 
square symmetries will appear on the 
worktable. To see your new images, 
go to the Photos section of the Project 
Sketchbook.

Step 7
Move the square.

Step 8
Click the square once to enter resize-mode.

Step 9
Click the square twice to enter rotate-mode.

Step 11 Step 12

Project Sketchbook > Photos section

Original image

New square 
symmetries image

Example of Square Symmetries results
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INCREASING OR 
DECREASING COLOR 
DEPTH
Use this feature to simplify images. You can 
do this for artistic reasons or for tracing. Start 
with an image edited or imported to the 
Image worktable.

1.	 With the image on the Image 
Worktable, click Image on the menu 
bar, then click Increase/Decrease Color 
Depth. A window will appear.

NOTE
The current bit depth of the image is the first 
number in the window.

2.	 Under Increase or decrease to, click the 
down arrow to drop-down your list of 
choices. Change to a different number.

3.	 If you choose 1, 4, or 8, you can also 
choose a palette, dithering method and 
other options.

4.	 Click OK.

5.	 The image on the worktable will update 
and reflect your choices. Click Add to 
Project Sketchbook if you want to keep 
these changes. Or, click Undo if you 
want to switch back to the previous 
image.

NOTES
Many effects and filters require 24 bit or higher 
images. If you do not increase the color depth 
yourself, the program will prompt you before 
allowing you to continue with the effect or filter.

You will not notice a difference in the image if you 
increase the color depth.

Step 1

Step 2

Step 3

Step 4

Step 5
Add to Project 

Sketchbook

Step 5
Undo

OR
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CHAPTER 8
Libraries

EQ8 comes with six separate library types containing over 20,000 quilting items, including blocks, fabrics, threads, layouts, 

and more, all to be used and reused as you design. You can also create your own libraries for blocks you’ve drawn, fabrics 

you’ve scanned or photos you’ve imported, making them all handy to use in any project. This chapter shows you how to 

use the library and save your own items in your own “My Favorite” Library.

8
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ABOUT THE LIBRARIES
EQ8 has six libraries: Block, Fabric, Layout, Embroidery, Photo, and Thread. The steps below work for any library.

Step 1

Sections

Categories

Styles

1.	 Click Libraries from the menu bar, then 
Your Choice. The library opens with 
items displayed. The first section is the 
EQ Library which holds that particular 
library’s respective blocks, fabrics, 
layouts, embroidery, photos, and 
threads that come with EQ8.

Seeing More Categories 
and Styles

2.	 Items are organized into categories. 
Beside the list of names drag the 
vertical scrollbar down to see the 
different categories (except in the Photo 
Library because there are only 4). For 
example, if you are in the Block Library 
the categories are: 01 Classic Pieced,  
02 Contemporary Pieced, etc.

3.	 Each category has styles. Click the 
plus sign next to any category name 
to see its styles. For example, in the 
Block Library if you are in 04 Classical 
Applique you would see the styles 
Baskets, Birds, Butterflies, etc.

4.	 Click any name to see items in the style.

Seeing More Items in a 
Style

5.	 The number of items in each style is 
shown at the lower-right beside the 
horizontal scrollbar. If the style contains 
57 items, but you only see 9, you need 
to scroll. Drag the horizontal scrollbar 
beneath the items to the right to see 
more items within that style.

6.	 You can also change the number of 
items that display at one time. On the 
left below the horizontal scrollbar you 
will see a series of display buttons. 
Click a button with a larger square to 
see fewer items, or one with a smaller 
square to see more items. 

NOTE
Changing the number of items displayed is a nice feature when viewing complex 
items. You can click a button with a larger square to “zoom in” closer to see an 
item’s detail.

Step 2

Step 3

Step 4

Number of 
items in style

Step 6 Step 5
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About the Rest of the Buttons
Each Library has five sections (except the Thread Library, which only has four):

EQ Library – These items come with EQ8 and are always the same. You cannot “use up,” 
delete, add to, or change items in this section.

My Favorite Library – There are no items here until you add them. You can create your own 
library category with your favorite or most frequently used items by saving them here.

Current Sketchbook – This area shows what is in your current project’s Sketchbook for that 
item type. For example, in the Block Library the Current Sketchbook section shows blocks you’ve added to the Sketchbook. In 
the Fabric Library the Current Sketchbook section shows fabrics you’ve added to the Sketchbook.

Search Results – When you search, the results will show here.

Import Results – When you import, your imported items will show here. (You cannot import thread to the library.)
Add items to the Sketchbook. Once 

they’re in the Sketchbook you can use 
them for designing. See pages 200.

Change the number 
of items displayed.

Import items from 
other EQ projects, or 

from outside files. See 
pages 207-209.

Search for items 
in the Library. See 

pages 201-204.

 Name items you are saving, 
and keep design notes about 

the items (the notecard is 
visible in the EQ Libraries, but 
you cannot edit them there).

Select all the 
items in a 

section at once.

Close the 
library.

Block Library only
The coloring arrows 

let you view the other 
colorings “stacked” on 
a block. See page 109.

Block, Photo, and Layout Libraries only
Adds the selected item to the Sketchbook 

and places it on the appropriate worktable.

These buttons will be enabled when you have the appropriate item(s) and section selected: 
Create Library – Create libraries with the items you like and use most in the My Favorite 
Libraries sections. 
Link Library – Link to library files in different EQ programs or from other users. See page 206. 
Cut and Copy – Cut or Copy an item you want to paste into My Favorite Library. 
Paste – Paste a cut or copied item into your My Favorite Library. See page 211. 
Delete – Delete an item (available in all sections except EQ Library). See page 212. 
Sort – Sort items in your desired order (available in all sections except EQ Library). 
Save Library – Save items or changes to your My Favorite Library. See page 211.
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USING ITEMS FROM THE LIBRARY
To design with anything from a library, you must first add it to your Sketchbook.

Finding and Selecting Items
1.	 Click Libraries from the menu bar, then 

Your Choice. Example: if you need a 
block, open the Block Library.

2.	 Click the library section you want items 
from.

3.	 If you choose EQ Library or My Favorite 
Library, click the category, then click 
the style you want to see.

4.	 Click the item you want to use. It will 
have a blue outline, indicating it is 
selected.

5.	 (Optional) To select multiple items, use 
keyboard shortcuts: 
 
Hold down the CTRL key (Command 
key) and click on each individual item 
you want to select.  
 
Hold down the Shift key as you click to 
select a range of items (entire rows or 
columns). 
 
Click the Select All button to select 
every item in the style.

Adding to your Sketchbook
6.	 Click the Add to Sketchbook button. 

The selected item “disappears” 
temporarily, showing you’ve added the 
item to your Sketchbook.

7.	 Click Close to return to the worktable.

Step 1

EQ Library – These items come with EQ8 and are 
always the same. 
 
My Favorite Library – This is empty until you add 
items. Use this section for original block designs, 
scanned fabrics or photos, imported embroidery 
designs, and to organize your favorite items 
(which can include items that came with EQ8). 
 
Current Sketchbook – Shows what is in your 
current project’s Sketchbook for that item type. 
 
Search Results – When you search, the search 
results will show here. 
 
Import Results – When you import, the 
imported items will show here (not available in 
the Thread Library).

Step 2

Category

Style

Step 4 Step 5 Step 6

Step 7
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Step 1

NOTES
You will see more results if you check all 3 fields (Name, Reference, and Notes). 
Or, if you type part of the name instead of the full name. For instance, search for 
“ohio” instead of “ohio star.”

If you are searching for blocks and have BlockBase installed, be sure to put a 
check next to Notes. BlockBase names are numbers. The earliest known name for 
the block (not all names) is in the BlockBase Notes. 

Order is important. You will get different results if you type in “Sue Sunbonnet” 
instead of “Sunbonnet Sue.”

SEARCHING FOR ITEMS 
BY NOTECARD
To search in the Thread Library, see page 204.

1.	 Open the library in which you want to 
search. (Click Libraries from the menu 
bar, then Your Choice.)

2.	 Click the Search button. If given two 
choices, choose By Notecard.

3.	 Put checks next to the fields you want 
to search (Name, Reference, and 
Notes).

4.	 In Find at most _____ items enter a 
number between 1 and 999. (Default =  
50.)

5.	 In the box at the top marked Find all 
blocks with this notecard text, type the 
word or words you want to search by.

6.	 Click the Search button. After the 
progress bar disappears and the results 
appear, click OK. You will now be 
viewing the Search Results section of 
the Library.

7.	 Drag the horizontal scrollbar beneath 
the items to see all the search results 
if they are not all visible. (You can also 
click on the number of items buttons to 
change how many items you see.)

8.	 If you want to use an item from the 
search, click directly on it to select it. 
Click Add to Sketchbook. The item will 
temporarily “disappear” to show it has 
been added to the Sketchbook. You can 
add as few or as many (you can use the 
Select All button) items as you want.

9.	 Click Search >> By Notecard again to do 
a new search or click Close to return to 
the worktable.

Step 2

Step 4

Step 5

Step 3

Step 6

Step 7 Step 9

Step 8

Step 6
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SEARCHING FOR BLOCKS BY CATEGORY
Each block in the Block Library is marked according to predetermined categories. These categories are grouped into sections: 
Difficulty & Piecing Info, Holiday, Events, Pieced, and Applique.

1.	 Click Libraries from the menu bar, then 
Block Library.

2.	 Click Search >> By Category.

3.	 Click any section to view the categories.

4.	 Click the image next to a category name 
to add the category to the search. You 
can add more than one category. You 
will know you’ve selected the category 
because it will change from a grayscale 
to multicolored square and will also 
appear at the bottom of the Block 
Category Search window, no matter 
which category you’re viewing. If you 
wish to remove a category, click the 
image next to the category name again, 
to deselect it and it will return to the 
grayscale image.

5.	 In Find at most _____ blocks enter a 
number between 1 and 999.  
(Default = 50.)

6.	 Click the Search button, then OK. You 
will now be viewing the Search Results 
section.

7.	 Drag the horizontal scrollbar beneath 
the items to see all the search results 
if they are not all visible. (You can also 
click on the number of items buttons to 
change how many items you see.)

8.	 If you want to use a block from the 
search, click directly on it to select it. 
Click Add to Sketchbook. The item will 
temporarily “disappear” to show it has 
been added to the Sketchbook. You can 
add as few or as many (you can use the 
Select All button) items as you want.

9.	 Click Search >> By Category again to do 
a new search or click Close to return to 
the worktable.

Step 1 Step 2

Step 3

Selected categories 
appear here

Step 6

Step 5Step 4

Step 6

Step 7 Step 9

Step 8
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NOTES
The blocks that appear in the Search Results must 
fit into all the categories chosen. You can add up to 
20 categories (any combination from all 5 sections), 
but your results will be fewer and fewer the more 
you add.

If you want to save the search results, consider 
copying and pasting these bocks into their own 
style in My Favorite Blocks, see page 210. For 
instance, if you are a beginning quilter and would 
like to stick to “Triangles and Rectangles,” Copy, 
Paste, and Save Library for those results into a new 
library. Then go to that My Favorite Blocks library 
page each time you need a block for a new project.

SEARCHING FOR 
FABRICS BY COLOR

1.	 Click Libraries from the menu bar, then 
Fabric Library.

2.	 Click to select any fabric (perhaps one 
you want to match in color) from any 
section (EQ Fabric Library, My Favorite 
Fabrics, etc.). You must have a fabric 
selected to proceed.

3.	 Click Search >> By Color.

4.	 To change the search color, click 
the down arrow next to the solid 
color rectangle to show your Project 
Sketchbook colors. Drag the horizontal 
scrollbar to see them all, then click your 
new color choice.

5.	 In the top right you will see a list of 
fabric libraries linked to EQ8. You can 
check one or more to search. The more 
libraries you have checked, the longer 
the search will take.

6.	 In Find at most _____ fabrics, enter a 
number between 1 and 999. (Default 
= 50.) A higher number returns more 
results, but takes more time.

7.	 Click the Search button. After the 
progress bar disappears and the results 
appear, click OK. You will now be 
viewing the Search Results section.

To see a block’s assigned 
categories, select the block in 

the library and click the Notecard 
button. Then use the Flip button 
to see the categories on the back 

of the notecard.

Flip

Notecard for Mosaic, No. 19 (shown at left)

Step 1

Step 4

Step 5

Step 6

Step 7

Step 7

Step 3
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SEARCHING FOR 
THREADS
You can search for threads by text (name or 
number) or by color.

Searching by Text
1.	 Click Libraries from the menu bar, then 

Thread Library.

2.	 Click Search >> By Text.

3.	 In the top box, type the word or words 
you want to search for in the Thread 
Library. A name, like Eggplant, or a 
number like 5633 work best.

4.	 In Find at most _____ items, enter a 
number between 1 and 999.  
(Default = 50.)

5.	 Click Search, then OK.

8.	 Drag the horizontal scrollbar beneath 
the items to see all the search results if 
they are not all visible. 

9.	 If you want to use a fabric from the 
search, click directly on it to select it. 
Click Add to Sketchbook. The item will 
temporarily “disappear” to show it has 
been added to the Sketchbook. You can 
add as few or as many (you can use the 
Select All button) items as you want.

10.	 Click Search >> By Color again to do a 
new search or click Close to return to 
the worktable.

NOTES
If you have a fabric library installed which is not 
showing up in the list of options, use the Link 
Library button. See page 206. 

To see the “average color” for any fabric, click the 
Show average color checkbox in the bottom right 
under the fabrics. The average color will appear as 
a small square in the top-left corner of each fabric. 
They may be hard to see if the average color is 
similar to the fabric, especially if it’s a solid-colored 
fabric.

Step 8 Step 10

Step 9

Step 1 Step 2

Step 4

Step 3

Step 5

Step 5
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Searching by Color
1.	 Click Libraries from the menu bar, then 

Thread Library.

2.	 Click to select any thread (perhaps one 
you want to match in color) from any 
section (EQ Thread Library, My Favorite 
Thread, etc.). You must have a thread 
selected to proceed.

3.	 Click Search >> By Color.

4.	 To change the search color, click the 
down arrow next to the solid color 
rectangle to show your Sketchbook 
colors. Drag the horizontal scrollbar to 
see them all, then click your new color 
choice.

5.	 In Find at most _____ items, enter a 
number between 1 and 999.  
(Default = 50.)

6.	 Click Search, then OK.

7.	 If you want to use a thread from the 
search, click directly on it to select it. 
Click Add to Sketchbook. The item will 
temporarily “disappear” to show it has 
been added to the Sketchbook. You can 
add as few or as many (you can use the 
Select All button) items as you want.

8.	 Click Search >> By Color again to do a 
new search or click Close to return to 
the worktable.

6.	 If you want to use a thread from the 
search, click directly on it to select it. 
Click Add to Sketchbook. The item will 
temporarily “disappear” to show it has 
been added to the Sketchbook. You can 
add as few or as many (you can use the 
Select All button) items as you want. 

7.	 Click Search >> By Text again to do a 
new search or click Close to return to 
the worktable.

Step 7

Step 6

Step 1 Step 3

Step 4 Step 6

Step 5

Step 6

Step 8

Step 7
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LINKING OTHER LIBRARIES
Use these steps to link other EQ software (BlockBase, Quilting Designs), personal libraries from previous versions of EQ, and 
EQ-formatted libraries from other outside sources (friends, online challenges). See the EQ8 Online Support site for more info.

1.	 Open the library of the same type you 
want to link. Click Libraries from the 
menu bar, then Your Choice. (If you 
want to link an outside fabric library, 
open the Fabric Library.)

2.	 Click the Link Library button.

3.	 Click the Auto Add button to add a 
link for any EQ software not listed. If 
the Auto Add button does not find and 
link the library, you will need to add it 
manually.

4.	 To add a library manually, click the Add 
button.

5.	 In the first box, type a name for the 
new library. This name will appear in 
the list under the Library section, so 
choose something that will help you 
identify it. Examples: Guild Member 
Blocks or Foundation Pieced Blocks, not 
Blocks.

6.	 In the second box, you need the path 
to the folder containing the library files. 
Click the Browse button to find the 
location.

7.	 Navigate to the location on your 
computer of the folder containing 
the library files. Be sure the folder is 
selected. Click OK to close the Browse 
for Folder box.

8.	 Click OK on the Add New Library Link 
box. If you chose a folder with no 
library files, the library will not be 
found and you will get a message Not 
a valid EQ library directory. Change 
the path and click OK or click Cancel to 
start over.

9.	 Click Close to return to the library. Click 
Close again to return to the worktable. 
Your library files will be available from 
the corresponding library.

NOTE
If you are having difficulty finding the files, but know they are on your computer, 
try doing a search. File extensions are: *.blk  = Block Library, *.ebr = Embroidery 
Library, *.fab = Fabric Library, *.pix = Photo Library, *.qlt = Layout Library,  
*.thd = Thread Library.

Step 1 Step 2

Step 3 Step 4

Step 6

Step 5

Step 8

Modify allows you to change 
the path (not the name) of 
an existing item in the list.

Remove allows 
you to take an 

item off the list.

Step 9
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IMPORTING FROM 
EXISTING PROJECTS
The import feature allows you to stay in the 
project you are working on and import from a 
different project’s Sketchbook with just a few 
clicks.

1.	 Open the library into which you want 
to import. Click Libraries from the 
menu bar, then Your Choice. Examples: 
If you need a group of blocks you 
drew in a different project, open the 
Block Library. If you need fabrics from 
a different project, open the Fabric 
Library.

2.	 Click the Import button. If given two 
choices, choose From Project. The 
Import box will appear.

3.	 Navigate to the correct folder for the 
project from which you need to import. 
The default location for EQ8 projects is:  
PC: Documents > My EQ8 > Projects 
MAC: Go > Home > My EQ8 > Projects

4.	 When you see the file you want to 
import from, click to select it.

5.	 Click Open. You will now be viewing the 
Import Results section of the Library. 

6.	 Drag the horizontal scrollbar beneath 
the items to see all the import results if 
they are not all visible. 

7.	 If you want to use an imported item, 
click directly on it to select it. Click 
Add to Sketchbook. The item will 
temporarily “disappear” to show it has 
been added to the Sketchbook. You can 
add as few or as many (you can use the 
Select All button) items as you want.

8.	 Click Import >> From Project again 
to import from a different existing 
project or click Close to return to the 
worktable.

Step 1

Step 2

Step 6 Step 8

Step 7

Step 5Step 4
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IMPORTING IMAGE FILES INTO THE FABRIC OR PHOTO LIBRARIES
Use these steps to import scanned fabrics for any quilt, or photos for photo-quilt projects. You can import BMP, GIF, JPG, PNG, 
or TIF files.

1.	 Open the library into which you want 
to import. Click Libraries from the 
menu bar, then Fabric Library or Photo 
Library. Example: To import scanned 
fabrics, open the Fabric Library.

2.	 Click Import >> From Image Files.

3.	 Navigate to the location on your 
computer where the image files are 
saved.

4.	 Click the image files you want to 
import. To select more than one: 
 
Hold down the CTRL key (Command 
key) and click on each individual file 
you want to select.  
 
Hold down the Shift key as you click to 
select a range of files. 
 
Click one file, then press CTRL+A 
(Command+A) to select all the files in 
this folder. 

5.	 Click Open. The Import Results display.

6.	 If you want to use an imported item, 
click directly on it to select it. Click 
Add to Sketchbook if you plan to use 
an item in a project, or click Copy 
if you plan to paste the item into a 
My Favorite Library. The item will 
temporarily “disappear” to show it has 
been added to the Sketchbook. You can 
add as few or as many (you can use the 
Select All button) items as you want.

7.	 Click Import >> From Image Files again 
to import from a different folder or click 
Close.

NOTE
To learn more about working with photos and 
fabrics, see Chapter 7.

Step 1 Step 2

Step 4
CTRL+A (Command+A) used to select 

all the files in the folder at once.

Step 5

Step 7

Step 6
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IMPORTING 
EMBROIDERY (.EXP) 
FILES
Only .EXP files can be imported.

1.	 Click Libraries from the menu bar, then 
Embroidery Library.

2.	 Click Import >> From .EXP Files.

3.	 Navigate to the location on your 
computer where the image files 
containing your .EXP files are saved. 
Having the related .RGB files is optional. 
If you have the .RGB files, they should 
be saved in the same folder as the .EXP 
files, but you will not see them listed in 
the Import window.

4.	 Click the .EXP files you want to import. 
To select more than one: 
 
Hold down the CTRL key (Command 
key) and click on each individual file 
you want to select. 
 
Hold down the Shift key as you click to 
select a range of files. 
 
Click one file, then press CTRL+A 
(Command+A) to select all the files in 
this folder.

5.	 Click Open. You will now see the Import 
Results section of the Library.

6.	 If you want to use an imported 
embroidery design, click directly on it 
to select it. Click Add to Sketchbook. 
The item will temporarily “disappear” 
to show it has been added to the 
Sketchbook. You can add as few or 
as many (you can use the Select All 
button) items as you want.

7.	 Click Import >> From .EXP Files again to 
import from a different folder or click 
Close.

NOTES
EQ8 may let you adjust the size of the embroidery larger than what your hoop 
and sewing machine can stitch.

Use the Thread Tools to recolor your imported embroideries, see page 105.

Step 1 Step 2

Step 4 Step 5

Step 7

Step 6
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ADDING, FORMATTING, AND RENAMING MY FAVORITE LIBRARIES
Use the customizable My Favorite Libraries to store your personal designs for easy access when working on any EQ8 project. 
This feature is great for new block designs and scanned fabrics.

1.	 Open the library into which you want 
to add a My Favorite category. Click 
Libraries from the menu bar, then Your 
Choice. Example: If you want to add 
a personal library of blocks, open the 
Block Library.

2.	 Click the My Favorite section.

3.	 Click the Create Library button.

4.	 Type a descriptive name for the library 
category. Example: Italy Trip Photos, 
not Photos.

5.	 In Start with _____ styles, choose the 
number of styles (or sub-categories) for 
this library category. This number can 
be from 1 to 59 styles.  

6.	 Click OK to add the new library 
category.

7.	 To format the library category and 
change its name or add more styles, 
right-click on the name in the list and 
click Modify Library.

8.	 Type in a new name or a new number 
of styles. When you’re done, click OK.

9.	 Click Close to return to the worktable.

NOTES
If you only want to change the name, you can click 
once on the name to select it and click on it again 
to get the renaming box. (Click, pause, click.) Type a 
new name and then click elsewhere to deselect it.

If you add items to a My Favorite Library (your 
own personal library), they won’t show up in the 
regular EQ8 Library. You will need to click on the 
My Favorite Library section to see them.

If you are only changing the library or style name, 
you do not need to click the Save Library button. If 
you are changing the name and adding items to the 
style you do need to click Save Library.

To learn how to delete from or an entire My 
Favorite Library, see page 212.

Step 1

Step 2

Step 3

Step 4

Step 5

Step 6

Step 7

Step 8
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ADDING AND SAVING ITEMS IN MY FAVORITE LIBRARY

Copying the Items
1.	 Open the library to which you want 

to add items. Click Libraries from 
the menu bar, then Your Choice. For 
example, if you want to add a block to 
a My Favorite Library, open the Block 
Library.

2.	 Click to choose the section of the 
library you want to copy from: EQ 
Library, Current Sketchbook, Search 
Results, or Import Results. If you 
choose Import Results, see pages 207-
209, or Search Results, see pages 201-
204, follow those instructions and then 
return to this step.

3.	 Click an item to select it. You can also 
use keyboard shortcuts to help you: 
 
Hold down the CTRL key (Command 
key) and click on each individual item 
you want to select. 
 
Hold down the Shift key as you click to 
select a range of items. 
 
Click one item, then press CTRL+A 
(Command+A) to select all the items in 
this style.

4.	 Click the Copy button, or press CTRL+C 
(Command+C).

Adding & Saving the Items
5.	 Click the My Favorite library section.

6.	 Click the plus sign next to the library 
name, then the style name you want to 
add these items to. (If you do not have 
libraries added to My Favorite library 
yet, see page 210 and then return to 
this step.)

7.	 Click the Paste button, or CTRL+V 
(Command+V). Do not add more than 
254 items to any style.

Step 1

Step 2

Step 3Step 4

Step 5

Step 6

Step 7
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8.	 Click the Save Library button. If you 
change styles without clicking Save 
Library you will be prompted to save 
the changes.

9.	 Click OK, then Close to return to the 
worktable.

DELETING FROM MY 
FAVORITE LIBRARIES

1.	 Open the library in which you want 
to delete from. Click Libraries from 
the menu bar, then Your Choice. For 
example, if you want to remove a 
scanned fabric, open the Fabric Library.

2.	 Click the My Favorite Library section.

3.	 Click the plus sign next to the library 
category name to open it, then click the 
style name containing the item or items 
you want to delete.

4.	 Click to select all items you want to 
delete. You can also use keyboard 
shortcuts to help you: 
 
Hold down the CTRL key (Command 
key) and click on each individual item 
you want to select. 
 
Hold down the Shift key as you click to 
select a range of items. 
 
Click one item, then press CTRL+A 
(Command+A) to select all the items in 
this style.

5.	 Click the Delete button or press your 
keyboard Delete key to delete the 
selected items.

6.	 At the prompt, click Yes if you are sure 
you want to delete the selected items.

7.	 Click Save Library. If you change styles 
without clicking Save Library you will 
be prompted to save the changes, 
otherwise the items will not be deleted.

8.	 Click OK, then Close to return to the 
worktable.

NOTE
To delete an entire My Favorite Library category and all the styles it contains, you 
need to find the User Favorites folder. The default location is:  
PC: Documents > My EQ8 > User Favorites  
MAC: Go > Home > My EQ8 > User Favorites 
Find the library file (it will have the same name as in the library list, potentially 
with an extension, such as .FAB) and delete it.

Step 8

Step 9

Step 1

Step 2

Step 3

Step 5 Step 4

Step 6

Step 7

Step 8
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EQ8 gives you many possibilities for printing patterns, colored block and quilt pictures, yardage estimates, photographs, 
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PRINTING PATTERNS OVERVIEW
There are a number of options for printing patterns in EQ8, but the basic steps are the same. Printing a block pattern can be 
done from either the Block Worktable or the Quilt Worktable, while printing a Quilt and Fabric Yardage can only be printed 
from the Quilt Worktable. 

Each pattern style has specific options for you to select which we’ll explain in the following sections. However, there are 
general options that they all share, which we’ll discuss below.

View the Printing Options
On the Quilt Worktable, click the PRINT & 
EXPORT tab. Click Print on the ribbon. Select 
the layer (below the worktable) on which you 
set the block, motif, or stencil. Click the item 
you’d like to print. It will have a green outline, 
showing it’s selected, and the size of the 
selected item will display. 
 
On the Block Worktable, click the PRINT & 
EXPORT tab. Click Print on the ribbon. 

Select a Printing Style
In the PRINT PATTERNS palette, select a print 
style. The palette on the Quilt Worktable has 
options for printing the quilt, fabric yardage, 
all the block patterns, as well as embroidery 
and photo (see page 230).

The palette on the Block Worktable has the 
pattern styles available for blocks.

General Printing Options 
Edit Name is on the first tab or screen of all 
printout styles, except for Foundation Patterns 
(click the Options tab). If the quilt or block 
does not have a name, Unnamed or Worktable 
Block will appear in the name box. This name 
appears at the top of your printouts. If you 
want to name the quilt or block (or edit the 
existing name), click Edit Name. Your cursor 
will appear in the name box. Type the new 
name and click Apply. This name change 
will update on the Notecard in the Project 
Sketchbook as well.

Block Worktable

View the Printing Options

Quilt Worktable

When you select an item on the Quilt Worktable > PRINT & EXPORT tab, 
the item will have a green outline and the finished size will display.

PRINT PATTERNS palette 
on the Quilt Worktable

PRINT PATTERNS palette on the Block Worktable 

Only applicable print options will be 
enabled in the palettes. For example, 

if you have an applique block 
selected for printing, Rotary Cutting 

will not be enabled.

Edit Name
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Finished Block Size is on the first tab or screen 
of all printout styles, except for Foundation 
Patterns (click the Options tab). Under 
Finished Block Size, you have two options: 
 
	 •	 Recommended: Use size from quilt (Quilt  
		  Worktable) or Use size from worktable  
		  (Block Worktable) – The finished block  
		  size will show in gray because EQ8 is  
		  reading the sizes you set for this block.  
		  (The size will be correct, but if you  
		  question the size, specifically when  
		  printing a block from the Quilt Worktable,  
		  be sure to review how blocks are  
		  measured for the layout style you are  
		  using, see pages 39-45 and 49.) 
 
	 •	 Custom block size – To enter a different  
		  size, click Custom block size, then double- 
		  click in the Width and Height boxes and  
		  type a size.

Under Copies, double-click in the box and 
type the number of printouts you want (1 to 
99).

Click any of the buttons across the bottom of 
the box for more options. See the descriptions 
of these options to the left.

NOTES
If multiple-page printouts are missing the right-
edge guideline, click Page Setup and increase your 
Right page margin.

Previewing a Template or Foundation pattern 
printout can save you paper. You can delete or 
move templates or foundation sections. You can 
also rotate templates in 30 degree increments to fit 
better on a page. See page 222.

Print preview

Print button Close button

Finished 
Block Size

Copies

Help – click to view detailed help information. 
 
Page Setup – click to change margins, paper size, orientation, or the printer 
(see page 236). 
 
Fonts – click to change fonts or font size (see page 235). 
 
Preview (recommended) – click to preview your printout. From the preview, 
click Print to print, Zoom In and then drag the magnifying glass to zoom in 
(if you select this and want to preview it again before closing, either click 
Zoom Out or Fit to Screen), or Close to return to this box. 
 
Print – click to print your block, motif, or stencil without previewing. 
 
Close – click to return to the worktable without printing.

These six buttons will appear at the bottom of every print window.
See descriptions below.
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PRINTING A BLOCK, MOTIF, OR STENCIL
1.	 On the Quilt Worktable, click the 

PRINT & EXPORT tab. Click Print on 
the ribbon. Select the layer (below the 
worktable) on which you set the block, 
motif, or stencil. Click the item you’d 
like to print to select it. 
 
On the Block Worktable, click the 
PRINT & EXPORT tab. Click Print on the 
ribbon.

2.	 In the PRINT PATTERNS palette, select 
Block.

3.	 Choose your Finished Block Size 
(Use size from quilt or worktable is 
recommended), see pages 37 and 215.

4.	 Under Printing Style, choose from the 
following: 
 
Outline drawing – black and white solid 
lines showing how patches overlap. 
 
Quilting stencil – black and white 
dotted lines. If you are printing stencils 
colored using the Thread tool, choose 
Showing fabrics instead. 
 
As applique pattern – solid black lines 
with white-filled patches showing how 
patches are layered. 
 
Showing fabrics – prints the block in 
color as displayed in the Print Block 
box. This option also prints a stencil in 
the thread color, style, and weight you 
have chosen. If the picture of the block 
in the Print Block box is only an outline, 
Showing fabrics will not be available. 
Click the coloring arrows beneath the 
block picture to enable this option 
and choose the coloring you want to 
print. The displayed coloring will print, 
regardless of which coloring is shown 
on the worktable.

5.	 Under Copies, double-click in the box 
and type the number of printouts you 
want (1 to 99).

Step 2

Step 3

Step 4

Coloring
arrows

Step 5

Outline drawing Quilting stencil

As applique pattern Showing fabrics

If you choose Showing fabrics in Step 4, 
the coloring displayed here will print.
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6.	 Click the Options tab, then under 
Pattern Style Options, click to check the 
options you want: 
 
Print block name – prints the name 
at the top of your printout from the 
block’s Sketchbook notecard. If you 
did not name your block, it will say 
“Unnamed.” You can name or rename 
your block using the Edit Name button 
on the Block Size tab and then clicking 
Apply, see page 214. 
 
Print as many as fit – prints as many 
full blocks on one page as possible, 
when you are printing smaller blocks. 
(Altering your page margins in Page 
Setup may change the number of 
blocks that fit on a page.) 
 
Mirror – prints the block flipped 
horizontally.

7.	 For Line Thickness, click the down 
arrow to show the styles, then click 
directly on the thickness you want. 
(This option is only available for the 
Outline drawing and As applique 
pattern Printing Styles.)

8.	 If you choose Showing fabrics, the 
outline choices on the Options tab 
under Showing Fabric Style Options 
will be enabled. (Other styles listed in 
step 4 automatically print outlines.) Put 
a check next to the options you want. 
(You can check one, both, or neither of 
the options.) 
 
Print block outline – prints a black 
outline around the block. 
 
Print patch outline – prints black 
outlines around the patches.

9.	 Change the Page Setup or Fonts (see 
pages 235 and 236).

10.	 Click Preview to see what will print, 
then click Print.

Step 6
Options tab

Step 6

Step 7

Step 8

Step 9 Step 10

Print preview screen

Step 10
Print
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PRINTING TEMPLATES
You can print templates for any block, no matter if it is pieced or applique. Each patch is printed as a separate piece 
(surrounded by seam allowance, if you so choose).

1.	 On the Quilt Worktable, click the 
PRINT & EXPORT tab. Click Print on 
the ribbon. Select the layer (below the 
worktable) on which you set the block 
or motif. Click the item you’d like to 
print to select it. 
 
On the Block Worktable, click the 
PRINT & EXPORT tab. Click Print on the 
ribbon.

2.	 In the PRINT PATTERNS palette, select 
Templates.

3.	 Choose your Finished Block Size 
(Use size from quilt or worktable is 
recommended), see pages 37 and 215.

4.	 Seam Allowance – check Print seam 
allowance if you want seam allowance 
added around each template. Double-
click the number and type a new 
number, if you need to change it. (See 
Notes at the end of this section for 
seam allowance tips.)

5.	 Print Key Block – the key block is 
a small picture of your block, with 
each patch identified by a letter. This 
“key” helps you know how to fit your 
template patches back together. Click 
to choose one: 
 
None – choose when you don’t need 
a key block, and want more room for 
templates. 
 
Small – choose when your block does 
not have many small patches. 
 
Large – choose when your block has so 
many tiny patches that the patch letters 
would not fit or read well on a small key 
block.

6.	 Line Thickness - click the down arrow 
to show the styles, then click directly on 
the thickness you want.

Step 2

Template printout

Key block

Step 3

Step 8

Step 4

Step 6

Step 5 Step 7

Step 9
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7.	 Mirror block - flips patches horizontally. 
(Depending on your technique, use 
this so your block doesn’t end up 
backwards.)

8.	 Under Copies, double-click in the box 
and type the number of printouts you 
want (1 to 99).	

9.	 Click Preview to see what will print. You 
can move, rotate, and delete patches 
to customize your pattern, see page 
222. When you are happy with your 
printout, click Print. 

NOTES
If your printer prints the seam allowance faintly, 
you can darken it by clicking File from the  menu 
bar, then Preferences and General. Under “Printing 
Options” change the “Minimum line size in pixels” 
from 1 (default) to 2, 3 or 4. See which thickness 
you prefer with your printer.

If you are printing directly onto freezer paper 
and plan to hand-cut seam allowance around the 
patches, uncheck Seam Allowance. Then see pages 
222 for how to move or delete unnecessary patches 
from your printout, so you can fit as much on one 
page as possible.

PRINTING A 
FOUNDATION PATTERN
Foundation patterns are also known as paper 
piecing patterns. If you’ve drawn a PolyDraw 
block or if your EasyDraw block has curves, 
you will need to section and number the block 
yourself. See Sections and Numbering on the 
next page.

1.	 On the Quilt Worktable, click the 
PRINT & EXPORT tab. Click Print on 
the ribbon. Select the layer (below the 
worktable) on which you set the block. 
Click on the block you’d like to print to 
select it. 
 
On the Block Worktable, click the 
PRINT & EXPORT tab. Click Print on the 
ribbon.

2.	 In the PRINT PATTERNS palette, select 
Foundation.

Step 2

Print preview screen

Step 9
Print

Customize your printout by deleting unwanted patches (like the large 
background patch that you would cut with a ruler), and then moving 

and rotating patches to best fit on the page(s). See page 222 for details.

Blank pages 
will not print.
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Style Options:

Line Drawing Grayscale fill

Color fill

Options:
Print numbering – prints the paper piecing letters and numbers on the pattern. 
 
Separate units – separates pattern according to sections defined on Sections tab. If you 
plan to move or delete sections of the pattern in the Print Preview, this option must be 
checked. 
 
Mirror – flips pattern horizontally. (Depending on your technique, use this so your block 
doesn’t end up backwards.) 
 
Print block name – prints the name at the top of your printout from the block’s Sketchbook 
notecard. If you did not name your block, it will say “Unnamed.” (Naming a block is 
different than naming a project. See pages 34 or 214.) 
 
Print as many blocks as fit – prints as many full blocks on one page as possible. If you 
plan to move or delete sections of the pattern in the Print Preview, this option must be 
unchecked.

Step 3

Step 4 Step 8

Step 6

Step 5

Step 7

Step 9

Step 10

Options tab
3.	 Click the Options tab.

4.	 Choose your Finished Block Size 
(Use size from quilt or worktable is 
recommended), see page 37 and 215.

5.	 Seam Allowance – check Print seam 
allowance if you want seam allowance 
added around each section. Double-
click the number and type a new 
number, if you need to change it.

6.	 Line Thickness – click the down arrow 
to show the styles, then click directly on 
the thickness you want.

7.	 Under Copies, double-click in the box 
and type the number of printouts you 
want (1 to 99).

8.	 Under Style, click the option you want. 
Line drawing will print a black and 
white block. Grayscale fill will fill the 
sections with shades of gray. Color fill 
will print the block with solid colors 
(if you colored the block with fabrics, 
EQ8 will choose solid colors that closely 
resemble the average color of the 
fabric).

9.	 Under Options, click to check the 
options you want. See details at right.

10.	 Click Preview to see the pattern. If you 
don’t like how the block is sectioned 
or numbered, click Close, then follow 
steps 11 – 16. Otherwise, click Print. If 
your preview says “Unnamed” and you 
want to name the block, see page 214.
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This window is resizable to help you section or number complicated patterns. Position your 
cursor over the edge or corner of the window, then click and drag to enlarge the entire box.

Step 11
After clicking Start Over, click 

on the patches for the section. 

Step 12

Step 13
Step 14

Click on the patches in sewing order.

Step 15 Step 16

Sections tab
11.	 Click the Sections tab. Blue lines 

surround the areas denoted as sections 
(units). 

12.	 To resection the block, click Start 
Over. All blue lines will disappear. 
Click directly on the patches you want 
in a section. When all patches for a 
section are selected (gray), click Group. 
Continue grouping sections until all 
the patches are included. If you make 
a mistake, SHIFT+click on a patch to 
remove it from the selection before 
clicking Group. Or click Start Over to 
deselect everything.

Numbering tab
13.	 Click the Numbering tab. You’ll see 

numbers and letters in the sections of 
your block.

14.	 To renumber the block, click Change 
Numbers. Click the patches in the order 
you want them numbered. If you make 
a mistake, SHIFT+click on a patch to 
remove the number. Or click Start Over.

15.	 Change the Page Setup or Fonts (pages 
235 and 236).

16.	 Click Preview to see your printout. 
You can move or delete sections to 
customize your pattern, see page 221. 
Click Print, or click Close and return to 
any above steps to make changes.

NOTES
If you don’t want EQ to help with sectioning or 
numbering of your pattern, put a check in I want 
to section & number myself without EQ’s help. You 
will need to section the parts of the block that you 
want to generate a pattern for, and you will need 
to number every patch. You are not required to 
section every part of the block. Only the sections 
that you define will appear on the printout. 

To make your sectioning and numbering permanent 
for this Sketchbook block, edit the block, follow 
steps 2-14, click Preview, Close, Close and the Save 
button. You may want to save this block in your 
My Favorite Library to make it accessible for other 
projects. See pages 211. 

Print preview screen

Step 16
Print
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CHANGING FOUNDATION AND TEMPLATE PRINTOUTS
Sometimes you may want to delete repeated templates or foundations, or move them so they don’t extend across more pages 
than necessary. You can tailor your printout before printing by using the available buttons on the print preview.

1.	 On the Quilt Worktable, click the 
PRINT & EXPORT tab. Click Print on 
the ribbon. Select the layer (below the 
worktable) on which you set the block 
or motif. Click the item you’d like to 
print to select it. 
 
On the Block Worktable, click the 
PRINT & EXPORT tab. Click Print on the 
ribbon.

2.	 In the PRINT PATTERNS palette, select 
Templates or Foundation.

3.	 Choose your settings and sizes, see 
pages 218-221.

4.	 Click Preview. 

NOTE
Templates have a key block option that appears 
at the top-left of the printout. You can choose not 
to print it, or to print it small or large. Make this 
choice before moving or deleting templates. If you 
close the print preview your printout will reset, 
then you’ll have to start deleting, moving, and 
rotating all over again.

Deleting
When you delete pattern pieces, the 
remaining pieces reorganize. So, delete pieces 
before moving them. If you are printing 
applique blocks, you may want to delete the 
large background square and cut that later.

5.	 Click directly on a piece you want to 
delete. The piece outline will turn red 
and the Delete button will be enabled.

6.	 Click the Delete button. The piece will 
disappear and the other pieces will 
move up to take the deleted one’s 
place.

7.	 Repeat steps 5 and 6 to delete other 
pieces as desired. If you delete enough 
pattern pieces to clear a page, that 
blank page will not print. 

Step 2

The large square patch has been deleted.

Step 6Key block Step 5

Click on the patch or section to delete. The outline will turn red.
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Moving
8.	 Click directly on the piece you want to 

move. The outline will turn red.

9.	 With the piece selected, click, hold, and 
drag the piece to another position, then 
release the mouse when the pattern 
piece is where you want.

10.	 You can repeat steps 8 and 9 to move 
other pieces as desired.

Rotating (Templates only)
11.	 Click directly on the piece you want to 

rotate. The outline will turn red.

12.	 With the piece selected, click the 
Rotate button. The patch will rotate 30 
degrees. You can click the Rotate button 
more times until the piece is at the 
desired angle. You may need to repeat 
steps 8-9 to move it again.

13.	 Click Print when the pattern looks the 
way you want it. If you click Close the 
pattern will reset and you’ll have to 
start over.

NOTES
If you accidentally delete a template or foundation 
piece you still need, click Close and click Preview 
again to start over.

Once you click Print, the changes you’ve made to 
the preview will be lost. If you’d like to “save” the 
print preview, you can create a PDF file. See the 
EQ8 Online Support site for instructions.

Step 8

Repeat steps 8 and 9 for any pieces you’d like to move.

Blank pages 
will not print.

Step 12

Click the Rotate button multiple times, if necessary.

Step 11
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PRINTING A ROTARY CUTTING CHART
This type of printout is not available for all blocks, because some blocks are not ideal for rotary cutting. Blocks made up of 
squares, triangles, rectangles, parallelograms or diamonds work best.

If you notice patches missing from the printout, it’s because they are not able to be rotary-cut. Print the block again as 
Templates to get these “missing” patches.

Be sure to read the next topic on notes about rounding and also the “best practices” to use when rotary cutting. See  
pages 225-227.

1.	 On the Quilt Worktable, click the 
PRINT & EXPORT tab. Click Print on 
the ribbon. Select the layer (below the 
worktable) on which you set the block 
or motif. Click the item you’d like to 
print to select it. 
 
On the Block Worktable, click the 
PRINT & EXPORT tab. Click Print on the 
ribbon.

2.	 In the PRINT PATTERNS palette, select 
Rotary Cutting.

3.	 Choose your Finished Block Size 
(Use size from quilt or worktable is 
recommended), see pages 37 and 215.

4.	 Seam Allowance – choose the seam 
allowance Width you want added 
around each piece. Double-click the 
number and type a new number, if you 
need to change it.

5.	 Print Key Block – the key block is a 
small drawing of your block, with each 
patch identified by a letter. This “key” 
helps you know how to fit your patches 
back together. Click to choose one: 
 
Small – choose when your block does 
not have many small patches. 
 
Large – choose when your block has so 
many tiny patches that the patch letters 
would not fit or read well on a small key 
block.

Step 2

Step 3

Step 4

Step 5

Rotary Cutting Chart printout

Key block
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6.	 Rounding (available when working in 
inches; metric automatically rounds 
to the nearest millimeter) – click to 
select whether you want EQ8 to round 
to the nearest 1/8 or 1/16 inch when 
calculating, or you can select “None” if 
you want exact cutting dimensions.

7.	 Under Copies, double-click in the box 
and type the number of printouts you 
want (1 to 99).

8.	 Change the Page Setup or Fonts (pages 
235 and 236).

9.	 Click Preview to see your printout, then 
click Print.

Step 6

Step 7Step 9Step 8

NOTES ON ROUNDING 
IN ROTARY CUTTING 
Rotary cutting dimensions are nearly always 
approximations. For example, the 7/8 inch that 
quilters conventionally add for half-square 
triangles is really 0.85355 inches, rounded off 
to the nearest 1/8 inch so it can be read on a 
ruler. (In fact, experienced quilters cut a little 
“shy” in this case since 0.85355 is a little less 
than 7/8 or 0.875.)

This applies to the dimensions given in 
EQ8 rotary cutting printouts, as well as to 
dimensions in books. Even selecting “None” 
for rounding, the rotary cutting instructions 
may not always be the best way to cut your 
block. Here are some things that you should 
know when deciding on the best type of 
pattern to use for a given block.

EQ8 Gives Conventional 
Results
With simple cases (rectangles and triangles 
at even sizes), EQ8 gives the same results as 
conventional quilter’s wisdom. It adds 1¼ 
inches to the finished size of quarter-square 
triangles, just like in books.

1

0.85355”

Understanding the Cutting Diagrams

For Patch A, cut a strip of fabric 2½” wide, then cut 2½” squares from the strip. 
You’ll need 4 blue squares, 4 pink squares, and 1 red square.

For Patch B, cut a strip of fabric 27/8” wide, then cut 27/8” squares 
from the strip. Cut the squares diagonally to make half-square triangles. 

You’ll need 8 white triangles and 4 green triangles.

For Patch C, cut a strip of fabric 3¼” wide, then cut 3¼” squares from the strip. Cut the 
squares diagonally twice to make quarter-square triangles. You’ll need 4 green triangles.

It would be nearly impossible to accurately cut this 
dimension with a rotary cutter and ruler.
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But, EQ8 gives rotary cutting dimensions 
even in cases where the conventional rules 
do not apply. Here you need to be aware that 
rounding off to the nearest 1/8 or 1/16 inch may 
produce inaccuracies. The example to the 
right illustrates this point very well. Choosing 
“None” for rounding may still calculate 
inaccuracies, especially if there are irregular 
shapes in the block. 

The inaccuracies produced by “rounding off” 
can become significant if the finished sizes of 
patches are not easily measured on common 
rulers. The illustrated block has 7 patches 
across by 5 patches down. If you wanted a 
10-inch square block, this would mean that 
each rectangle has a finished size 1.428571” 
by 2”. The measurement 1.43 is not to be 
found on your ruler. Even choosing “None” as 
your rounding option, EQ8 goes to the 3rd, or 
thousandth, decimal point, so the block would 
be rounded to 1.429 which would, over the 
entire quilt, cause inaccuracies. 

EQ8 would add the ¼ inch seam allowance, 
round off (say, to the nearest 1/8 inch), and tell 
you to cut rectangles 1 7/8” by 2 ½”. If you then 
pieced together these patches (assuming you 
use accurate quarter-inch seams), the finished 
size of the actual block would come out to be 
9 5/8” by 10”, a full 3/8 inch too narrow! If you 
round off to the nearest 1/16 inch, the block will 
be 10 1/16” x 10”, and still 1/16 inch too wide.

Use Templates to Verify 
Sizes
EQ8 templates are always 100% accurate. 
If you are uncertain about rotary cutting 
dimensions in some cases, print the 
templates as a check. The actual, un-
rounded, dimensions for rotary cutting may 
be measured by the dotted seam allowance 
lines on the templates. First, extend the seam 
allowance lines at the corners until they cross. 
Then measure the resulting total length and 
height. 

A block 7 across by 5 down should be printed at 7” x 5” or 14” x 10” or 21” x 15”, etc. 
If the size is not a multiple of the grid, print templates instead.

Original EQ8 template Extend seam allowance lines at 
the corners, then measure.

1

1.43”

2
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Best Practices
1.	 Make note of a block’s grid or 

structure. For example, a Nine Patch 
and all its variations and stars are on a 
3 x 3 grid.

2.	 When setting up a quilt on the LAYOUT 
tab, set the finished block size to be 
a multiple of that grid. Nine patches 
would be best at 3, 6, 9, 12, 15, 18, etc.

3.	 When printing rotary cutting, print 
the block at a multiple of that grid 
and round to 1/16 of an inch. Click the 
Use size from quilt option to print the 
block the same size as specified on the 
LAYOUT tab.

4.	 Print templates to cross-check the 
sizes, especially if the block is complex 
and the grid is not apparent. Tape these 
to the underside of your acrylic ruler to 
verify the actual width of the patches 
to be cut and to keep the templates 
from sliding away.

Best Practices 1
Make note of a block’s grid or structure. The Ohio Star shown is on a 3 x 3 grid.

21 3

2

3

Best Practices 2
Make finished block size a multiple of the block grid.

Best Practices 3
Choose Use size from quilt and set Rounding to 1/16.
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PRINTING BORDER OR 
SASH BLOCKS
Printing border or sash blocks is like printing 
other blocks: you select the block, choose 
your pattern type, then print. What’s 
confusing is that the whole border won’t 
print as one pattern. Most borders require 
multiple print jobs because they are made up 
of multiple blocks or sections. (See the Notes 
below about using the Auto Borders.)

1.	 On the Quilt Worktable on Layer 1, 
click the PRINT & EXPORT tab. Click 
Print on the ribbon. 

2.	 Click on the border or sash block you 
want to print. The whole block will 
select, whether it is a long strip, a 
whole block, or a clipped block.

3.	 Click the Print option you want. (Use 
Templates, Foundation, or Rotary 
Cutting to get a pattern.)

4.	 Choose your Finished Block Size (Use 
size from quilt recommended), see 
pages 37 and 215. The finished block 
size will show in gray.

5.	 Under Copies, double-click in the box 
and type the number of printouts you 
want (1 to 99).

6.	 Change the Page Setup or Fonts (pages 
235 and 236).

7.	 Click Preview to see your printout, then 
click Print.

NOTES
If you want the convenience of having your whole 
border print in one print job, use a border from the 
Single Block Patterns Auto Border categories. See 
page 66.

If you notice patches are missing on rotary cutting 
charts for border, sash, or sash corner blocks, it’s 
because those patches are not able to be rotary-
cut. Print the block again as Templates to get these 
“missing” patches.

If you want to delete, move, or rotate patches, see 
page 222.

Step 4

Step 5Step 6 Step 7

Step 1

Step 2
Click on the border or sash block to select it. It will have a 

green outline and display the size you set on the LAYOUT tab.

Step 3

Check Use size from quilt to ensure 
your printouts are correct.

If you forget to check Use size from 
quilt, your printout may be wrong.
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PRINTING A QUILT
To print a quilt, you must be on the Quilt 
Worktable with the quilt you wish to print on 
your screen.

1.	 Click the PRINT & EXPORT tab, and 
Print on the ribbon.

2.	 In the PRINT PATTERNS palette, click 
Quilt. The Print Quilt box appears.

3.	 Under Printing Style, choose either: 
 
Outline drawing – to print your quilt as 
a line drawing with no color. 
 
Showing fabrics – to print your quilt 
filled with the current fabrics and 
colors.

4.	 Under Options, click to check the 
options you want. See descriptions of 
these options on the left.

5.	 Under Copies, double-click in the box 
and type the number of printouts you 
want (1 to 99).

6.	 Change the Page Setup or Fonts (pages 
235 and 236).

7.	 Click Preview to see your printout, then 
click Print.

NOTES
If the line drawing printout of your quilt has 
overlapping shapes, especially with applique, try 
coloring the entire quilt white. Then print the white 
quilt Showing fabrics.

To print a smaller picture of your quilt, try making 
your margins larger (page 236) or exporting your 
quilt as an image (page 238). Then import that 
image through the Photo Library (page 208), and 
print it from the Image Worktable to the exact size 
you need (page 231).

If you would like to select part of a quilt to print, 
while still on the PRINT & EXPORT tab, click Export 
on the ribbon. Choose Selection in the EXPORT 
IMAGES palette and drag the mouse on the quilt 
to select the area you want to print. In the window 
that appears, click Print. See page 240.

Options:
Print name – prints the name at the top of your printout from the quilt’s Sketchbook 
notecard. If you did not add your quilt to the Sketchbook and name it, the printout will say 
“Unnamed.”  
 
If you want to name the quilt or edit the existing name, click Edit Name. Your cursor 
will appear in the name box, so delete any words you don’t want, and type the new or 
additional name you want for the quilt. Click Apply. This name change will update on the 
Notecard in the Sketchbook. (Naming a quilt is different than naming a project. See page 
214.) 
 
Print overall size – prints the dimensions of your quilt at the top of your printout. 
 
Print block outline – prints a block outline around each block. 
 
Print patch outline – prints black outlines around each patch.

Step 2

Step 4
See descriptions 

below

Step 3

Step 6 Step 7

Step 5

Step 7
Print



230

EQ8 Reference Manual

9

PRINTING PHOTOS OR EMBROIDERY FROM THE QUILT WORKTABLE
To print a photograph or embroidery design from your quilt, you must be on the layer on which you set the photo or 
embroidery design. Photos can be set on Layers 1, 2, or 3. Embroidery designs can only be set on Layer 3.

1.	 On the Quilt Worktable, click the PRINT 
& EXPORT tab, and Print on the ribbon.

2.	 Click the layer where your photo or 
embroidery design is that you want to 
print.

3.	 Click on the photo or embroidery you 
want to print. In the PRINT PATTERNS 
palette, the respective option will 
enable (either Photo or Embroidery). 
Click this option.

4.	 For either photo or embroidery, select 
the size you want it to print. Use size 
from quilt is recommended.

5.	 Under Copies, double-click in the box 
and type the number of printouts you 
want (1 to 99).

6.	 Change the Page Setup or Fonts (pages 
235 and 236).

7.	 On the Print Embroidery Design box, 
click the down arrow under Line 
Thickness and click on the desired line 
thickness.

8.	 Click Preview to see your printout, then 
click Print.

NOTES
If you are printing photos on fabric, for sewing into 
a quilt, you may want to print them a fraction larger 
than the size you will sew (have the color extend 
into the seam allowance). Then, when you sew, you 
won’t see any white lines from unprinted fabric 
along your seam line.

You can also print images from the Image 
Worktable, see page 231.

Step 3
(Only the appropriate print  

option will be enabled.)

Step 2
Choose the layer (below the worktable) where the item is set.

Step 4

Step 5

Step 6 Step 8

Step 4

Step 7

Step 6 Step 8

Step 5
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PRINTING IMAGES WITH 
PHOTO LAYOUT
Make the most of printable fabric sheets and 
arrange photos before printing. Do this from 
the Image worktable when you have at least 
one photo in your Sketchbook. Change Page 
Setup before you start this process.

1.	 On the Image Worktable, click the 
PRINT & EXPORT tab, and Print on the 
ribbon. 

2.	 In the PRINT IMAGE palette, click Photo 
Layout. What looks like a blank piece of 
paper will appear with the photos from 
your Sketchbook on the right.

3.	 Drag and drop an image from the right 
column onto the page. The toolbar will 
enable once there is an image on the 
page. The image will set at its saved 
size, unless the image is too large to fit 
on your page. If it is too large, click Yes, 
to scale the image to fit. You can drag 
as many images onto the page as you 
like.

Steps 4-13 can be done in any order, but the 
image must be selected: 

4.	 Move the image – click and drag the 
image to a new position.

5.	 Resize the image – if the image’s top-
left corner is not visible, move the 
image. Click the Resize dialog button. 
If Maintain aspect ratio is checked, the 
image stays proportional. To change the 
numbers, double-click the number and 
type a new one or use the arrows next 
to the size to move in increments. Click 
OK. You may need to move the image 
back on the page.

6.	 Rotate or Flip the image – click the 
Rotate Left or Rotate Right buttons 
to rotate the image 90 degrees each 
time. Click the Flip Horizontally or Flip 
Vertically buttons to mirror the image.

7.	 Reposition using the presets – click any 
of the Center or Move preset buttons.

Step 1

Step 2

Step 3 
Drag the photo from the right column onto the page. The photo  

will be small and transparent until the mouse is released.

Sketchbook photos appear here. Use the 
scrollbar to the right, if you don’t see them all.

Step 5
Resize

Step 6 – Rotate or Flip

Rotate 
Left

Rotate 
Right

Flip
Horizontally

Flip
Vertically

Center on
Page

Center 
Horizontally

Center 
Vertically

Step 5

Move to 
Top

Move to 
Bottom

Move Left Move Right

Step 7 – Center or Move
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8.	 Reposition the image using the grid – 
make sure you can see the grid (click 
Show Grid) and turn on grid snapping 
(click Snap to Grid). Now when you 
move the image, the image will snap to 
the grid. (The grid does not print.)

9.	 Changing the grid – click View > Grid 
Setup. Choose the Origin and Spacing. 
Click OK.

10.	 Aligning images – click the image you 
want all others to follow. SHIFT+click 
the other images you want to align to 
the first selected image. Click one of the 
Align buttons to align tops, bottoms, 
lefts, or rights. (The Align options are 
only active when there is more than 
one image selected.)

11.	 Make a full sheet of printable fabric 
(works best for small images) – click the 
Tile button. The image will repeat side 
by side on the page. (To turn off Tile, 
click the Tile button again.)

12.	 Copying and pasting images already 
on the page – to copy the image, press 
the Copy button, or press CTRL+C 
(Command+C). Paste the image by 
clicking the Paste button, or pressing 
CTRL+V (Command+V).

13.	 Remove/Delete an image from page –  
click the image to select it. Click the 
Delete button or press your keyboard 
Delete key.

14.	 Print – click Print when the page is 
ready. You may receive a printer box 
asking which printer to use. Choose a 
printer from the list and click OK. The 
page will remain open in case you want 
to print it again or make changes. 
 
Click the X in the top-right corner to 
close Photo Layout. The page will be 
erased.

NOTES
Remember seam allowance when positioning images. We suggest setting your 
grid to Upper left of page with ¼ inch spacing and positioning your images 2 
squares apart, and at least one square from the edge of the page.

Print your images a fraction larger than they need to be so your color extends 
past your sewing line to avoid seeing any white lines from unprinted fabric 
along your seam line. Example: Instead of printing at 5” x 5”, print at 5.125” x 
5.125” to have the color extend 1/16 of an inch into each seam allowance side.

Step 8 – Grid

Show Grid Snap to Grid

Origin: Where you want 
the grid to start

Spacing: Increments used 
for Snap to Grid

Step 9

Step 10 – Align

Align 
Top

Align
Bottom

Align Left Align Right

First block selected SHIFT+click the other photos to align

Align Top was used 
in this example

Step 11
Tile

Full page of tiled photos
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Step 2

PRINTING FABRIC 
YARDAGE ESTIMATES
EQ8 will estimate yardage for your quilt. 
Remember that these are estimates. You may 
find you need less fabric depending on your 
quilt style. In contrast, if you are using a fabric 
with a repeat or a specific design you want in 
the center, you will probably need more than 
the estimated amount. 

1.	 With the quilt you want to print fabric 
yardage for on the Quilt Worktable, 
click the PRINT & EXPORT tab, and 
Print on the ribbon.

2.	 In the PRINT PATTERNS palette, click 
Yardage. The Print Yardage Estimates 
box will appear.

3.	 Under Fabric Width, click the down 
arrow beside Width to select a width 
size for your fabric. Or, you can decide 
to have the fabric yardage given using 
Fat quarters only by clicking the 
checkbox. 

4.	 Under Seam Allowance choose the 
seam allowance Width you want added 
around each piece. Double-click the 
number and type a new number, if you 
need to change it.

5.	 Click Preview to see what will print. To 
zoom in, click the Zoom In button, drag 
a marquee box around what you want 
to see larger, then release to see the 
selected area zoom. Click Zoom Out 
or Fit to Screen to zoom back to the 
regular view. Note that the fabric name 
and SKU, where applicable, are listed. 
Click Print.

NOTE
If you need to change the font or font size, see page 
235. Numbers is the main font used in yardage 
charts.

Here is how EQ8 figures yardage:

1.	 It adds the selected seam allowance to each patch and places an 
imaginary rectangle around each patch at the seam allowance.

2.	 It places these rectangles on fabric of the selected Fabric Width.

3.	 Each time a “row” is filled, it begins a new row, counting the entire 
strip as required yardage.

•	The result is usually an over estimate. Shapes like on-point sashes  
	 tend to give exceptionally large yardage figures. 
•	The estimate for the border assumes that long strips are pieced. The  
	 piecing length is based on the width of fabric selected in the Print  
	 Fabric Yardage box. 
•	Backing and binding are not estimated. 
•	For tips on Fabric Yardage Estimates, see page 234.

Step 3

Step 4

Step 5

Print Zoom In
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SPECIAL NOTES ON 
FABRIC YARDAGE 
ESTIMATES
Color your center and borders differently to 
get separate yardage amounts for each. If 
your quilt center and borders use the same 
fabric swatch (let’s say a green leaf print), the 
yardage will show as one number for both in 
the estimate. Leave your quilt center colored 
in the green leaf fabric, but change your 
border to be a gray solid color. If you re-print 
fabric yardage, they’ll show up as separate 
numbers in the estimate. After printing the 
fabric yardage, you can recolor the borders 
using your desired fabrics. See Example 1.

For quilts with many identically colored 
blocks, you can use the yardage estimate to 
count the number of blocks you need to sew. 
On the Quilt Worktable, click the DESIGN tab. 
On the ribbon, click Fabric Tools. Click the 
Paintbrush tool and select either a fabric or 
solid color not used anywhere in your quilt, 
or close in color to any others you have used. 
CTRL+click (Command+click) one patch in one 
block on the quilt. This will make all matching 
blocks color in the same patch. Continue 
this step until the blocks you want counted 
are filled. If you preview the yardage now 
(PRINT & EXPORT tab > Yardage > Preview), 
the number of patches needed for the new 
fabric or color chosen will equal the number 
of blocks colored that way on the quilt. See 
Example 2.

Fabric yardage will not calculate backing, but 
if you design a second quilt that is the quilt 
back you can print yardage for that as well. 
Start a new Custom Set quilt (the same size as 
your quilt front) and set a plain square which 
covers the entire center rectangle (see page 
55). Or, design a pieced back in any layout 
style (the same size as your quilt front) and 
color it with fabric. To see how large your 
quilt front is, look in the bottom-right corner 
of your screen and find Finished Quilt Size. 
This is the finished size of the quilt (including 
borders). See Example 3.

Example 1

Initial design – borders and center are 
colored in the same fabrics.

Modified design to see yardage needed 
for center versus borders.

Example 2

CTRL+click to color a patch in one block and preview the yardage to get a block count.

The fabric yardage estimate says there are 16 black patches in the quilt, 
which means there are 16 Economy Patch blocks in the quilt.

Example 3

The finished quilt size appears at the lower-right corner of your screen.

Quilt front – 50” x 76” Quilt back – 50” x 76”
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CHANGING FONTS
You can customize your printouts by changing 
the style or point size of the fonts.

1.	 Click FILE from the menu bar, then 
Printer Fonts. OR, if you have the Print 
box on your screen, click the Fonts 
button. The Printer Fonts box appears.

2.	 Click the down arrow next to the 
Choose font for: box, and click the item 
you want to change.  
 
Symbol (default is Arial, 8) – On 
templates and rotary cutting charts, it 
labels the key block. It also labels each 
template.  
 
Number (default is Arial, 8) – On quilts, 
it is the overall size of the quilt (below 
the Header). It’s also used for labeling 
on foundation piecing printouts, 
templates, and rotary cutting charts. On 
fabric yardage estimates, it is the main 
font used. 
 
Header (default is Arial, 12) – The 
header prints the block or quilt name 
(as it appears on the notecard – if there 
is no name, it will read “Unnamed”) at 
the top of the page.  
 
Footer (default is Arial, 7) – The footer 
prints in the lower-left corner of all 
printouts. It will again list the name of 
the block or quilt, the size of a block, 
and the name of the project. 
 
Data (default is Arial, 8) – The data font 
prints on rotary cutting instructions 
only. This is used for the legend for 
cutting diagrams, patch counts, and 
patch labels.

3.	 Click the down arrow below the Font: 
box, and click the font style you want. 

4.	 Click the down arrow below the Size: 
box, and click the point size you want. 

5.	 Click OK to keep your changes, or click 
Close to cancel them. 

Header Symbol

Data

NumberFooter

Step 1

Step 2

Step 4

Step 3

Step 5

If you already have a Print window open, click the Fonts button.
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CHANGING PAGE 
SETUP OR PRINTERS
Use this to change the page orientation, 
margins, paper size, printer or paper source.

1.	 (Optional) If you need to change 
printers, click FILE from the menu bar, 
then Print Setup. Click the down arrow 
next to Name and click the printer you 
wish to use. Click OK.

2.	 Click FILE from the menu bar, then Page 
Setup. OR, if you have the Print box 
on your screen, click the Page Setup 
button. The Page Setup box appears.

3.	 Under Paper, click the down arrow next 
to the Size box to choose your paper 
size.

4.	 Under Paper, click the down arrow next 
to the Source box to choose where the 
paper is fed from (which paper tray, or 
manual feed, for example). 

5.	 Under Orientation, click Portrait if you 
want your printout to be tall (normal) 
or Landscape if you want your printout 
to be wide (sideways). 

6.	 Under Margins, double-click in each 
box and type the size you want to set 
the left, right, top and bottom margins. 
Margins are the spaces around the 
edges of your printout. If you make 
them too large it will take more pages 
to print the information. Your printer 
determines how small they can be. 

7.	 Click OK to keep your changes, or click 
Cancel to cancel them. 

Step 1
(Optional)

Step 2

Step 3

Step 4

Step 5 Step 6

Step 7

Step 1
(Optional)
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This chapter explains the ways you can export selected areas of your design, images, and metafiles of blocks. And, in this 

age of social media, we’ll show you how you can share your designs on Facebook.

Exporting Images..............................................................................................238

Exporting Selected Areas..................................................................................240

Exporting Metafiles of Blocks...........................................................................241

Sharing Designs on Facebook...........................................................................242
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EXPORTING IMAGES
EQ8 lets you export images, perfect for everything from webpages to books—in other words, images of low to high resolution.

1.	 On the Quilt or Block Worktable, 
click the PRINT & EXPORT tab. On 
the ribbon, click Export, then Image 
from the palette. An Export Image box 
appears.

2.	 Navigate to the location on your 
computer where you’d like to save the 
image. 

3.	 Click the down arrow next to Save as 
type: and choose the desired file type: 
 
TIF is typically used for high resolution 
printing purposes. Use this, for 
instance, for images to be sent to 
publishers. 
 
JPG, GIF, BMP, and PNG files are 
typically used for web images. 

4.	 Click inside the File name: box and type 
a name for your image. 

5.	 Click Save. An Export Image File of Quilt 
or Block (depending which worktable 
you are on) box appears. You will want 
to export the image at the size and 
resolution you need.

NOTE
To print a quilt a specific size, or print several blocks 
on one sheet of paper, export them using these 
directions, then import them as images (see page 
174), and print using Photo Layout (see page 231). 
This will also work for quilt labels you create using 
the Set Applique Text tool.

6.	 Under Dimensions of Image, enter the 
size you need by double-clicking inside 
each box and typing a new size. If you 
are exporting a quilt image, leave Keep 
aspect ratio checked to keep your quilt 
correctly proportioned when changing 
width or height.

Step 1

Block Worktable

Quilt Worktable

Step 2

Step 3Step 4 Step 5

Quilt Worktable

Block Worktable
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7.	 Click the down-arrow next to 
Resolution: and click the resolution 
you need. Resolution depends on how 
you’ll use the image:  
 
72-75 dpi (low resolution) – for images 
to be emailed or used in web pages. 
 
150-300 dpi – for images to print from 
your home printer. 
 
300-600 dpi (high resolution) – for 
images to be used in books or 
magazines.

8.	 Under Options, you can uncheck the 
Outline patches and Outline blocks 
boxes if you do not want a black line 
around blocks and patches.

9.	 If you choose to export a TIF or JPG file, 
set the other options: 
 
TIF files – Compression (LZW or none) 
and Depth (24 bit or 32 bit). 
 
JPG files – JPEG quality (set to 50 by 
default; available choices 0-100;  
100 is the highest quality/largest file 
size; 0 is the lowest quality/smallest file 
size).

10.	 Click OK.

NOTES
When in doubt, try several settings and choose the 
one image that works best for your use.

In general, you want to export the image at the size 
you plan to use it in the document. The number of 
pixels in an image is fixed. Increasing or decreasing 
image size after the image has been created can 
lead to resolution and printing issues in your 
document.

Step 7

Step 6

Step 8

Step 9

Step 10
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EXPORTING SELECTED 
AREAS

1.	 On the Quilt or Block Worktable click 
the PRINT & EXPORT tab. On the 
ribbon, click Export, then Selection 
from the palette. Your cursor will 
change to a fancy plus sign with a 
rectangle in the bottom-right quadrant.

2.	 Position the center of the plus sign at 
the top-left of the area to be exported. 
Click, hold, and drag diagonally down 
and right to form a box, release when 
the box encloses the image you want 
to export. An Export Selection box will 
appear with three choices:

Save as a File
3.	 Click the Save as a file button.

4.	 Navigate to the location on your 
computer where you’d like to save the 
image.

5.	 Click inside the File name: box. Type a 
name for your file.

6.	 Click Save. Your file will be saved as a 
bitmap (.bmp).

Copy to Windows Clipboard
Only available for Windows® operating 
systems.

3.	 Click the Copy to Windows clipboard 
button.

4.	 Open a drawing, imaging, or word 
processing program on your computer. 

5.	 Create a new image, file, or document. 
Click EDIT > Paste (or press CTRL+V). 
Your image will appear in the 
document.

Print
3.	 Click the Print button. Your image will 

print.

Step 1

Block Worktable

Quilt Worktable

Quilt Worktable

Block Worktable

Step 3

Step 2
Click, hold, and drag diagonally to form a box around the area you’d like to export.

Export Selection Cursor
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NOTES
If you decide you don’t want to export anything 
and the plus-sign cursor is engaged, click on a 
different EQ8 tab, palette option, or worktable and 
it will disappear. If you have created the export box 
around the image and the Export Selection box is 
on your screen, click the X in the top-right corner to 
close the box. Your cursor will return to its previous 
use.

To print the entire screen, press the Print Screen 
key (Command+SHIFT+4) on your keyboard, open 
a new document in a program such as Word, and 
press CTRL+V (Command+V) to paste the screen 
image. This is handy for writing EQ8 teaching 
materials.

EXPORTING METAFILES 
OF BLOCKS
Only available for Windows® operating 
systems. In EQ8 you can export metafiles 
of blocks (not quilts) and import them into 
another software application, such as Word, 
to make piecing diagrams.

1.	 Begin on the Block Worktable, with 
the block you want to export. Click the 
PRINT & EXPORT tab. On the ribbon, 
click Export, and Metafile from the 
palette. The Export Metafile box will 
appear.

2.	 Under Quality choose Draft quality, 
Medium, or High.

3.	 Under Options, choose one: 
 
Outline and Fill – colored block with 
outlines 
 
Outline only – line drawing 
 
Fill only (recommended) – colored 
block with no outlines

NOTE
Fill colors are solid colors only. The average color of 
the fabrics in the block will be used If you choose 
Outline and Fill or Fill only.

Step 1

Step 2

Step 3

Step 1
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4.	 You can save the metafile as a file or 
copy it to the clipboard: 
 
Save as Windows metafile – Navigate 
to the location on your computer 
where you’d like to save the image. 
Click inside the File name: box and type 
a name for your metafile. Click Save. 
EQ8 automatically adds the three-letter 
extension of .emf. 
 
Copy to Windows clipboard – The 
metafile is copied to the Windows 
clipboard. After exporting, open the 
document (or program) you want to 
paste into, and choose Edit > Paste (or 
CTRL+V) to paste the metafile.

NOTE
To learn how to explode a metafile for a piecing 
diagram, see the EQ8 Online Support site.

SHARING DESIGNS ON 
FACEBOOK
Let your Facebook friends see what quilts 
you’ve been designing. 

1.	 Begin on the Quilt Worktable with the 
quilt you want to share. Click the PRINT 
& EXPORT tab. On the ribbon, click 
Export, and Facebook from the palette. 
A Log into Facebook box appears. 

2.	 Enter your Facebook login information, 
then click Log In. 

3.	 Click OK to the Facebook permission 
questions.

4.	 Check the box if you’d also like to post 
your design on the Do You EQ Facebook 
page to share with other EQ users.

5.	 Type content in the top box to post 
with your image.

6.	 Click Post to My Facebook Wall.

7.	 A message will display telling you that 
your quilt has been posted. Click OK.

Step 4

Step 1

Step 1

Step 2

Step 4

Step 5

Step 6
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Symbols

3 Dot Options  14, 32, 76

A

Activation  12
Add a border to a quilt  63
Add as Fabric  177, 178, 181
Adding Items to Project Sketchbook  

27
Add to Sketchbook (from Library)  

200
Adjust Image Color  183
Adjust tool  83, 85, 88, 90
Advanced Symmetry  125
Aligned Borders  70
Aligning multiple blocks  90
Align to Edge fabric rotating method  

103
Applique

Block vs. motif  138
Center (patches) in Block  150
Clone patches  150
Combining with pieced block  156
Delete patches  150
Drawing a block or motif  138
Editing blocks or motifs  149
Editing nodes  152
Flip patches  150
Make a wreath  151
Making a block into a motif  154
Rearrange overlapping patches  

150
Resize patches  149
Rotate patches  150

Applique text  92
Arc (Ellipse tool)  144
Arc Tool  123
Auto Add  206
Auto Borders  66
Auto Fill  131, 139

B

Baby Blocks Quilt  42
Background canvas color  179, 180, 

193, 194
Bezier Curve Tool  140
Block

Adding to Project Sketchbook  27
Add plain block  76
Adjusting  82
Aligning multiple blocks  90

Centering on quilt  88
Clipping  88
Colorings  109
Copy & paste  85
Delete  85
EasyDraw  121
Editing from Project Sketchbook  

29
Erase  86
Making multiple blocks the same 

size  90
Move  83
Pieced  121
Printing  216
Resize on Layers 2 or 3, or on 

Custom Set  84
Rotate and flip  82
Rotate on Layers 2 or 3, or on 

Custom Set  84
Search by Category  202
Select Coloring  73
Set on quilt  73, 74
Skew on Layers 2 or 3, or on 

Custom Set  84
Stacking order  88

Block Library
Search by Category  202

Block Size  121, 131, 138
Block Tools

Adjust tool  83, 85, 88, 90
Erase Block tool  86
Eyedropper  77
Flip tool  82
Rotate tool  82
Set Block  73, 75, 76
Symmetry tool  87

BMP  172, 208, 238
Border

Adding, Deleting, or Inserting a  
63

Aligned  70
Auto Borders  66
Choosing a style  62
Cloning  65
Keeping borders when changing 

layouts  67
Making each side a different style  

68
Printing  228
Sizing  64
Styles  60

Brightness or Contrast  189
Bring to Front  150
Brush Stroke Tool  142
Brush Thread  105

C

Center Image  159
Center in Block  150
Centering blocks on a quilt  88
Centimeters or Inches  10
Channel Mixer  183
Circular Symmetries  192
Clear the current guides  122, 131, 

139
Clip & Flip  167
Clipping blocks  88
Clone  126, 135, 150

Borders  65
Selected strips in a strip quilt  48

Color Depth  196
Coloring Arrows  109
Colors  96 (see also Fabric Tools)

Adding grades  113
Adding new  110
Adding shades & tints or tones  

112
Sorting  107

Compress a Project’s File Size  23
Contact EQ  12
Convert selected segments to guides  

122, 131, 139
Convert to patch  143, 145
Copying

Projects from One Computer to 
Another  25

Copy & paste
Items on Layers 2 or 3, or on 

Custom Set  85
Copy to Fabrics  30, 181
Copy to Photos  175
Create Colorway  185
Create Copy Project  23
Create Quilt from Block  56
Create Serendipity  164
Crop  160, 177, 178, 180
Custom Set Quilt  55

Aligning blocks  90
Copy & paste items  85
Delete items  85
Move, resize, rotate, and skew 

blocks  83
Set blocks  74
Set photos  79
Set plain block  76
Sizing blocks  90
Stacking, centering, and clipping 

blocks  88
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D

Default Palette
Changing the  114

Default Project  11
Delete  125, 135, 150

Borders  63
from the Project Sketchbook  33
Image from Image Worktable  

176
Project  20

Detach button  97
Distort Fit  51, 159
Download  12
Drag and drop  74, 75, 76, 78, 79
Drawing

an Applique Block or Motif  138
an EasyDraw + Applique Block  

156
an EasyDraw Block  120
a PolyDraw + Applique Block  156
a PolyDraw Block  129
Combining Pieced and Applique 

Blocks  156
Drawing Tools (Applique)

Bezier Curve Tool  140
Brush Stroke Tool  142
Draw Tool  140
Edit Tool  143, 152
Ellipse Tool  144
Freehand Tool  141
Line Tool  140
Oval Shapes  146
Pick Tool  149
Polygon Shapes  146
PosieMaker  147
Rectangle Tool  144
Shapes Tool  146
StarMaker  147
StencilMaker  148
Swath Tool  142
Wreathmaker  151

Drawing Tools (EasyDraw)
Arc Tool  123
Edit Tool  126
Grid tool  124
Line Tool  123
Pick Tool  125

Drawing Tools (PolyDraw)
Edit Tool  136
Pick Tool  134
PolyArc Tool  133
PolyLine Tool  132

Draw Tool  140

E

Easy + Applique  156
EasyDraw  119

Advanced Symmetry  125
Clone segments  126
Delete segments  125
Drawing a block  120
Editing blocks  125
Editing nodes  126
Flip segments  125
Resize segments  126
Rotate segments  126
Rules  120

Editing
Blocks from Project Sketchbook  

29
Photos from Project Sketchbook  

30
Quilts from Project Sketchbook  

28
Edit Tool  126, 136, 143, 152
Ellipse Tool  144
Embroidery

Importing EXP files  209
Printing from Quilt Worktable  

230
Set on quilt  78

Embroidery Tools
Set Embroidery  78

Erase Quilt  86
Erase tool  86
Export

Facebook  242
Images  238
Metafiles of blocks  241
Resolution  239
Selected Areas  240

Eyedropper tool
Find a block, motif, or stencil  77
Find a fabric or color  104

Eye Icon  72

F

Fabric Library
Importing image files  208
Searching by Color  203

Fabrics  96
Add as Fabric  177
Copy to Photos  175
Scale  177
Search by Color  203
Sorting  107
Straightening  178

Fabric Tools  96
Fussy Cut Tool  101
Paintbrush tool  96
Randomize Tool  115
Rotate Fabric Tool  102
Select & Spray Tool  99
Select & Swap Tool  100
Spraycan tool  99
Swap Color Tool  100

Fabric Yardage Estimates  233
Notes on  234

Facebook, Sharing Designs on  242
Fancy Star  170
Fat quarters  233
Favorite Libraries (see My Favorite 

Libraries)
File

Compressing size  23
Creating a New Project  15
Default location  15
Deleting a Project  20
PJ8  14
Moving from One Computer to 

Another  25
Opening a Project  17
Renaming a Project  18
Saving a Project  16
Searching for a Project  19

Finding items with the Eyedropper  
77, 104

Finished Size  36
Fit in Window  181
Flip  125, 135, 150
Flip tool  82
Foundation Pattern  219

Change Numbers  221
Changing printouts  222
Deleting and moving sections  

222
Numbering tab  221
Options tab  220
Sections tab  221

Frame Block  164
Freehand Brush  98
Freehand Tool  141
Fussy Cut Tool  101

G

GIF  172, 208, 238
Graph Paper Cells  121, 131, 139
Grid Snaps  80
Grid tool  124
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H

Help  12
Hide/show

Auto Fill on closed patches  131, 
139, 162

Graph paper  121, 131, 139
Image for tracing  161
Quilt patch lines  72

Histogram  187
Adjust  188
Bright/Contrast  189
Equalize  187

Home Screen  6, 17, 21
Horizontal Quilt  39
Horizontal Strip Quilt  44
Hue Map  184

I

Image (see also Photo)
Adding to Project Sketchbook  27
Adjust color  182
Applying Circular Symmetries  192
Applying Effects  190
Applying Filters  191
Applying Square Symmetries  194
Channel Mixer  183
Create Colorway  185
Cropping  180
Deleting  176
Editing  175
Exporting  238
Flip  179
Hue Map  184
Import for tracing  158
Import to Image Worktable  174
Increase/Decrease Color Depth  

196
Photo Layout  231
Resizing  175
Rotate  179
Shearing  180
Special Effects  190
Straightening  178
Tracing  158

Import
an image for tracing  158
Embroidery (EXP) files  209
from existing projects  207
Image files into Fabric or Photo 

Libraries  208
Image to Image Worktable  174
Photo to Quilt Worktable  50

Inches or Centimeters  10
Insert Borders  63

Inside Fit  50, 159
Installing EQ8  12

J

JPG  172, 208, 238

K

Kaleidoscope
PolyDraw Grid  130
Serendipity  169

L

Layer 1
Set blocks  73
Set photos  79

Layer 2
Applique text  92
Set motifs  75
Set photo  79

Layer 3
Set embroidery  78
Set stencils  75

Layout Library  57
Resize a layout library quilt  58

Layout styles for quilts  38
Baby Blocks Quilt  42
Custom Set Quilt  55
Horizontal Quilt  39
Horizontal Strip Quilt  44
One Patch Quilt  49
On-Point Quilt  40
Photo Patchwork Quilt  49, 50
Variable Blocks Quilt  43
Variable Point Quilt  41
Vertical Strip Quilt  44

Libraries
About  198
Add to Sketchbook  200
Categories and Styles  198
Importing from existing projects  

207
Importing into Fabric or Photo 

Libraries  208
Layout Library  57
Linking  206
My Favorite Libraries  210
Searching in the  201
Sections  199
Using items from  200

Line Brush  98
Line Tool  123, 140
Linking Libraries  206

M

Map to colors  52, 118
Map to fabrics  52, 118
Margins  236
Mask  51
Measurement units (inches or 

centimeters)  10
Merge Blocks  166
Metafiles  241
Most recently used fabrics and colors  

96
Most recently used projects  17
Motif (see also Applique)

Removing the background from 
an applique block  154

Set on quilt  75
Move

Items on Layers 2 or 3, or on 
Custom Set  83

My Favorite Libraries
Adding and Saving Items in  211
Adding, Formatting, and 

Renaming  210
Delete an entire library  212
Deleting items from  212

N

New
Project  15
Quilt  38

Nodes  126, 136, 152
Notecard  34

Flip  203
Searching for items by  201

O

One Patch Quilt  49, 53
Online Support Articles  12
On-Point Quilt  40
Open a Project  17

from your Email  22
Open Library  7
Options Menu  14
Outside Fit  51, 159
Oval Brush  98
Oval Shapes  146

P

Page Setup  236
Paintbrush tool  96, 98
Pan  181
Paper Piecing (see Foundation 

Pattern)
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PatchDraw (see PolyDraw)
Photo (see also Image)

Editing from Project Sketchbook  
30

Importing image files  208
Import to Quilt Worktable  50
Printing from Quilt Worktable  

230
Printing using Photo Layout  231
Set on quilt  79
Understanding Image vs. Photo  

172
Photo Patchwork Quilt  49, 50
Photo Tools

Set Photo  79
Pick Tool  125, 134, 149
Pieced blocks  119

Combining with applique  156
EasyDraw  120
PolyDraw  129

Pie (Ellipse tool)  144
PJ8  14
PNG  172, 208, 238
Poly + Applique  156
PolyArc Tool  133
PolyDraw  119, 129

Clone and Rotate Method  135
Clone patches  135
Delete patches  135
Drawing a block  129
Editing blocks  134
Editing nodes  136
Flip patches  135
Grid  129
Rotate patches  135

Polygon Shapes  146
PolyLine Tool  132
PosieMaker  147
Position & Resize  159
Precision Bar

Applique  138
EasyDraw  121
PolyDraw  130

Preferences  10
Previous EQ Versions  17, 19
Printer Fonts  235
Printing

As applique pattern  216
As many as fit  217
Block  216
Block name  217
Block outline  217
Border or Sash Blocks  228
Changing fonts  235

Changing foundation and 
template printouts  222

Changing Printers  236
Edit Name  214
Embroidery  230
Fabric Yardage Estimates  233
Finished Block Size  216, 218, 220, 

224, 228
Foundation Pattern  219
Images  231
Key Block  218, 224
Line Thickness  217, 218, 220, 230
Margins  236
Mirror  217, 219
Outline drawing  216, 229
Overview  214
Page Setup  236
Patch outline  217
Photo Layout  231
Photos  230
Preview  215, 219, 220, 221, 222, 

225, 228, 229, 230, 233
Quilt  229
Quilting stencil  216
Rotary Cutting Chart  224
Seam Allowance  218, 220, 224, 

233
Showing fabrics  216, 229
Templates  218
Use size from quilt  215
Use size from worktable  215

Project
Compressing  23
Create a New  15
Create Copy  23
Default locations  15
Deleting  20
Import from an existing  207
Moving from One Computer to 

Another  25
Open an existing  17
Renaming  18
Saving  16
Searching for a  19
Sending via Email  22

Project Helper  15, 17, 18, 20
Project Sketchbook  14

Adding Items  27
Deleting from  33
Editing Blocks from  29
Editing Photos from  30
Editing Quilts from  28
Naming items  34
Resizing  14
Sorting Items  31

Q

Quick Quilt  21
Quick Start Guide  12
Quilt

Adding to Project Sketchbook  27
Adjusting blocks in a  82
Create Quilt from Block  56
Editing from Project Sketchbook  

28
Erase Quilt  86
Hide/show quilt patch lines  72
Layout choices  38
Layout Library  57
New  38
Printing  229
Rulers  81
Setting applique text  92
Setting blocks  73, 74
Setting embroidery  78
Setting motifs  75
Setting Photos  79
Setting plain blocks  76
Setting stencils  75
Snap Settings  80
Symmetry  87
Understanding Layers  72

R

Randomize Tool  52, 115, 116
Rectangle Brush  98
Rectangle Tool  144
Resize  126, 149

Items on Layers 2 or 3, or on 
Custom Set  84

Resolution  173, 174, 176, 239
Restore Default Settings  10, 114
Rotary Cutting  224

Best Practices  227
Notes on rounding  225
Understanding the cutting 

diagrams  225
Rotate  126, 135, 150

Items on Layers 2 or 3, or on 
Custom Set  84

Rotate Fabric Tool  102
Rotate Tool  82
Rounded Rectangle (Rectangle tool)  

145
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Strip Quilts
Cloning a Strip  48
Formulas  47
Strip Styles  46

Support Site  12
Swap Color Tool  100
Swap Thread  105
Swath Tool  142
Symmetry tool  87

T

Tape Measure Tool  37
Tech support  12
Templates  218

Changing printouts  222
Deleting, moving, and rotating 

patches  222
Text Tools

Adjust tool  93
Set Text  92

Thread
Adding colors  106
Properties  105
Search for by Text and by Color  

204
Thread Tools  105

Brush Thread  105
Spray Thread  105
Swap Thread  105
Thread Properties  105

TIF  172, 208, 238
Tilt Block  165
Toggle automatic tool snapping  77
Tracing an image  158

Tips for  161
Tracing Image Tools

Crop Tool  160
Import Image Tool  159
Position & Resize Tool  159

Tutorial Videos  12

U

Uninstalling EQ8  12
Upper Left Image  159
Use size from quilt  215
Use size from worktable  215

V

Variable Blocks Quilt  43
Variable Point Quilt  41
Vertical Strip Quilt  44
View Actual Size  181
View Project Sketchbook  28, 29, 30, 

31, 33, 34

S

Same size buttons  90
Sashing  39, 40, 41
Save

As  18
Project  16

Save Palette as Default  11
Scale Fabric  177
Scanning

Fabrics  173
Photos  174

Seam Allowance  218, 220, 224, 233
Searching

for a Project  19
for blocks by Category  202
for fabrics by Color  203
for items by Notecard  201
for threads  204

Select & Spray Tool  99
Select & Swap Tool  100
Send project via email  22
Send to Back  150
Serendipity  164
Set

Block tool  73, 75, 76
Embroidery tool  78
Photo tool  79
Text tool  92

Shape Tool (from EQ7) (See Edit Tool)
Shapes Tool  146
Shrink & Flip  168
Sketchbook (see Project Sketchbook)
Skew

Items on Layers 2 or 3, or on 
Custom Set  84

Snapping Options  122, 139
Snap Points  121, 139
Snap Settings  80
Sort

Fabrics and colors  107
In the palette  32
Items in the Project Sketchbook  

31
Special Effects  190
Spraycan Tool  99
Spray Thread  105
Square Symmetries  194
Stacked Colorings  109
Stacking blocks  88
StarMaker  147
Stencil

Set on quilt  75
StencilMaker  148
Straighten Tool  178

W

Worktable Options  80
Worktables  7

Diagram  8
Worktable Tools  181

Add as Fabric  181
Fit in Window  181
Pan  181
View Actual Size  181

Wreathmaker  151
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KEYBOARD SHORTCUTS

Speed Keys
Use these speed keys on the Quilt Worktable to quickly set blocks and/or 
color patches. 

CTRL+click (Windows) Command+click (Mac)	
Setting blocks, photos 
Sets blocks in all pre-defined spaces of a quilt layout. See page 73. 

Coloring with Paintbrush tool  
When the same block is used multiple times in a quilt, holding this speed 
key while clicking will color the same patch in all of those blocks at once. 
See page 96.

Coloring with the Spraycan tool 
When the same fabric/color is used multiple times in a quilt, holding this 
speed key while clicking will color the matching fabric/color in all the 
blocks at once. See page 99.

ALT+click (Windows) Option+click (Mac)
Setting blocks, photos 
Sets blocks in alternating pre-defined spaces of a quilt layout.

Coloring with Paintbrush tool  
When the same block is used multiple times in a quilt, holding this speed 
key while clicking will color the same patch in alternating blocks at once.

Coloring with the Spraycan tool 
When the same fabric/color is used multiple times in a quilt, holding this 
speed key while clicking will color the matching fabric/color in alternating 
blocks at once. 

File Handling
Command Windows Mac

New CTRL+N Cmd+N

Open CTRL+O Cmd+O

Save / Add to 
Sketchbook

CTRL+S Cmd+S

Editing
Command Windows Mac

Undo CTRL+Z Cmd+Z

Cut CTRL+X Cmd+X

Copy CTRL+C Cmd+C

Paste CTRL+V Cmd+V

Clear Delete Delete/
Backspace

Miscellaneous
Command Windows Mac

Select All CTRL+A Cmd+A

Select last 
drawn 
segment(s) 

Spacebar Spacebar

Flip arc on 
EasyDraw block

Spacebar 
(while 
drawing)

Spacebar 
(while 
drawing)

View 
Sketchbook

F8 F8

Close dialog 
box

Esc Esc

Zoom in/out CTRL + 
mouse 
wheel

CTRL + 
mouse 
wheel
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QUILT WORKTABLE

Check the EQ8 Online Support site for 
information about any palette sub-tools.

Block Tools
This toolbox is found on the Quilt 
Worktable. Click the DESIGN tab on 
the top ribbon, then choose Block 
Tools.

Set Block 
Click on a space in the quilt, or drag 
and drop a block onto the quilt. 

Erase Block 
Click on a block in the quilt to remove 
the block from that space.  

Rotate 
Click a block in the quilt to rotate it 90 
degrees with each click.  

Flip 
Click on an asymmetric block in the 
quilt to mirror it left to right.  

Adjust 
Select a block on the quilt to move, 
rotate and resize it on Layers 2 and 3, 
as well as Layer 1 of Custom Set quilts. 
This tool is only enabled when on the 
appropriate layer.  

Symmetry 
Click on the quilt to flip and rotate 
asymmetric blocks in 16 different 
variations. This works best with 
horizontal layouts.  

Eyedropper 
Click a block in the quilt to quickly 
locate it in the palette.  

Open Library 
Opens the Block Library window.  

Fabric Tools
This toolbox is found on the Quilt 
Worktable. Click the DESIGN tab on 
the top ribbon, then choose Fabric 
Tools.

Paintbrush 
Click on a patch in the quilt to color it 
with the selected fabric.  

Spraycan 
Click on a patch in the quilt to color all 
matching fabrics in the block at one 
time. 

Swap Color 
Click on a patch in the quilt to color 
all matching fabrics in the quilt at one 
time.  

Eyedropper 
Click a patch in the quilt to quickly find 
the fabric or color used in the palette.

Fussy Cut 
Click, hold and drag to move the fabric 
around within a patch in the quilt.  

Rotate Fabric 
Click the fabric in the quilt to rotate it 
within the patch.  

Randomize 
Choose an option, then click on the 
quilt to recolor quickly. 

Open Library 
Opens the Fabric Library window.   

Photo Tools
This toolbox is found on the Quilt 
Worktable. Click the DESIGN tab on 
the top ribbon, then choose Photo 
Tools.

Set Photo 
Click on a space in the quilt, or drag 
and drop a photo onto the quilt. 
Photos can be set on any layer of the 
Quilt Worktable. 

Erase 
Click on a photo in the quilt to remove 
the photo from that space.  

Adjust 
Select a photo on the quilt to move, 
rotate and resize it on Layers 2 and 3, 
as well as Layer 1 of Custom Set quilts. 
This tool is only enabled when on the 
appropriate layer.  

Open Library 
Opens the Photo Library window.   
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Text Tools
This toolbox is available when Layer 2 
is selected at the bottom of the Quilt 
Worktable. Click the DESIGN tab on 
the top ribbon, then choose Text Tools.

Set Text 
Hold the keyboard SHIFT key, then 
click, hold and drag to create a text 
box on the quilt. When you release, 
you’ll have a box in which you can start 
typing. 

Adjust 
Select a text box on the quilt to move, 
rotate, resize and delete it on Layer 2.

Note: Text Tools are only available when 
Layer 2 is selected at the bottom of the 
Quilt Worktable.

Embroidery Tools
This toolbox is available when Layer 
3 is selected at the bottom of the 
Quilt Worktable. Click the DESIGN 
tab on the top ribbon, then choose 
Embroidery Tools.

Set Embroidery 
Drag an embroidery design from the 
palette to Layer 3 of the quilt.  

Erase 
Click on a design in the quilt to remove 
it from its space. Use the Adjust tool to 
completely remove the empty space. 

Rotate 
Click an embroidery in the quilt to 
rotate it 90 degrees with each click.  

Flip 
Click an embroidery in the quilt to 
mirror it left to right. 

Adjust 
Select an embroidery on the quilt to 
move, rotate, resize and delete it on 
Layer 3. 

Open Library 
Opens the Embroidery Library window.

Note: Embroidery Tools are only available 
when Layer 3 is selected at the bottom of 
the Quilt Worktable.   

Thread Tools
This toolbox is found on the Quilt 
Worktable. Click the DESIGN tab on 
the top ribbon, then choose Thread 
Tools.

Brush Thread 
Click a patch in the quilt to color the 
outlines with the selected thread color.  

Spray Thread 
Click a patch in the quilt to color the 
outlines of all matching patches in the 
block at one time. 

Swap Thread 
Click a patch in the quilt to color the 
outlines of all matching patches in the 
quilt at one time. 

Open Library 
Opens the Thread Library window.    

QUILT WORKTABLE
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PRINT & EXPORT TOOLS

Print
This toolbox is found on the Quilt 
Worktable. Click the PRINT & EXPORT 
tab on the top ribbon, then choose 
Print.

Quilt (Quilt Worktable only) 
Prints a picture of the quilt.   

Yardage (Quilt Worktable only) 
Prints the yardage requirements for 
your quilt.

Block 
Prints a picture of the selected block.   

Templates 
Prints templates of the selected block.  

Foundation 
Prints foundation patterns of the 
selected block. 

Rotary Cutting 
Prints rotary cutting instructions of the 
selected block. 

Embroidery (Quilt Worktable only) 
Prints a picture of the selected 
embroidery. Only available with 
embroidery selected on Layer 3.

Photo (Quilt Worktable only) 
Prints a picture of the selected photo.

Print Setup 
Opens the Print Setup dialog to adjust 
your print settings.

Export
This toolbox is found on the Quilt 
Worktable. Click the PRINT & EXPORT 
tab on the top ribbon, then choose 
Export.

Image 
Exports an image of the quilt (or the 
selected block) as a *.JPG, *.TIF, *.GIF, 
*.PNG or *.BMP file.

Selection 
Exports an image as a *.BMP file of the 
selected area. Drag a box around an 
area of your quilt to export only that 
area. 

Metafile (Block Worktable only) 
Exports a vector metafile (*.EMF) 
to explode blocks in another vector 
software. This is only available for 
Windows computers.

Facebook (Quilt Worktable only) 
Exports an image of your quilt to your 
Facebook page for your peers to see.

Note: The Print & Export options are 
similar on the Quilt and Block Worktables. 
You may notice some of the options are not 
available on the Block Worktable and vice 
versa.

Also, some printing options do not apply 
to particular quilt elements, and may not 
be available. For example, if you have an 
applique block selected, then Foundation, 
Rotary Cutting, Embroidery and Photo will 
not be available because they do not apply 
to the selected applique block.  

Print options on the Quilt Worktable shown above

Export options on the Quilt Worktable shown above
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EasyDraw Tools
This toolbox is found on the Block 
Worktable. With an EasyDraw Block 
selected, choose the DRAW tab on 
the top ribbon, then choose Drawing 
Tools.

Pick 
Click on a segment (line or arc) to 
select it. Selected segments can be 
moved, resized, rotated, deleted and 
converted to guides. This tool does 
have Advanced options available.  

Edit 
Click on a line or arc to adjust the 
endpoints (nodes) or the shape of the 
curve, where applicable. 

Line 
Click, hold and drag your mouse to 
draw a line from point to point on the 
block.   

Arc 
Click, hold and drag your mouse to 
draw an arc on the block. Use the 
Spacebar to flip the direction of the 
arc. 

Grid 
Enter the Columns and Rows of your 
grid, then drag diagonally on the block 
to place your grid.     

PolyDraw Tools
This toolbox is found on the Block 
Worktable. With a PolyDraw Block 
selected, choose the DRAW tab on 
the top ribbon, then choose Drawing 
Tools.

Pick 
Click on the edge of a patch to select 
it. Selected patch(es) can be flipped, 
rotated, cloned and deleted.   

Edit 
Click on the edge of a patch to select 
it. Drag a node to reposition it. Double-
click a node to delete it. Double-click a 
line/curve to add a new node.  

PolyLine 
This tool will follow straight line grids. 
Double-click to anchor your starting 
point. Single click to anchor additional 
points to create the patch shape. 
Double-click on the starting point to 
close the patch.     

PolyArc 
This tool will follow straight line and 
curved grids. Double-click to anchor 
your starting point. Single click to 
anchor additional points to create 
the patch shape. Double-click on the 
starting point to close the patch. 

BLOCK WORKTABLE

Applique Tools
This toolbox is found on the Block 
Worktable. With an Applique Block 
or Motif selected, choose the DRAW 
tab on the top ribbon, then choose 
Drawing Tools.

Pick 
Click on the edge of a patch to select it. 
There are several options for selected 
patches in the palette.   

Edit 
Click on the edge of a patch to select 
it. Drag a node to reposition it. Adjust 
the handles to reshape curves. Double-
click a node to delete it. Double-click a 
line/curve to add a new node.  

Draw 
Choose a drawing sub-tool. Each has 
its own capabilities. Drag your cursor 
on the block to draw with these tools.   

Shapes 
Choose a pre-defined shape, then drag 
your mouse on the block to place your 
shape. Use the PatchMaker shapes to 
create quick stars, flowers and scallops.  

Ellipse 
Drag an ellipse onto the block. Use the 
palette options to change the style of 
the ellipse, its shape and size. 

Rectangle 
Drag a rectangle onto the block. Use 
the palette options to change the style 
of the rectangle, its shape and size. 
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Create Serendipity
This toolbox is found on the Block 
Worktable. Click the NEW BLOCK tab 
on the top ribbon, then choose Create 
Serendipity.

Frame Block 
Puts a pre-designed frame around the 
selected Sketchbook block.   

Tilt Block 
Tilts the selected Sketchbook block at 
any angle from 0 to 90 degrees.  

Merge Blocks 
Combines the two selected Sketchbook 
blocks into one block. Note that the 
background block must meet specific 
requirements. See the EQ8 Online 
Support site.   

Clip & Flip 
Flips and rotates the upper-left 
quadrant of the selected Sketchbook 
block.  

Shrink & Flip 
Shrinks the selected Sketchbook block, 
then flips and rotates it into 4 different 
quadrants to create a new block.    

Kaleidoscope 
Turns the selected Sketchbook block 
into a kaleidoscope by cutting it 8 
ways. 

Fancy Star 
Turns the selected Sketchbook block 
into a star with 5 to 8 points. 

Open Library 
Opens the Block Library window. 

Tracing Image Tools
This toolbox is found on the Block 
Worktable. With any block style 
selected, choose the DRAW tab on 
the top ribbon, then choose Tracing 
Image.

Import Image 
Import an image from your computer 
into EQ8. Place as a background image 
that can be used as a guide for tracing 
a new block.  (You must go back to the 
DRAW tab to trace the block once the 
image is set.)  

Position & Resize 
Use these options to position the 
image in the block.  

Crop 
Crop out unwanted edges of the 
image.

Delete Image 
Delete the current image on the 
worktable. 

BLOCK WORKTABLE IMAGE WORKTABLE

Edit Options
This toolbox is found on the Image 
Worktable. Click the IMAGE tab on 
the top ribbon, then choose Edit.

Import Image 
Imports an image from your computer 
into EQ8 to edit and add to your 
project.   

Resize Image 
Adjusts the image size and resolution.  

Scale Fabric 
Ensures the fabric image you have 
imported is at 100% scale, so what you 
see in your EQ quilt or block is what 
you’d see in your sewn quilt or block.   

Rotate 
Options to rotate, shear or straighten 
an image. The Straighten feature 
is very helpful for imported fabric 
images.  

Crop 
Removes unwanted edges of the 
image.

Delete Image 
Deletes the current image on the 
worktable. 

Open Library 
Opens the Photo Library window. 
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Color Options
This toolbox is found on the Image 
Worktable. Click the IMAGE tab on 
the top ribbon, then choose Color.

Color Balance 
Automatically adjusts color levels in 
the image.  

Red/Green/Blue 
Changes the amount of red, green and 
blue in the image. 

Hue/Sat/Light 
Changes all three dimensions (hue, 
saturation and lightness) of the image’s 
color values.   

Colorize 
Changes the overall color and intensity 
of the image.  

Color Accent 
Selects a hue or range of hues to 
emphasize or isolate while minimizing 
the hues in the rest of the image.

Hue Map 
Adjusts specific hues in your image.

Channel Mixer 
Applies creative color adjustments to 
an image.

Create Colorway 
Creates various colorations of the 
same image. 

IMAGE WORKTABLE

Histogram Options
This toolbox is found on the Image 
Worktable. Click the IMAGE tab 
on the top ribbon, then choose 
Histogram.

Adjust 
Changes the brightness and contrast of 
the image.  

Equalize 
Increases the contrast in an image. 

Bright/Contrast 
Applies overall and equal adjustments 
to all the pixels in an image.  

Special Effects Options
This toolbox is found on the Image 
Worktable. Click the IMAGE tab on 
the top ribbon, then choose Special 
Effects.

Effects 
This option has over 45 different 
effects that can be applied to images, 
including Artistic, Noise, Blur and many 
more.  

Filters 
This option has 9 different filters that 
can be applied to images, including 
Sharp/Unsharp, and Edge Detection. 

Circular Symm 
Takes a pie-shaped petal of an image 
and turns it into a circular design 
similar to the patterns seen in 
kaleidoscopes.  

Square Symm 
Uses a square portion of the photo 
to create symmetries within a new 
4-quadrant image.  
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IMAGE WORKTABLE

Print 
This toolbox is found on the Image 
Worktable. Click the PRINT & EXPORT 
tab on the top ribbon, then choose 
Print.

Photo Layout 
Interactive layout for placing 
Sketchbook photos on the page in the 
best sizes and positions for printing. 
This helps utilize the space better, 
especially if printing onto inkjet fabric.  

Print Setup 
Opens the Print Setup dialog to adjust 
your print settings. 

Export
This toolbox is found on the Image 
Worktable. Click the PRINT & EXPORT 
tab on the top ribbon, then choose 
Export.

Image 
Exports the image as a *.JPG, *.TIF, 
*.GIF, *.PNG or *.BMP file.

Selection 
Exports an image as a *.BMP file of 
the selected area. Drag a box around 
a portion of your image to export only 
that selected portion.  

Worktable Tools
This toolbox is always found in the 
palette on the Image Worktable. 

View Actual Size 
Displays the image at its actual size. 
The image may be smaller or larger 
than your screen can display.

Fit in Window 
Zooms the image larger or smaller to 
fit the entire size of the window.  

Pan 
Grabs to move the image around on 
the screen.

Add as Fabric 
Adds the current image as a fabric in 
your Sketchbook. This works best for 
fabric photos that you have imported 
and plan to use in your quilt design. 
After using this tool, you will find your 
image in the fabric palette on the Quilt 
and Block Worktables. 


